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Ïðåäèñëîâèå 

 

Перед вами самоучитель, при помощи которого вы сможете самостоятельно 

освоить основные возможности приложения Adobe Premiere Pro 2.0 (в даль-

нейшем будем называть просто — Premiere). 

Мы организовали изложение материала в той последовательности, в которой 

обычно осуществляется создание фильма в видеоредакторах: импорт или за-

хват видео — линейный монтаж — настройка спецэффектов — добавление 

титров — вывод фильма. Главы, каждая из которых нацелена на решение оп-

ределенной задачи, мы назвали "уроками", подчеркивая тем самым, что ос-

новное назначение нашей книги — научить читателя работе с Premiere. Мы 

старались сделать уроки максимально независимыми друг от друга с тем, 

чтобы помочь читателю начать быстро ориентироваться именно в тех воз-

можностях Premiere, которые ему в данный момент наиболее необходимы 

для текущей работы. Поэтому в пределах каждого из уроков решается кон-

кретная проблема видеомонтажа в Premiere. 

Хотим сразу оговориться, что мы старались максимально упростить воспри-

ятие материала. Для этого мы сделали акцент на частое использование пояс-

няющих рисунков и экранных форм, на которых при помощи указателя  

мыши подчеркивали смысл рисунка. Для тех из вас, кто последовательно 

изучает материал, мы пометили разделы, не являющиеся, на наш взгляд, ос-

новными, "звездочкой". Их чтение можно пропустить, без ущерба для освое-

ния оставшейся части книги. 

Надеемся, что существенную помощь в изучении материала окажет видео-

курс, который вы найдете на компакт-диске, прилагаемом к книге. Просто 

просмотрите (при помощи любого медиапроигрывателя) учебное видео, 

представляющее собой примеры работы в Premiere Pro, которые, в основном, 

соответствуют содержанию книги. 
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Этот самоучитель является одним из двух наших пособий, посвященных 

Premiere. В нем мы постарались рассмотреть наиболее важные возможности 

программы. Если вы пожелаете больше узнать о программе Premiere, то сове-

туем обратиться ко второй книге — "Premiere Pro 2.0 в подлиннике". Если 

вам доведется работать с другими видеоредакторами: Adobe After Effects или 

Pinnacle Studio, то, возможно, вы отдадите предпочтение нашим книгам об 

этих программах — они также вышли в свет в издательстве "БХВ-Петербург". 

Надеемся, что наша книга поможет вам быстро и без проблем научиться ком-

пьютерной обработке видео при помощи замечательного пакета Premiere. 

Авторы 
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Îáùèå ñâåäåíèÿ  
î öèôðîâîì âèäåî 

Первый урок посвящен знакомству с принципами компьютерного видеомон-
тажа и графики и адресован, в первую очередь, новичкам в области цифрово-
го видео. Здесь в сжатой форме объясняются принципы хранения и обработ-
ки видео- и звукозаписей на компьютере, описываются основные параметры 
видеофайлов (размер, частота кадров и т. п.). 

� Чего мы хотим: 

• понять принципы хранения и обработки цифрового видео и звука; 

• изучить наиболее важные свойства медиафайлов. 

 

Уже довольно давно персональные компьютеры используются в качестве 
средства воспроизведения и редактирования цифрового видео. Технология, 
позволяющая отображать на экране монитора видео и воспроизводить с по-
мощью акустических систем звук, получила название мультимедиа. С точки 
зрения хранения мультимедийной информации на компьютере (вообще гово-
ря, любые данные представляются на нем в виде файлов определенного ти-
па), можно выделить несколько основных типов файлов: 

� audio (звуковые, или аудио) — только звук, который проигрывается через 
акустическую систему (например, файлы с расширениями wav, mp3, aiff  
и т. п.); 

� video (анимационные, или видео) — видео может быть беззвучным, а мо-
жет и звуковым, т. е. сопровождаться синхронным звуком (файлы с рас-
ширением avi, mov и т. п.); 

� image (рисунки, или статические изображения) — обычные картинки (не-
сколько условный тип, однако нам будет удобно говорить о нем в книге 
как о полноценной разновидности мультимедиа). Это файлы с расшире-
ниями gif, jpeg, tiff, bmp и т. п. 
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Общее название перечисленных типов файлов — это мультимедиа-, или про-

сто медиафайлы (рис. 1.1). Коротко остановимся на принципах хранения ин-
формации в медиафайлах, начав с самого простого их типа — рисунков (ста-

тических изображений). 

 

Рис. 1.1. Типы мультимедиа 

1.1. Ñòàòè÷åñêèå èçîáðàæåíèÿ 

Вероятно, сегодня практически каждый пользователь представляет себе ос-

новной принцип хранения и отображения графической информации на ком-

пьютере. Тем не менее, скажем об этом несколько слов, чтобы последующие 

сведения о цифровом видео (которое представляет собой сменяющую друг 

друга последовательность изображений) были для нас понятнее. 

1.1.1. Ðàçðåøåíèå 

На первый взгляд, качественный рисунок, будучи отображенным на экране 

хорошего монитора, мало чем отличается от обычной фотографии. Однако на 

уровне представления изображения это отличие просто огромно. В то время, 

как фотографический снимок создается на молекулярном уровне (т. е. со-

ставляющие его элементы принципиально не различимы человеческим зре-

нием независимо от увеличения), рисунки на экране монитора (и, подчерк-

нем, в памяти компьютера) формируются благодаря пикселам — элементар-

ным составляющим изображения (чаще всего) прямоугольной формы. 

Каждый пиксел имеет свой определенный цвет, однако из-за их малого раз-

мера отдельные пикселы (почти или вовсе) неразличимы глазом, и у челове-

ка, рассматривающего картинку на экране монитора, их скопление создает 

иллюзию непрерывного изображения (рис. 1.2). 
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Рис. 1.2. Изображения на компьютере формируются благодаря пикселам 

 
Изображения на экранах компьютеров формируются при помощи пикселов квад-
ратной формы. В отличие от компьютеров, во многих стандартах телевидения 
используются не квадратные, а прямоугольные пикселы. Параметром, характери-
зующим отношение размеров пикселов, выступает отношение их горизонтально-
го и вертикального размеров, или пропорции пиксела (pixel aspect ratio). 

Каждый пиксел (кстати, слово pixel образовано от первых двух букв англий-
ских слов picture element) представляет информацию о некоторой "средней" 
интенсивности и цвете соответствующей области изображения. Общее число 
пикселов, представляющих рисунок, определяет его разрешение. Чем больше 
пикселов создают изображение, тем естественнее оно воспринимается чело-
веческим глазом, и тем, как говорят, выше его разрешение (рис. 1.3). Таким 
образом, пределом "качества" компьютерного рисунка является размер фор-
мирующих его пикселов. Более мелкие, чем пикселы, детали компьютерного 
рисунка совершенно теряются и, в принципе, невосстановимы. Если рассмат-
ривать такой рисунок в увеличительное стекло, то, по мере увеличения, мы 
увидим только расплывающееся скопление пикселов (см. рис. 1.2), а не мел-
кие детали, как это было бы в случае качественного фотоснимка. 

Здесь стоит оговориться, что, во-первых, мы имеем в виду традиционную 
(аналоговую, а не цифровую) фотографию (т. к. принцип цифровой фотогра-
фии как раз тот же самый, что и обсуждаемый принцип формирования изо-
бражения из пикселов), а во-вторых, даже для нее, говоря о качестве изобра-
жения, всегда следует помнить о самой технологии фотографии. Ведь изо-
бражение на фотопленке появляется благодаря прохождению света через 
объектив фотокамеры, и его качество (в частности, четкость и различение 
мелких деталей) напрямую зависит от качества оптики. Поэтому, строго го-
воря, "бесконечная" четкость традиционного фотографического снимка, о 
которой мы говорили, является некоторым преувеличением. 

 
На самом деле, современные цифровые фотокамеры позволяют зафиксиро-
вать изображение, разрешение которого практически не уступает аналоговому 
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(в том смысле, что сейчас возможно оцифровать такое количество пикселов, 
которое будет "перекрывать" границы разрешения самой оптики). Однако для 
предмета нашей книги этот факт не играет важной роли, т. к. в настоящее вре-
мя цифровое видео в подавляющем большинстве случаев передается именно  
с невысоким разрешением (относительно малым общим числом пикселов), и 
принимать во внимание такой параметр, как разрешение, просто необходимо. 

 

Рис. 1.3. Общее число пикселов (разрешение) определяет качество изображения 

Итак, немного упрощая, чтобы представить рисунок в цифровом виде, необ-
ходимо покрыть его прямоугольной сеткой размера M×N (M точек по гори-
зонтали и N по вертикали). Это сочетание чисел M×N (например, 320×240, 
800×600 и т. д.) и называют разрешением (resolution) изображения, или раз-
мером кадра (frame size). Затем следует усреднить данные о структуре изо-
бражения в пределах каждого пиксела и записать соответствующую инфор-
мацию о каждом из M×N пикселов изображения в графический файл. Для 
цветного изображения это будет информация о конкретном цвете каждого 
пиксела (о компьютерном представлении цвета написано чуть ниже в этом 
разделе), а для черно-белых изображений — это информация об интенсивно-
сти черного цвета. Чтобы объяснить некоторые важные параметры компью-
терного представления изображений, остановимся далее чуть подробнее на 
их последнем типе — рисунках, выполненных в оттенках серого цвета 
(grayscale), т. е. в градации от белого до черного. 

1.1.2. Ãëóáèíà ïèêñåëà 

Поскольку компьютер оперирует исключительно цифрами, то для описания 
интенсивности цвета отдельного пиксела он применяет определенное число-
вое значение, которое является целым числом, т. е. — 0, 1, 2 и т. д. К приме-
ру, чисто белый цвет в черно-белых рисунках будет описываться нулевой ин-
тенсивностью, чисто черный — некоторым максимальным числом, а серые 
цвета — промежуточными значениями (в зависимости от их оттенка). Важ-
ным параметром, влияющим на качество представления изображения, явля-
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ется именно это максимальное значение интенсивности, которое (за вычетом 
единицы) называется глубиной пиксела (pixel depth). 

Если глубина пиксела равна, к примеру — 128, то это означает, что (кроме 
белого и черного цветов, интенсивность которых, по определению, равна 0 и 
127 соответственно) возможно представить на экране компьютера лишь  
128 – 2 = 126 оттенков серого цвета (рис. 1.4, а). Промежуточные цвета ото-
бразить будет невозможно, и (если таковые присутствовали в исходном изо-
бражении до оцифровки) они будут заменены наиболее близким оттенком из 
этих 126 градаций. В то же время для изображений с глубиной пиксела рав-
ной 256, возможно отобразить в два раза больше оттенков, и поэтому такое 
изображение будет, скорее всего, существенно более естественным. 

Минимально возможная глубина пиксела, равная 2, позволяет представить 
лишь два цвета — черный и белый (рис. 1.4, б) — и подходит для графиче-
ского хранения черно-белых документов с линейной графикой (line art). 

 
В качестве градаций глубины пиксела выбираются числа 2, ..., 128, 256 и т. д., 
т. к. все они являются степенями цифры 2, обеспечивая наиболее эффективное 
хранение данных на компьютере (оперирующем изначально числами в двоич-
ном представлении). Напомним читателю, что один байт информации как раз 
эквивалентен хранению одного из чисел диапазона 0...255. 

 

                                           а                                                                              б 

Рис. 1.4. Черно-белые изображения с одинаковым разрешением,  

но разной глубиной пикселов 

1.1.3. Êà÷åñòâî (êîìïðåññèÿ) 

Хранение всей информации о том или ином изображении (т. е. о цвете каж-
дого его пиксела) зачастую или невозможно, или неэффективно. Например, 
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рисунок размером 800×600 пикселов требует записи информации о 800 × 600 = 
= 480 000 пикселах. Если использовать глубину пиксела, равную 256 (т. е. 
кодировать каждый пиксел одним байтом), то размер файла, хранящего изо-
бражение (в оттенках серого цвета), будет равен почти половине мегабайта. 

 
Несколько забегая вперед отметим, что для хранения такого же цветного изо-
бражения потребуется файл уже в три раза большего размера (почти 1,5 Мбайт), 
а для хранения одной секунды цветного видео с кадром такого качества и ти-
пичной частотой кадров 24 кадра/с целых 40 Мбайт! 

Чтобы уменьшить размеры файлов, хранящих изображения, применяются 
специальные программы, называемые компрессорами или, по-другому, коде-

ками (codec — от англ. compressor/decompressor). Процедуру уменьшения 
размера медиафайла называют компрессией или сжатием. Как правило, при 
сжатии некоторая часть информации о рисунке теряется, и его качество соот-

ветственно понижается. Многие программы-компрессоры позволяют регули-
ровать степень ухудшения рисунков путем варьирования параметра, назы-

ваемого качеством сжатия, которое обычно измеряется в процентах. Очевид-
но, что чем сильнее сжато изображение (т. е. чем меньше получившийся 
медиафайл), тем хуже будет его качество (рис. 1.5). 

 

Рис. 1.5. Два изображения с разным качеством компрессии 

Все сказанное о рисунках в полной мере (и даже сильнее, т. к. при компрес-
сии может учитываться дополнительная информация о последовательностях 

кадров) относится и к видеофайлам. Как правило, эффективность сжатия су-
щественно зависит от структуры самого изображения, и правильный подбор 
кодека зачастую позволяет достичь просто фантастических успехов в улуч-

шении качества изображений. Очевидно, что следует выбирать такие кодеки 
и так регулировать их параметры, чтобы, с одной стороны, обеспечить хоро-

шее качество изображения, а с другой — скорость расчетов и приемлемый 
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физический размер медиафайла. Однако, зачастую, идеальный подбор кодека 

является "почти искусством" и под силу только очень опытным пользова- 
телям. 

1.1.4. Öâåò 

Ограничимся самыми общими упоминаниями о технологии компьютерного 

отображения цветных изображений. Как известно, человеческий глаз устроен 

таким образом, что способен раздельно воспринимать три цвета, называемых 

основными: красный, зеленый и синий. Какой-либо предмет, имеющий опре-

деленный цвет, воспринимается нашим зрением как определенная комбина-

ция этих основных цветов. Например, белый цвет ассоциируется нами как 

смесь всех трех основных цветов в максимальной равной пропорции, чер-

ный — как комбинация нулевых интенсивностей основных цветов, чисто си-

ний цвет — как комбинация максимальной пропорции синего и нулевой — 

красного и зеленого, и т. д. 

Именно на этом принципе и построено компьютерное представление цвета. 

Каждый пиксел цветного изображения кодируется тремя числами — сочета-

нием трех основных цветов: красного, зеленого и синего. Такую систему ко-

дирования цвета называют моделью RGB (от англ. Red, Green, Blue — крас-

ный, зеленый, синий). Как правило, каждый цвет кодируется одним байтом 

информации, т. е. пропорции цветов представляются числами от 0 до 255. 

Разумеется, такая система передачи цвета является дискретной, т. е. не каж-

дый имеющийся в природе цвет (число оттенков которого бесконечно) можно 

представить на компьютере. В этом смысле цифровое представление цвета 

имеет те же плюсы и минусы, что и рассмотренная нами выше передача ин-

тенсивности черно-белых изображений. 

 
Некоторые рисунки хранят информацию о цвете в других системах, например, 
CMYK-модели (голубой, пурпурный, желтый и черный), часто применяемой в 

полиграфии. Однако для представления на экране монитора компьютера соче-
тание этих цветов все равно пересчитывается в комбинацию основных цветов 
RGB. 

Говоря о технологии передачи цвета на компьютере, нельзя не сказать о том, 
что она тесно связана с проблемой компрессии изображений. Легко можно 

сосчитать, что если каждый из основных цветов кодировать при помощи од-
ного байта, то общее число возможных цветов составит более 16 миллионов. 

Кодировать каждый пиксел изображения с учетом такого большого количе-
ства цветов зачастую представляется расточительным. Поэтому многие коде-
ки используют несложный трюк, позволяющий значительно уменьшить раз-



Óðîê 1 18 

мер графического файла. Они изначально, исходя из предварительного ана-

лиза исходного рисунка, готовят набор характерных именно для него цветов 
(например, 256 цветов), называемый цветовой палитрой (color palette). Ин-

формация об этих цветах записывается в определенном виде в графический 
файл, а потом уже изображение "перерисовывается" кодеком исключительно 
при помощи цветов из созданной палитры. Разумеется, некоторые цвета ис-

ходного рисунка при таком способе компрессии приходится заменять наибо-
лее близкими цветами из палитры, что ухудшает качество изображения, но 

позволяет существенно сократить физический размер графического файла. 
При работе с цветными изображениями на компьютере важно постоянно 
помнить о принципе использования цветовых палитр, и в случае необходи-

мости (для достижения лучшего качества цветопередачи или, напротив, в це-
лях минимизации размера файла) корректировать параметры кодека. 

1.2. Âèäåî 

Все, сказанное выше по отношению к статическим изображениям, относится 
и к видео. Надо лишь помнить о том, что впечатление просмотра видео на 
компьютере создается благодаря быстрому чередованию отдельных статиче-

ских изображений, называемых кадрами (frames). Количество кадров, демон-
стрируемых в течение одной секунды, называется частотой кадров (frame 

rate). Психология человеческого восприятия такова, что при чередовании с 
частотой более 20-ти кадров в секунду они не воспринимаются как отдельные 

изображения, а полностью создают иллюзию просмотра динамической кар-
тины (рис. 1.6). 

 

Рис. 1.6. Иллюзия просмотра видеофильма основана  

на принципе быстрого чередования кадров 

Принцип покадрового видео, как вы знаете, лежит в основе традиционного 
(аналогового) кино и телевидения. Отличие компьютерного представления 
видео проявляется лишь на изложенных нами ранее характеристиках отдель-

ных кадров видео как компьютерных изображений. Сведем все то, о чем  мы 
уже рассказали, и то, о чем только собираемся рассказать, в одну таблицу 

(табл. 1.1) (не касаясь пока звука, рассмотренного в следующем разделе). 
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Заметим, что термином "цифровое видео" здесь и далее мы обозначаем не 
только видео, которое воспроизводится на мониторе компьютера, но и совре-
менные "некомпьютерные" технологии (цифровые видеомагнитофоны, видео-
камеры и т. п.). 

Òàáëèöà 1.1. Öèôðîâîå è àíàëîãîâîå âèäåî 

Параметр Цифровое видео 
Аналоговое видео 
(традиционное ТВ) 

Аналоговое кино 

Разреше- 
ние 

Изображение дискретное, создается пикселами Изображение не-
прерывное, созда-
ется на кинопленке 
на молекулярном 
уровне  

Глубина Определяется числом 
байт, кодирующим ин-
формацию об  интенсив-
ности каждого пиксела 

Бесконечная (непрерывная шкала оттен-
ков, отсутствие градации оттенков, наибо-
лее естественные цвета) 

Качество 
сжатия 

Выбирается пользовате-
лем; при этом за счет 
ухудшения качества изо-
бражения возможно зна-
чительное уменьшение 
размера видеофайла 

Нельзя регулировать, максимальный объ-
ем видеозаписи определяется характери-
стиками носителя (видеолента, киноплен-
ка и т. п.) 

Частота 
кадров 

Иллюзия динамической картинки создается благодаря быстрому че-
редованию отдельных кадров (20 кадров/с и более) 

Звук Цифровой, записывае-
мый по принципу дискре-
тизации 

Аналоговый (бесконечное число градаций) 

 

Исторически сложилось, что разные стандарты кино и ТВ поддерживают раз-

личную частоту кадров. Приведем характеристики некоторых из них: 

� 24 (кадра/c) — используется для создания кинофильмов на кинопленках 

(классический кинематограф); 

� 25 (кадров/c) — стандарт PAL/SECAM, европейский стандарт телеви- 
дения; 

� 29.97 (кадров/c) — стандарт частоты кадров для NTSC (североамери-
канского стандарта телевидения); 

� 30 (кадров/c) — режим, довольно часто применяемый для создания ком-
пьютерных мультимедийных продуктов. 
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При работе с цифровым видео большое значение имеет договоренность о ну-

мерации отдельных кадров. Способ и формат расстановки числовых меток, 
связанных с каждым кадром, называется тайм-кодом (timecode) кадра. Чаще 

всего используется отображение тайм-кода в стандарте NTSC, определяю-
щего нумерацию кадров в пределах каждой секунды фильма, т. е. в виде 
час : минута : секунда : кадр. Например, тайм-код 01:37:10:21 означает 21-й 

кадр 10-й секунды 37-й минуты 1-го часа от начала фильма. Однако наряду с 
таким представлением иногда применяются и альтернативные варианты ну-

мерации кадров (например, сквозная нумерация кадров по порядку от начала 

до конца, без ссылки на время, т. е. 0, 1, 2, …, 100 000, 100 001, 100 002 
и т. д.). 

Подытожим основной принцип компьютерного представления видео: эффект 

восприятия человеческим зрением динамической картины создается благода-
ря последовательной демонстрации (с достаточной частотой) отдельных кад-
ров (см. рис. 1.6). При этом каждый кадр является стандартным компьютер-

ным рисунком, обладая всеми его характерными качествами (рис. 1.7), а для 
уменьшения размеров видеофайлов часто применяются специальные про-

граммы, называемые кодеками, большинство из которых используют прин-
цип схожести последовательных кадров друг с другом. 

 

Рис. 1.7. Качество цифрового видео зависит от разрешения  
и других параметров отдельных кадров 

1.3. Çâóê 

Посвятим данный раздел объяснению основных моментов возникновения, 

распространения и восприятия человеком звука, а также главным парамет-
рам, связанным с представлением цифровой аудиоинформации. 

1.3.1. ×òî òàêîå çâóê? 

С физической точки зрения, звук в широком смысле этого слова, представля-

ет собой колебания частиц окружающей среды (воздуха), передающиеся от 
точки к точке. Процесс распространения звука (в несколько упрощенном  

виде) происходит следующим образом. Некоторый источник (например, 
струна музыкального инструмента, мембрана динамика акустической систе-
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мы и т. п.) совершает быстрые колебания с определенной частотой и ампли-

тудой. Частотой называется количество повторений цикла колебаний в се-
кунду, а амплитудой — максимальное отклонение колеблющегося тела от 

среднего состояния, измеряемое, например, в миллиметрах. 

В результате взаимодействия источника звука с окружающим воздухом час-

тицы воздуха начинают сжиматься и расширяться в такт (или "почти в такт") 
с движениями источника звука. Затем, в силу свойств воздуха как текучей 

среды, происходит передача колебаний от одних частиц воздуха другим 
(рис. 1.8). 

 

Рис. 1.8. К объяснению распространения звуковых волн 

В результате колебания передаются по воздуху на расстояние, т. е. в воздухе 

распространяется звуковая или акустическая волна, или, попросту, звук. 
Звук, достигая уха человека, в свою очередь, возбуждает колебания его чув-

ствительных участков, которые воспринимаются нами в виде речи, музыки, 
шума и т. д. (в зависимости от свойств звука, продиктованных характером его 
источника). 

Чем больше амплитуда колебаний источника, тем больше интенсивность воз-
буждаемых им звуковых волн (т. е. значение локальных сжатий и разрежений 

воздуха, происходящих в звуковой волне), следовательно, тем громче звук, 
воспринимаемый нашими органами слуха. Интенсивность звука в технике 

принято измерять в децибелах, сокращенно дБ (dB). Зависимость интенсивно-
сти звука от времени (рис. 1.9) является исчерпывающей информацией об 

этом звуке. 
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Рис. 1.9. График динамики интенсивности звуковых волн  

является их исчерпывающей характеристикой 

Частота звука, как уже было сказано, измеряется в единицах в секунду —  
в герцах, сокращенно Гц (Hz). Частота определяет высоту тона, восприни-

маемую нашим ухом. Малые, или низкие, частоты (порядка сотен герц) свя-
заны в нашем сознании с глухими басами, а большие, или высокие, частоты 

(десятки тысяч герц) — с пронзительным свистом. Таким образом, человече-
ский слух способен воспринимать звук от сотен до десятков тысяч герц, а 
более низкие и более высокие, чем порог слышимости, частоты называются 

соответственно инфразвуком и ультразвуком. 

 
В отношении звуковых волн часто используются производные единицы часто-
ты — килогерц (кГц), равный 1000 Гц и, реже, мегагерц (МГц), равный 10

6
 Гц. 

Чтобы не запутаться, имейте в виду, что мегагерцы, описывающие быстродей-
ствие компьютеров, никакого отношения к звуку не имеют (они определяют час-
тоту электрических колебаний в процессоре). 

На самом деле, подавляющее большинство знакомых нам звуков не является 
колебаниями определенной частоты, а представляют собой смесь различных 

частот, или спектр. Однако некоторые частоты в спектре, чаще всего, доми-
нируют, определяя наше общее впечатление от звука, который мы слышим 

(об этом можно судить и по приведенному на рис. 1.9 графику интенсивности 
звука). 

Итак, звук является акустическими волнами, передаваемыми в воздухе, и его 
основными характеристиками являются частота и интенсивность, а полно-
ценной записью звуковых волн может быть признан временной график ин-

тенсивности. 

1.3.2. ×àñòîòà äèñêðåòèçàöèè 

Очевидно, что для записи звука на компьютере требуется представить в циф-
ровом виде график зависимости интенсивности звука от времени. Для этого 

достаточно записать в аудиофайл последовательные значения интенсивности 
звука, измеренные через определенные (чаще всего, равные) промежутки 
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времени (рис. 1.10). Чем чаще будет произведена такая запись, тем большая 

информация о звуке будет сохранена, и, соответственно, тем лучше и естест-
веннее будет передан при помощи компьютера звук, однако тем большим по 

размеру получится звуковой файл. 

 

Рис. 1.10. Цифровое представление звука связано  
с дискретизацией временной зависимости интенсивности 

Итак, частотой дискретизации (rate) называется частота записи графика ин-

тенсивности, при помощи которой звук представляется в цифровом виде. На-

пример, частота 5000 Гц означает, что каждая запись звука производится че-

рез временные интервалы 1 / 5000 = 0.0002 с. 

Очевидно, что частота дискретизации для звуковых файлов имеет то же зна-

чение, что и разрешение для видеофайлов. 

1.3.3. Ãëóáèíà êîäèðîâêè çâóêà (ôîðìàò) 

Подобно действию рассмотренного нами ранее для видеофайлов параметра 

глубины пиксела, в аудиофайлах каждое текущее значение интенсивности 

звука может быть кодировано с использованием различного числа возмож-

ных градаций. Таким образом, глубина кодировки звука определяет количе-

ство битов информации, кодирующих интенсивность звуковой волны в каж-

дый момент времени. Очевидно, что, чем больше количество записываемых в 

звуковой файл битов, тем с лучшей точностью и разрешением по интенсив-

ности прописывается в цифровом виде звук, тем лучше и естественнее каче-

ство звучания. 

Поясним сказанное на простом примере (рис. 1.11). Рассмотрим малый ин-

тервал времени, для которого имеется несколько измеренных значений ин-

тенсивности (для определенных отсчетов времени с равными промежутка-

ми). Эти значения интенсивности обозначены на рисунке крестиками. Если 

использовать большую глубину кодировки, то при помощи достаточного 

числа бит информации можно записать в звуковой файл данные значения 

интенсивности с большой точностью (столбики на рис. 1.11, б). Однако в 
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целях уменьшения размера файла глубина кодировки может быть уменьше-

на. Это означает, что имеющееся в распоряжении компьютера число бит 

информации будет недостаточным, чтобы записать точные значения интен-

сивности, а вместо них в файл будут записаны наиболее близкие допусти-

мые значения (столбики на рис. 1.11, а). Разумеется, из-за отличий в исход-

ном звуковом сигнале и записанной в аудиофайл информации качество вос-

произведения звука во втором случае будет гораздо худшим. Подчеркнем, 

что в обоих случаях использовалось одинаковое значение частоты дискре-

тизации. 

 

                                                  а                                                                  б 

Рис. 1.11. К объяснению смысла параметра глубины кодировки звука  

(глубина кодировки левого графика меньше) 

1.3.4. Ìîíî è ñòåðåî 

Упомянем о хорошо известном всем стереофоническом эффекте, позволяю-

щем синхронно воспроизводить из двух различных динамиков различный 

звук. Как известно, формат Моно связан с записью в аудиофайл одной звуко-

вой дорожки, а формат Стерео — двух (в последнем случае размер файла по 

сравнению с монофоническим удваивается благодаря записи в один аудио-

файл двух зависимостей интенсивности звука от времени — пример показан 

на рис. 1.12). 

В последнее время все более широкую популярность приобретают многока-

нальные стереофонические эффекты (предусматривающие воспроизведение 

не двух, а большего числа звуковых каналов, что, естественно, в соответст-

вующее число раз увеличивает размеры файлов). В этом случае важную роль 

приобретает схема расстановки динамиков относительно слушателя, по-

скольку многоканальная стереофония позволяет создать полноценный "эф-

фект присутствия" (хорошим примером является стандарт Dolby Surround, 

применяемый в современном кинематографе). 
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Рис. 1.12. Формат Стерео связан с синхронной записью  
в один файл двух звуковых каналов 

1.3.5. Êà÷åñòâî (êîìïðåññèÿ) 

Чем больше частота дискретизации и глубина кодировки звука, тем качест-

веннее результат воспроизведения аудиофайла, но и, к сожалению, тем боль-
ше его физический размер.  Для уменьшения размеров звуковых файлов при-

меняются специальные программы, называемые (как и в случае видеофайлов) 
компрессорами, или кодеками (codec). Процедуру уменьшения размера зву-
кового файла также называют компрессией, или аудиосжатием. 

В последнее время (в основном, благодаря широко известному формату MP3) 

появились новые, попросту фантастические, возможности чрезвычайно эф-
фективно сжимать звуковые файлы, оставляя их качество очень хорошим. 
Эти технологии постоянно совершенствуются, с каждым годом открывая для 

пользователей все более широкие возможности. 
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Çíàêîìñòâî ñ Premiere 

 

Начнем наше первое знакомство с приложением Premiere с описания первых 
шагов работы с этой программой и описания ее интерфейса. 

� Чего мы хотим: 

• понять базовые принципы монтажа в Premiere и выяснить назначение 
основных окон Premiere — Project (Проект), Monitor (Монитор) и 
Timeline (Монтаж); 

• познакомиться с элементами интерфейса Premiere; 

• освоить операцию импорта клипов; 

• разобраться с принципами сохранения редактирования фильмов в фай-
лах проектов. 

� Нам потребуется: 

• сама программа Premiere, которая должна быть установлена на вашем 
компьютере; 

• любой видеофайл. 

2.1. Íà÷àëî ðàáîòû â ïðîãðàììå Premiere 

Рассмотрим последовательность первых шагов в программе Premiere. 

 

Загрузить пробную версию программы Premiere для ознакомительных целей 
(она будет функционировать на вашем компьютере в течение месяца) можно 
бесплатно с сервера компании-разработчика www.adobe.com. Приобрести саму 
программу можно у российского дистрибьютора — компании АТРИ-Графикс: 
www.az-graphics.ru. 
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2.1.1. Çàïóñê Premiere 

После завершения установки программы на вашем компьютере нажмите 

кнопку Start (Пуск) и затем выберите в главном меню ОС Windows пункт 
Adobe Premiere Pro 2.0 (рис. 2.1). 

 

Впоследствии вы сможете запускать приложение Premiere двойным щелчком на 
файлах проектов, которые вы до этого сохранили. Эти файлы, начиная с новой 
версии Premiere Pro, имеют расширение prproj (например, start.prproj). 

 

Рис. 2.1. Запустите Premiere при помощи главного меню Пуск 

После загрузки на экране возникнет окно приглашения Premiere, на фоне ко-
торого появится диалоговое окно с приглашением Adobe Premiere Pro.  
В нем можно либо открыть один из недавно редактировавшихся проектов, 

щелкнув на его имени в списке Recent Projects (Последние проекты), либо 
(нажатием соответствующей кнопки) выбрать одно из следующих действий 

(рис. 2.2): 

� New Project (Создать проект) — начало монтажа нового (пустого) про- 

екта; 

� Open Project (Открыть проект) — открытие существующего проекта пу-
тем выбора соответствующего файла; 

� Help (Справка) — обращение к справочной системе. 

Если вы выберете опцию создания нового проекта, то перед загрузкой содер-

жимого основного окна Premiere вам будет предложено определить его уста-
новки, т. е. основные параметры, определяющие настройки окон, в которых 
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будет происходить редактирование проекта (размер изображения фильма, 

частота кадров, способ нумерации кадров и т. п.). 

 

Рис. 2.2. Начните работу в Premiere с создания нового проекта 

Управление процессом монтажа отдельного фильма в рамках работы 

с Premiere построено на основе понятия проекта (project). Проект является 

естественным объединением создаваемых вами фильмов и является своеоб-

разной записью программы действий по монтажу их элементов — клипов. По 

аналогии, к примеру, с программой Microsoft Word, фильм в Premiere соот-

ветствует по смыслу документу Word. Только в последнем вы создаете пе-
чатный текст, а в проекте Premiere — видеофильм. 

2.1.2. Âûáîð óñòàíîâîê ïðîåêòà 

Мы начнем работу с создания нового проекта и разберемся с особенностями 

интерфейса программы. Для этого нажмите кнопку New Project (Создать 

проект) в диалоговом окне с приглашением. В результате загружается одно-

именное окно New Project (Создать проект) (рис. 2.3), которое предназначено 

для предварительного определения атрибутов создаваемого фильма (таких 

как разрешение изображения, частота кадров, качество звука и т. д.). Это  
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диалоговое окно содержит две вкладки, предоставляющие пользователю две 

альтернативные возможности выбора установок: 

� Load Preset (Загрузить предустановку) — выбор одной из имеющихся в 

Premiere предустановок (предварительно составленного набора устано-
вок); 

� Custom Settings (Настройка установок) — задание установок вручную. 

 

Рис. 2.3. Выберите в качестве для проекта одну из предустановок 

Предустановки нужны для быстрого задания комбинаций параметров филь-
ма. Они выбираются в диалоговом окне New Project (Создание проекта)  

в левом списке Available Presets (Доступные предустановки). Определив  
предустановку, можно затем изменить некоторые ее параметры вручную, об-

ратившись к вкладке Custom Settings (Настройка установок). 

 

В Premiere Pro следует намного серьезнее, чем в предыдущих версиях, отно-
ситься к выбору установок создаваемого проекта. Некоторые из них впоследст-
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вии поменять не удастся. Например, если вы определили для  проекта один из 
форматов семейства DV (Цифровое видео), то при работе с ним изменить та-
кие установки, как размер кадра, будет уже нельзя. 

Разработчиками Premiere скомпонованы несколько семейств установок, отно-

сящихся к технологии цифрового видео (Digital Video).  Эта технология в по-

следнее время стала стандартом современных видеоустройств и применяется 

как для записи на DVD, так и для непосредственной передачи видеосигнала с 

компьютера на подключенное к нему внешнее цифровое устройство. 

Несколько стандартов цифрового видео характеризуются, в частности, раз-

личным размером кадра, частотой кадров и др. Следует отметить следующие 

форматы: 

� NTSC (североамериканский стандарт телевещания) — установки для теле- 

и видеопрограмм в стандарте NTSC, размер кадра (в пикселах): 720×480; 

� PAL (европейский стандарт телевещания) — установки для теле- и видео-

программ в стандарте PAL, размер кадра: 720×576; 

� HDV (видео высокого разрешения) — более современные форматы, отли-

чающиеся наилучшим качеством изображения, размеры кадра: 1280×720 и 

больше (например, 1920×1080); 

� 24p (24p) — самые последние форматы, приближающие цифровое видео 

по качеству восприятия зрителями к съемке на кинопленку (предусмотрен 

ряд различных значений размеров кадра, главным образом высокого раз-

решения). 

 

Мы привели очень упрощенную классификацию форматов цифрового видео, 
которая, возможно, покажется профессионалам недостаточной. На самом деле, 
форматов и их сочетаний больше, причем каждый год, в результате развития 
технологий, рождаются новые стандарты. 

В соответствии с целью работы вам следует выбрать одну из этих предуста-

новок из списка, ориентируясь также на их дополнительные параметры (см. 

рис. 2.1). Стандарты цифрового видео отличаются частотой модуляции зву-

кового сигнала (наиболее популярные стандарты 32 и 48 кГц) и отношением 

размера экрана — Standard (Стандартный), т. е. 4:3, и Widescreen (Широко-

экранный), т. е. 16:9. 

Если вы затрудняетесь с выбором, отметьте в списке Available Presets (Дос-

тупные предустановки) пункт DV - PAL - Standart 32kHz (Цифровое видео - 

стандарт PAL - Стандартный звук 32 кГц) (рис. 2.3). Это будет означать, что 

для дальнейшей работы будет выбран набор установок, составленный разра-

ботчиками Premiere, предназначенный для создания фильма в формате PAL 
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(европейском стандарте телевидения). После того как вы выберете одну из 

предустановок, параметры, составляющие ее набор, отобразятся на панелях 

Description (Описание) справа. 

 

Предустановки DV - PAL  или DV - NSTC предназначены для подготовки филь-
мов в стандарте DV (Digital Video — цифровое видео) и подразумевают, чаще 
всего, что созданный фильм будет затем экспортироваться либо на DVD-диск, 
либо на внешнее DV-устройство, подключенное к компьютеру. Если вы соби-
раетесь разрабатывать фильмы для других целей, обратитесь к разд. 2.1.3, по-
священному определению установок вручную. 

2.1.3. Î çàäàíèè óñòàíîâîê ïðîåêòà âðó÷íóþ * 

Вообще говоря, установки проекта можно задать не только при помощи вы-

бора соответствующего набора предустановок, но и вручную. Миновать это-
го шага создания нового проекта не удастся, если вам требуется нестандарт-

ный набор установок. 

Установки различных типов сгруппированы на нескольких страницах, от-

крывающихся в данной закладке при выборе определенного элемента списка. 
На рис. 2.4 показана группа элементов интерфейса, настраивающих общие 
установки General (Общие). Они включают две установки, определяющие 

среду редактирования: Editing Mode (Режим редактирования) и Timebase 

(Временная база), а также Video (Установки видео) и Audio (Установки звука). 

Îáùèå óñòàíîâêè 

Общие установки связаны с выбором подходящей среды редактирования ви-
део в зависимости от типа фильма, который вы намерены получить в резуль-
тате монтажа. 

� Editing Mode (Режим редактирования) — раскрывающийся список, опре-

деляющий основные параметры фильма. Главным образом режим редак-
тирования определяет список доступных параметров кадра (разрешение, 
тип развертки, частота кадров) и совместимых программ-компрессоров, 

находящийся в установках видеорендеринга. Отметим две основные воз-
можности: 

• DV (Цифровое видео) — семейство режимов редактирования с предус-

тановленными базовыми параметрами (такими, к примеру, как размер 
кадра), включающее форматы NTSC, PAL, 24p и т. д., предусматри-

вающих воспроизведение фильма как в окне Program (Программа) 
Premiere, так и на внешнем цифровом устройстве, специальным обра-

зом подключенном к вашему компьютеру; 
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• Desktop (Рабочий стол) — режим редактирования, позволяющий вруч-

ную задать все параметры проекта и поэтому наиболее подходящий для 

пользователей ОС Windows (применяется, например, для подготовки 
мультимедийных файлов для просмотра на компьютере). 

 

Рис. 2.4. Вкладка Custom Settings диалогового окна New Project  
позволяет задать все установки проекта вручную  
(включен режим редактирования проекта DV PAL) 

Обратите внимание, что при выборе режимов редактирования семейства DV 

(Цифровое видео) DV многие установки (в частности, размер кадра) изменять 
нельзя, поскольку они определяются самим выбранным стандартом Digital 

Video. Например, стандарт PAL подразумевает размеры кадра 720×576 пик-

селов, частоту кадров — 25 кадров в секунду и отношение размеров отдель-
ного пиксела — либо 1.067 (для стандартного экрана 4:3), либо 1.422 (для 
широкоэкранного, 16:9, видео). 

Если вы собираетесь создавать фильм для других целей, отличных от исполь-

зования технологии DV, следует выбрать режим Desktop (Рабочий стол) 
(рис. 2.5). 
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� Timebase (Временная база) — раскрывающийся список, задающий способ 

отсчета времени фильма, т. е. временные метки на шкале времени в окне 
Timeline (Монтаж) и Program (Программа), с помощью которых Premiere 

разбивает фильм (в том числе для вычисления временного положения ли-
нии редактирования). Предусмотрены следующие возможные значения 
временной базы: 

• 23.976 frames/second (23.976 кадра/c) — используется в стандарте циф-

рового видео 24p; 

• 24 frames/second (24 кадра/c) — используется для создания видео при 

переносе кинофильмов на кинопленках; 

• 25 frames/second (25 кадров/c) — режим, подходящий для частоты кад-

ров PAL/SECAM (европейского стандарта телевидения); 

• 29.97 frames/second (29.97 кадров/c) — режим для частоты кадров 

NTSC (североамериканского стандарта телевидения); 

 

Рис. 2.5. На странице общих установок проекта выбран  
режим редактирования Desktop 
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• 30 frames/second (30 кадров/c) — режим, применяемый для мультиме-

дийных продуктов и других стандартов; 

• 59.94 frames/second (59.94 кадра/c) — используется в одном из специ-

альных стандартов видео высокого разрешения HD-SDI 720p; 

• 60 frames/second (60 кадров/c) — тоже режим для мультимедийных 

продуктов, позволяющий редактировать видео с удвоенной частотой. 

В зависимости от частоты кадров, которая будет использоваться в смонтиро-
ванном фильме, удобно выбирать то или иное значение временной базы. Если 
фильм будет воспроизводиться на теле- или видеосистеме стандарта 

PAL/SECAM (в частности, принятом в России), то он должен иметь частоту 
25 кадров/c. Естественно, что для монтажа такого фильма удобно использо-

вать и временную базу 25 кадров/c, т. е. разбиение каждой секунды фильма в 
окне Timeline (Монтаж) шкалой времени на 25 кадров. 

Óñòàíîâêè âèäåî 

На той же самой странице с общими установками имеется еще одна группа 

элементов интерфейса Video (Установки видео) (см. рис. 2.4 и 2.5). Перечис-
лим эти установки: 

� два поля Frame Size (Размер кадра) — определяют размеры кадра в пиксе-
лах по горизонтали и вертикали; 

� раскрывающийся список Pixel Aspect Ratio (Пропорции пиксела) — уста-
навливает отношение размеров пиксела. В некоторых стандартах телеви-

дения (например — DV NTSC, DV 1), в отличие от компьютерных мони-
торов, используются не квадратные, а прямоугольные пикселы. В случае 

выбора неправильной пропорции пикселов изображение фильма при про-
смотре его на мониторе соответствующего стандарта будет искаженным 
(вытянутым по горизонтали или вертикали), но на экране монитора ком-

пьютера фильм может смотреться правильно. Если вы не работаете в фор-
мате DV, то в большинстве случаев верным будет выбор варианта Square 

Pixel (Квадратные пикселы), если же вы собираетесь демонстрировать 
фильм на специальной телевизионной аппаратуре, обязательно сверьтесь 

со стандартом пропорций пиксела, которые в ней используются; 

� раскрывающийся список Fields (Поля) — устанавливает различные фор-

маты чересстрочной или прогрессивной развертки при воспроизведении 
видео на внешнем устройстве. Если вы монтируете фильм, тут же про-
сматривая его на внешнем мониторе, то сверьтесь с руководством по экс-

плуатации монитора, чтобы правильно выставить данную опцию. Боль-
шинство телевизоров используют чересстрочную развертку (причем либо 

верхние, либо нижние группы строк могут воспроизводиться первыми). 
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Новый стандарт 24p, как и "пленочное" кино, использует прогрессивную 

развертку, что намного улучшает качество восприятия зрителями; 

� раскрывающийся список Time Display Format (Формат отображения вре-

мени) — определяет формат нумерации кадров на шкале времени в окне 
Timeline (Монтаж) и на табло в окне Monitor (Монитор). Этот параметр 
тесно связан с общей установкой Timebase (Временная база) и был под-

робно рассмотрен на вводном уроке (см. разд. 1.2); 

� поля ввода числовых параметров Title Safe Area (Безопасная зона титров) 

и Action Safe Area (Безопасная зона действия) — задают размер областей 
на кадре фильма (в процентах от его полного размера), в пределах кото-
рых титры и картинка фильма будут передаваться без искажений. Извест-

но, что различная воспроизводящая телевизионная аппаратура может не-
сколько "обрезать" или исказить фильм на границах кадра. Для того чтобы 

пользователь мог ориентироваться в величине безопасных областей, соот-
ветствующие рамки могут отображаться в окне Monitor (Монитор). 

Óñòàíîâêè àóäèî 

Установки, определяющие параметры кодирования звука, выбираются в 
группе элементов Audio (Установки звука) на странице General (Общие): 

� раскрывающийся список Sample Rate (Частота) — определяет частоту,  
с которой звук представляется в цифровом виде. Например, частота 
32000 Hz означает, что запись звука производится с временным интерва-

лом 1 / 32000 × 0.00003 с. Чем выше частота, тем, как правило, лучше и ес-
тественнее звук; 

� раскрывающийся список Display Format (Формат отображения звука) — 

определяет формат измерения интенсивности звука (сэмплы или миллисе-
кунды) на соответствующих амплитудных графиках. 

Óñòàíîâêè îöèôðîâêè 

Установки проекта, находящиеся на странице Capture (Оцифровка), относят-
ся к процессу передачи изображения с внешнего устройства на компьютер. 

Раскрывающийся список Capture Format (Формат оцифровки) задает фор-
мат, в котором будет производиться видеозахват. По умолчанию в Premiere 

имеется формат DV, который соответствует передаче цифрового видеосигна-
ла через стандартный порт IEEE 1394. Если на вашем компьютере имеются 
иные устройства оцифровки (capture device), то список Capture Format 

(Формат оцифровки) будет содержать дополнительные элементы, которые 
следует выбрать при передаче видео с того или иного устройства. 
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Óñòàíîâêè ðåíäåðèíãà 

Установки рендеринга (рис. 2.6) определяют алгоритм расчета содержимого 

фильма по программе действий пользователя, записанных в окне Timeline 
(Монтаж). Напомним, что рендерингом (rendering) называется процесс по-

строения изображения каждого кадра по его описанию, которое пользователь 
создает в процессе монтажа фильма. Рендеринг производится для предвари-
тельного просмотра рабочей области фильма или при его экспорте (в послед-

нем случае вместо установок проекта применяются задаваемые отдельно ус-
тановки экспорта). Предварительный просмотр выполняется либо при нажа-

тии клавиши <Enter>, либо при выборе команды Sequence>Render Work 

Area (Фильм>Рендеринг рабочей области). 

 

Рис. 2.6. Установки рендеринга 

Перечислим установки рендеринга. 

� Флажок проверки Maximum Bit Depth (Максимальная глубина цвета) ус-
танавливает опцию задания максимально возможного (для данного вы-
бранного кодека) цветового разрешения, вплоть до 32-битной цветовой 
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палитры. Если выбранный кодек поддерживает только одну глубину цве-

та, то данный флажок будет недоступным. 

� Раскрывающийся список File Format (Формат файла) определяет стандарт 
вида, применяемый для создания файлов предварительного просмотра. 
Формат Video for Windows (Видео для Windows) наиболее подходит для 
подготовки мультимедийных файлов для просмотра на компьютере, а раз-
личные стандарты DV (Цифровое видео) предусматривают подготовку ви-
део в том или ином стандарте, соответственно выбранному режиму редак-
тирования. 

� Раскрывающийся список Compressor (Компрессор) выбирает кодек, кото-
рый будет использоваться для сжатия изображения и звука. Выбирайте те 
кодеки, которые, с одной стороны, обеспечат хорошее качество изображе-
ния, а с другой — скорость расчетов и приемлемый физический размер 
видеофайла (если это имеет для вас значение). Если выбрать элемент None 
(Нет), то сжатия видео производиться не будет, соответственно качество 
фильма при экспорте не ухудшится, однако файл, в результате, получится 
очень большим. 

� Раскрывающийся список Color Depth (Глубина цвета)  определяет число 
цветов, которые могут использоваться для представления пиксела изобра-
жения. Чем больше глубина пиксела, тем качественнее картинка, но тем 
больше ресурсов компьютера требуется (в частности, тем большим полу-
чается файл предварительного просмотра). Но некоторые кодеки не по-
зволяют регулировать глубину пиксела, используя всегда определенное 
количество цветов в палитре (например, 256 цветов, или 8-битную глуби-
ну цвета, как кодек Microsoft RLE). 

� Флажок Optimize Stills (Оптимизировать статические кадры) — позволяет 
существенно сэкономить ресурсы компьютера при рендеринге статиче-
ских изображений. Если флажок выставлен, то вместо создания последо-
вательности идентичных кадров будет создан единственный кадр опреде-
ленной длительности. 

 

Большинство из перечисленных установок при работе с цифровым видео будет 
недоступно, т. к. они однозначно определяются выбранным режимом редакти-
рования. Поэтому для выбранного стандарта DV (Цифровое видео) перечис-
ленные элементы управления имеют, большей частью, информационное на-
значение. 

Óñòàíîâêè ôèëüìà ïî óìîë÷àíèþ 

Установки на странице Default Sequence (Фильм по умолчанию) определяют, 
в каком виде будут открываться вновь создаваемые фильмы в окне Timeline 
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(Монтаж), а именно, какое количество видео- и аудиотреков будет создано 

изначально. Имейте в виду, что впоследствии при работе с проектом число 
доступных треков можно изменить как в большую, так и в меньшую сторону. 

Установки фильма по умолчанию включают следующие поля ввода (рис. 2.7): 

� Video (Видео) — начальное число видеотреков; 

� Mono (Моно) — начальное число монофонических (одноканальных)  

аудиотреков; 

� Stereo (Стерео) — начальное число стереофонических (двухканальных) 
аудиотреков; 

� 5.1 — начальное число многоканальных аудиотреков, 6-канальный звук 
(3 фронтальных канала + 2 тыловых + 1 низкочастотный). 

Три последних установки присутствуют на странице Default Sequence 

(Фильм по умолчанию) в двойном экземпляре — для рабочих аудиотреков и 

треков субмикширования. Таким образом, число аудиотреков определяется 
независимо для этих двух типов треков. 

 

Рис. 2.7. Установки фильма по умолчанию 
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Как вы видите, начиная с новой версии Premiere Pro, аудиотреки подразделя-
ются на три типа согласно формату аудиозаписей. Соответственно, клипы с 
монофоническим звуком могут располагаться только на монофонических  
аудиотреках и т. д. 

2.1.4. Âûáîð íàçâàíèÿ ôàéëà ïðîåêòà 

Чтобы завершить подготовительные действия по созданию нового проекта, 
введите в нижнее текстовое поле Name (Название) его название. В поле 
Location (Расположение) над ним задайте путь к папке на вашем компьютере, 
куда будет сохранен файл с проектом. После нажатия в диалоговом окне New 
Project (Создание проекта) кнопки ОК новый проект будет загружен в окно 
Premiere. 

2.2. Îñíîâû èíòåðôåéñà Premiere 

Вид окна Premiere после первого запуска показан на рис. 2.8. Рассмотрим в 
этом разделе основные составляющие интерфейса Premiere. 

2.2.1. Îêíà è çàêëàäêè 

После определения установок в основное окно Premiere загрузится несколько 
дочерних окон (на самом деле, точнее было бы называть их панелями), каж-
дое из которых предназначено для проведения определенных действий по 
редактированию проекта (рис. 2.8). Самыми важными являются окна: 

� Project (Проект) — для управления составом проекта (исходными клипа-
ми, импортированными из внешних файлов, и фильмами, которые вы ре-
дактируете); 

� Timeline (Монтаж, или Монтажный стол) — для монтажа фильма при  
помощи схематического расположения вдоль временной шкалы состав-
ляющих его клипов, символически представленных прямоугольными бло-
ками; 

� Monitor (Монитор) — для просмотра изображения кадров исходных кли-
пов и фильмов, а также для визуального монтажа. Это окно присутствует в 
Premiere в нескольких вариантах, главными из которых являются окна 
Program (Программа), предназначенном для отображения скомпилиро-
ванных кадров фильма, и Source (Источник), применяемое для просмотра 
исходного видеоматериала (клипов). 

Окно Project (Проект) является библиотекой фильмов и клипов, а два других 
окна служат, собственно, для управления процессом монтажа. Все три окна  
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Рис. 2.8. Вид окна Premiere после первого запуска 

имеют (в их верхней части) закладки, позволяющие отобразить информацию, 
относящуюся к определенному объекту. В частности, закладки окон Timeline 
(Монтаж) и Program (Программа) являются ничем иным, как идентификато-
ром фильма, открытого в данный момент. Новый проект открывается в 
Premiere с автоматически добавленным в него фильмом, который, как видно 
из рис. 2.8, называется по умолчанию Sequence 01. Строка с таким названием 
находится в окне Project (Проект), а закладки открыты в окнах Program 
(Программа) и Timeline (Монтаж), что говорит о приложении действий поль-
зователя к монтажу именно этого (активного) фильма. Если бы в проекте бы-
ли созданы и открыты в окнах Program (Программа) и Timeline (Монтаж) 
другие фильмы, то активный фильм можно было бы определить по выделен-
ной закладке. 

 

Несколько забегая вперед, скажем, что термином клип (clip) мы называем со-
держимое исходных медиафайлов (видео, звуковых или графических), а терми-
ном фильм (sequence) — предмет вашей работы в Premiere, т. е. финальное 
видео, которое вы монтируете из клипов. 
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Помимо трех основных окон, которые используются при монтаже фильма, на 
экран выводятся еще несколько вспомогательных окон  (см. рис. 2.8). Они 
применяются, главным образом, для специфических действий, облегчения 
процесса монтажа и вывода дополнительной информации. 

Принцип монтажа в Premiere основан на выполнении над исходными клипа-
ми в окне Timeline (Монтаж) действий определенного типа, для чего следует 
использовать соответствующий инструмент. В каждый момент времени мо-
жет быть активным только один инструмент, а выбрать его можно в специ-
альной палитре — Tools (Инструментарий). 

Все окна допускается перемещать по экрану (перетаскивая за заголовок окна) 
и изменять их размер (перетаскивая нужную границу окна), настраивая тем 
самым рабочую область в виде, наиболее удобном для конкретного пользова-
теля. Одно из окон всегда является активным, о чем говорит оранжевая рам-
ка, окаймляющая окно по периметру. Все действия пользователя в Premiere 
(включая применение горячих клавиш) касаются именно активного окна. Для 
того чтобы сделать то или иное окно активным, достаточно щелкнуть мышью 
в его пределах. 

 

Следите за тем, какое из окон является активным в каждый момент времени. 
От этого, в частности, решающим образом зависят действия Premiere в ответ 
на нажатие вами клавиш на клавиатуре, выбор пунктов меню и т. п. 

 

Рис. 2.9. Вызов на экран временно скрытых окон 
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Если нужное вам окно отсутствует на экране, перейти к нему легко, восполь-

зовавшись соответствующей командой меню Window (Окно) (рис. 2.9). 

2.2.2. Ýëåìåíòû óïðàâëåíèÿ 

Для выполнения действий по управлению клипами и монтажу фильма в 
Adobe Premiere имеются следующие элементы интерфейса: 

� верхнее меню (menu bar) — строка меню, находящаяся под заголовком 

окна Adobe Premiere (см. рис. 2.8); 

� контекстные (всплывающие) меню (context menu, pop-up menu) — меню, 

появляющиеся при нажатии в том или ином месте правой кнопки мыши. 
Это особенно удобный способ редактирования, поскольку состав всплы-
вающих меню зависит от того места, в котором вы его вызываете, и вам 

легко найти в нем нужную команду (рис. 2.10); 

 

Рис. 2.10. Содержимое контекстного меню зависит от места его вызова 

� меню окон (window menu) — специфические меню, характерные для про-
дуктов компании Adobe  и не очень привычные для пользователей других 

программ ОС Windows. Эти меню вызываются нажатием кнопки с тре-
угольной стрелкой, которую легко отыскать в правой верхней части каж-

дого окна и почти каждой палитры (рис. 2.11), и содержат наборы команд, 
характерные для данного окна или палитры; 
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Рис. 2.11. Меню окна Project 

� панели инструментов (toolbars) — многочисленные панели, размещенные 
в окнах и комбинирующие различные элементы управления; 

� горячие клавиши (shortcuts) — очень эффективный способ для опытных 
пользователей. Если вы часто применяете определенные команды, намно-

го быстрее выполнять их нажатием сочетания клавиш на клавиатуре, чем 
вызовом меню или инструментов; 

� активные надписи и регуляторы параметров — характерные элементы 
интерфейса, применяемые для регулировки различных числовых парамет-

ров. Например, одна из таких надписей представляет собой тайм-код те-
кущего кадра в окне Timeline (Монтаж) (рис. 2.12). Числовое значение па-

раметра, представленного активной надписью, как правило, можно изме-
нить непосредственно с клавиатуры, щелкнув предварительно на надписи 
мышью (рис. 2.13), а перетаскивание линии подчеркивания влево или 

вправо указателем мыши уменьшает или увеличивает значение параметра 
соответственно (именно эта ситуация проиллюстрирована рис. 2.12). Не-

которые регуляторы параметров выполнены в виде характерных индика-
торов, позволяющих визуальным способом корректировать их значение; 
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Рис. 2.12. Активная надпись Рис. 2.13. Ввод значения тайм-кода  

с клавиатуры 

� вложенные списки — еще одна деталь интерфейса, характерная для слож-

ных программ, позволяющая представить в компактной форме группы 
сходных по смыслу параметров того или иного объекта. Вложенные спи-
ски устроены в виде иерархической последовательности списков, объеди-

няющих группы сходных по смыслу параметров. Для того чтобы развер-
нуть скрытую часть вложенного списка, достаточно щелкнуть на харак-

терной треугольной кнопке, обращенной вправо (рис. 2.14). Для скрытия 
развернутого списка также следует щелкнуть на данной кнопке, которая в 
этом случае будет направлена вниз. 

 

Рис. 2.14. Эффекты, имеющиеся в Premiere, организованы  
в виде иерархического вложенного списка закладки Effects 

Все окна являются связанными тем или иным способом, поэтому, проводя 
редактирование фильма в одном из них, вы изменяете и состояние других 
окон. 
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Важным элементом интерфейса Premiere является указатель мыши. В зави-
симости от места, на которое он наведен, и выбранных сочетаний опций окна 
(например, при том или ином активном инструменте) указатель выглядит по-
разному. Если вы поработаете с Premiere некоторое время, то привыкнете к 
внешнему виду указателя, что будет помогать вам увереннее ориентировать-
ся в возможностях редактирования в каждый момент времени. 

2.2.3. Íàñòðîéêà ðàáî÷åé îáëàñòè 

Разные проекты удобно монтировать при различном взаимном расположении 
и размере окон. Когда вы запасаете проект, Premiere автоматически запоми-
нает размер, взаимное расположение и некоторые установки окон, например, 
вид клипов в окне Project (Проект). Следующий раз при открытии данного 
проекта окна появятся в тех же самых местах. 

Быстро изменить вид рабочей области можно, не обязательно меняя вручную 
размер и расположение окон. Достаточно воспользоваться одной из имею-
щихся встроенных настроек рабочей области. Для этого выберите Window/ 
Workspace (Окно/Рабочая область) и в подменю выберите желаемую на-
стройку (рис. 2.15). Разработчики предусмотрели несколько настроек, пред-
назначенных для определенного характера работы в Premiere: 

� Editing (Монтаж) — для линейного монтажа видео; 

� Effects (Эффекты) — для настройки спецэффектов; 

 

Рис. 2.15. Быстрая настройка рабочей области 
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� Audio (Аудио) — для аудиомонтажа с расширенными возможностями ре-

дактирования звукового ряда фильма; 

� Color Correction (Цветокоррекция) — для настройки цветового баланса 
изображения при соответствующих режимах окна Monitor (Монитор). 

Вовсе не обязательно ограничиваться четырьмя предустановленными на-
стройками рабочей области. Скорее всего, вы выработаете (одну или не-

сколько) индивидуальных настроек рабочей области, которые будут наиболее 
комфортны для тех или иных действий в Premiere. Если оформить эти уста-
новки в виде соответствующих шаблонов настройки рабочей области, то это 

поможет существенно сэкономить время, которое вы затрачиваете на работу 
с фильмами. 

Сохранить понравившуюся настройку рабочей области для использования в 
других проектах можно выбором Window/Workspace/Save Workspace (Ок-

но/Рабочая область/Сохранить рабочую область). После определения имени 
настройки она будет доступна в подменю Window/Workspace (Окно/Рабочая 

область), и использовать ее можно точно так же, как остальные предустанов-
ленные настройки. 

2.2.4. Ñïðàâî÷íàÿ ñèñòåìà 

Для получения англоязычной справочной информации в процессе работы с 
Premiere имеется очень удобная и исчерпывающая система помощи. 

Для ее вызова используйте команду Help>Adobe Premiere Pro Help (Справ-

ка>Справка Adobe Premiere Pro). Справочная система состоит из следующих 
составных частей (рис. 2.16): 

� Contents (Содержание) — статьи справки Premiere, расположенные по по-
рядку в соответствии с оглавлением; 

� Index (Индекс) — выбор статьи из алфавитного указателя. Выберите пер-
вую букву слова из алфавита в левой панели, а затем отыщите в открыв-

шемся списке нужное слово и щелкните на сопровождающей его гипер-
ссылке; 

� Search (Поиск) — поиск статей по ключевому слову (введите слово в поле 
ввода в левой панели и нажмите клавишу <Enter>); 

� Bookmarks (Закладки) — сервис, позволяющий организовать впоследст-
вии быстрый доступ к помеченным вами статьям. 

Если вы неплохо владеете английским языком, не пренебрегайте справочной 

системой — она окажет вам существенную помощь, поскольку буквально в 
несколько щелчков мыши вы найдете в ней интересующую вас статью, со-
провождающуюся прекрасными иллюстрациями и примерами. 
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Рис. 2.16. Справка Premiere 

2.3. Ïîäãîòîâêà êëèïîâ 

Перейдем к первым шагам создания фильмов в Premiere. Вообще говоря, ра-
боту по монтажу фильма можно разбить на следующие этапы. 

1. Создание нового проекта, включая определение его основных установок. 

2. Подготовка исходных файлов и импорт их в проект. 

3. Монтаж фильма из клипов, импортированных в проект. 

4. Возможно, добавление различных спецэффектов. 

5. Добавление  титров при необходимости. 

6. Возможно, разметка фильма на разделы DVD-диска. 

7. Экспорт смонтированного фильма. 
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2.3.1. Èìïîðò êëèïîâ 

При загрузке Premiere (см. разд. 2.1) мы создали новый проект. По умолча-

нию он уже содержит один фильм, и наша следующая задача — это помес-

тить, или импортировать, в проект необходимые файлы, из которых вы со-

бираетесь монтировать фильм, или в терминах видеомонтажа — клипы. По-

этому необходимо иметь видео-, аудио- или графические файлы на своем 

компьютере, работая с которыми в итоге вы получите фильм. 

 

Рис. 2.17. Выберите в диалоговом окне Import файл,  
который вы собираетесь импортировать в проект 

Для того чтобы импортировать клип из внешнего медиафайла в проект: 

1. Выберите в верхнем меню File>Import (Файл>Импорт). 

2. В открывшемся диалоговом окне Import (Импорт) перейдите к нужной 

папке и выделите в ней файл, который вы собираетесь импортировать.  
В нашем случае это файл clip1.avi (рис. 2.17). 

3. Нажмите кнопку ОК. 

В результате клип появляется в окне Project (Проект) (рис. 2.18), и его можно 
использовать для вставки в фильм. 
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Рис. 2.18. Импортированный файл появляется в проекте в виде клипа 

Осуществлять импорт клипов можно и другими, альтернативными, спосо- 
бами: 

� двойным щелчком на пустом месте окна Project (Проект) вызовите диало-
говое окно Import (Импорт) и определите в нем желаемые файлы; 

� вызовите из области, вне списков клипов и папок, окна Project (Проект) 
контекстное меню, выберите в нем команду Import>File (Импорт>Файл) и 

затем работайте в диалоговом окне Import (Импорт); 

� расположите на экране одновременно и окно Premiere, и окно той папки 

Windows, в которой находится нужный медиафайл, а затем перенесите его 
в проект при помощи техники перетаскивания (drag-and-drop) в окно 

Project (Проект). 

Хочется еще раз заметить, что при импорте изображение (или звук) из файла 

ни в коем случае не копируется в файл с проектом Premiere. Проекты содер-

жат лишь ссылки на файлы, и для того, чтобы дать возможность пользовате-
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лю проводить монтаж фильма, считывают информацию из этих файлов. По-

этому, с одной стороны, вы можете без страха импортировать в проекты са-

мые большие файлы (это не вызовет сколько-нибудь существенного увеличе-

ния файла с проектом); но с другой стороны, вы должны заботиться о том, 

чтобы все файлы, импортированные в проект, оставались на своих местах на 

диске. В противном случае, в частности, при переносе проекта на другой 

компьютер вам придется захватить с собой не только файл с проектом, но и 

все медиафайлы, импортированные в него. 

2.3.2. Îöèôðîâêà êëèïîâ * 

Альтернативой импорту файлов является их непосредственная оцифровка, 

или, по-другому, видеозахват, в Premiere. Для этого ваш компьютер должен 

быть оснащен специальными средствами передачи и обработки видеосигнала 

с внешнего устройства, такого как видеомагнитофон, видеокамера, TV-ан-

тенна и т. п. В любом случае, перед тем как начать монтаж фильма, вы долж-

ны иметь его исходные составляющие — клипы. Если вы не собираетесь 

осуществлять оцифровку средствами Premiere, можете смело пропустить этот 

раздел. 

Ïîäãîòîâêà ê âèäåîçàõâàòó 

Для оцифровки клипов в Premiere предусмотрены следующие возможности: 

� без аппаратного контроля — управление воспроизведением видео на 

внешнем устройстве производится непосредственно на этом устройстве 

(например, с помощью кнопок на панели видеомагнитофона). Сигнал по-

ступает на компьютер, а пользователь, выбирая нужный момент, нажимает 

кнопку старта оцифровки, не имея возможности оказать какое-либо влия-

ние на поступление видеосигнала; 

� с применением аппаратного контроля (device control) — управление внеш-

ним устройством осуществляется из Premiere. Иными словами, имеется 

обратная связь, позволяющая командами компьютера включать и останав-

ливать воспроизведение, перематывать видеопленку и т. п. 

Для подготовки к оцифровке видео и/или звука с внешнего устройства: 

1. Подключите надлежащим образом внешний источник видеосигнала к 

компьютеру через устройство оцифровки или порт IEEE 1394. При необ-

ходимости воспользуйтесь инструкциями по эксплуатации устройства 

оцифровки. 

2. Включите воспроизведение видео на внешнем устройстве. Это поможет 

вам сразу определить, надежно ли поступает видеосигнал на компьютер. 
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Как правило, предварительно стоит закрыть все прочие приложения, прини-
мающие с внешнего устройства, в частности сервисную программу, поставляе-
мую с устройством оцифровки. 

3. Выберите в верхнем меню команду File>Capture (Файл>Оцифровка). 

4. Спустя некоторое время, для инициализации внешнего устройства, на эк-
ране появится диалоговое окно Capture (Оцифровка) (рис. 2.19). Если на 

внешнем устройстве идет воспроизведение видеопрограммы, то понаблю-
дайте за ее качеством в области предварительного просмотра в левой час-
ти этого диалогового окна. 

 

Рис. 2.19. Диалоговое окно Capture 

Диалоговое окно Capture (Оцифровка) (рис. 2.19) предназначено для управ-
ления процессом оцифровки. Оно состоит из двух больших областей. В ле- 
вой части окна выводится кадр видеоизображения, передаваемого с внеш- 

него устройства, и под ним панель с кнопками управления процессом оциф-
ровки. На рис. 2.19 указатель мыши наведен на кнопку Record (Запись) на 
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панели управления, включающую запись оцифрованного видеосигнала в 

файл. 

В правой части диалогового окна Capture (Оцифровка) может отображаться, 
в зависимости от выбранной закладки, информация двух типов. 

� Logging (Формуляр) — страница с основными атрибутами, идентифици-
рующими файл, в который будет проведена оцифровка (см. рис. 2.19). 

� Settings (Установки) — страница с возможностью просмотра и изменения 
основных установок процесса оцифровки (рис. 2.20). 

 

Рис. 2.20. Закладка Settings диалогового окна Capture 

Âèäåîçàõâàò áåç àïïàðàòíîãî êîíòðîëÿ 

После того как вы увидели изображение кадра с внешнего устройства в диа-

логовом окне Capture (Оцифровка), можно приступать к оцифровке. Если 
ваше устройство оцифровки не поддерживает опцию аппаратного контроля 
(device control), то, чтобы записать видеосигнал с внешнего устройства в 

файл, проделайте следующие действия. 
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1. Включите воспроизведение на внешнем устройстве и добейтесь приемле-
мого качества получения сигнала на компьютере в диалоговом окне 
Capture (Оцифровка). 

2. За несколько секунд (как правило — 3—10 с), до начала фрагмента, кото-
рый вы желаете записать в файл, нажмите кнопку Record (Запись), нахо-
дящуюся в правом верхнем углу панели управления внешним устройством 
внизу диалогового окна Capture (Оцифровка) (см. рис. 2.19). 

 

Рис. 2.21. Ввод имени файла и комментариев после оцифровки  
в диалоговом окне Log Clip 

 

Рис. 2.22. Оцифрованные клипы появляются в окне Project 
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3. Наблюдайте за кадрами, которые оцифровываются устройством. 

4. По истечении 3—10 с после последнего кадра записываемого фрагмента 

(чтобы оставить запас для монтажа) нажмите клавишу <Esc>. 

5. В появившемся диалоговом окне Log Clip (Формуляр клипа) (рис. 2.21) 

введите имя файла и комментарии к клипу. 

6. Нажмите кнопку OK. 

После этого на вашем диске в месте, определенном настройками закладки 

Settings (Установки), появится оцифрованный файл, а окно Capture (Оциф-

ровка) будет готово к оцифровке следующего файла. В частности, модифи-

цированное имя прошлого файла будет использовано по умолчанию в ка- 

честве предложения имени очередного файла. Вдобавок к этому, оцифро- 

ванный клип будет автоматически добавлен в текущую папку проекта 

(рис. 2.22). 

Âèäåîçàõâàò ñ àïïàðàòíûì êîíòðîëåì 

Некоторые устройства оцифровки могут управляться не только с собственной 

панели (пульта) управления, но и с компьютера, к которому они подключены. 

Такие устройства (в частности, устройства цифрового видео стандарта 

IEEE 1394) позволяют автоматизировать процесс оцифровки в Premiere. Для 

того чтобы пользователь мог осуществлять управление внешним устройст-

вом, в диалоговом окне Capture (Оцифровка) присутствуют соответствую-

щие кнопки управления (рис. 2.23). 

 

Рис. 2.23. Панель управления аппаратным контролем  

в диалоговом окне Capture 

Если аппаратный контроль разрешен, то в диалоговом окне Capture (Оциф-

ровка) можно будет использовать панель управления внешним устройством, 

служащую для подачи на устройство некоторых команд. Панель состоит из 

нескольких частей, расположенных в нижней части диалогового окна 

(рис. 2.23), непосредственно под областью кадра. Перечислим кнопки, нахо-

дящиеся в верхнем ряду панели: 

� Next scene (Следующая сцена) — переход к следующей сцене оцифрован-

ного файла (разбиение на сцены осуществляется автоматически, исходя из 

принципа резкой смены действия); 
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� Set In point (Установить входной маркер) — пометка текущего кадра 
входным маркером для выделения рабочего фрагмента оцифрованного 
клипа; 

� Set Out point (Установить выходной маркер) — пометка текущего кадра 
выходным маркером; 

� Rewind (Назад) — быстрая перемотка назад; 

� Step back (Кадр назад) — кнопка, перематывающая на внешнем устройст-
ве пленку на один кадр назад; 

� Play (Проиграть) — кнопка запуска воспроизведения на внешнем устрой-
стве; 

� Step forward (Кадр вперед) — кнопка, перематывающая пленку на один 
кадр вперед; 

�  Fast Forward (Вперед) — быстрая перемотка вперед; 

� Pause (Пауза) — пауза при воспроизведении; 

� Stop (Стоп) — кнопка останова воспроизведения; 

� Record (Запись) — запуск процесса оцифровки. 

В нижнем ряду находятся следующие кнопки и регуляторы: 

� Previous scene (Предыдущая сцена) — переход к предыдущей сцене 
оцифрованного файла (разбиение на сцены осуществляется автоматиче-
ски); 

� Go To In point (Перейти к входному маркеру) — переход на начало рабо-
чего фрагмента; 

� Go To Out point (Перейти к выходному маркеру) — переход на конец ра-
бочего фрагмента; 

� Jog (Полоса протяжки) — элемент управления покадровой перемоткой 
видео на внешнем устройстве, похожий на полосу протяжки в окне 
Monitor (Монитор), управление которым сводится к перетаскиванию по-
лосы влево или вправо; 

� Shuttle (Регулятор скорости) — ползунковый регулятор, увеличивающий 
или уменьшающий скорость при воспроизведении на внешнем устройстве; 

� Slow Reverse (Медленно проиграть назад) — кнопка медленной перемот-
ки назад; 

� Slow Play (Медленно проиграть) — кнопка медленной перемотки вперед; 

� Scene detect (Определить сцены) — осуществить автоматическое разбие-
ние видео на сцены (этот процесс может занимать длительное время, т. к. 
для его проведения требуется осуществить анализ изображения каждого 
кадра). 
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Еще раз обратим внимание на то, что описанные кнопки, кроме кнопки Record 
(Запись) и кнопок, управляющих сценами, относятся к управлению внешним 
устройством. 

Описанными кнопками можно пользоваться подобно панели управления ви-
деомагнитофоном, что существенно упрощает процесс оцифровки. Если вы 

применяете аппаратный контроль, то вам не придется каждый раз отвлекать-
ся от компьютера для управления внешним устройством, чтобы установить 

на нем нужный кадр. Для осуществления видеозахвата с аппаратным контро-
лем выполните следующее. 

1. Соедините внешнее устройство (камеру или магнитофон) с портом 
IEEE 1394. 

2. Выставьте на внешнем устройстве режим воспроизведения (а не записи, 
т. е. Camera mode), если такой режим для него предусмотрен. 

3. Запустите Premiere и начните новый проект с предустановками DV или 
откройте существующий с такими же установками. 

4. Пользуясь кнопками на панелях окна Capture (Оцифровка), как на пульте 

обычного видеомагнитофона, осуществите запись видео в файл на компь-
ютере, подключенном к компьютеру, видеоленты. 

Таким образом, аппаратный контроль подразумевает запуск и останов вос-
произведения видео на внешнем устройстве при помощи компьютера. При 

этом текущий кадр вы будете наблюдать в левой части окна Capture (Оциф-
ровка). 

Если при передаче сигнала с внешнего устройства через порт IEEE 1394  
в Premiere возникают проблемы, попробуйте обратиться к настройкам 

Premiere — выберите в верхнем меню команду Edit>Preferences>Device 

Control (Правка>Настройки>Аппаратный контроль). Выделите во всплы-
вающем меню Device (Устройство) пункт DV Device Control (Аппаратный 

контроль DV). Затем нажмите кнопку Options (Опции) и проверьте, правиль-
но ли установлены параметры вашего устройства (модель видеокамеры или 

магнитофона и т. п.). 

Îïöèè âèäåîçàõâàòà 

Рассмотрим в заключение раздела опции оцифровки более подробно. Заклад-
ка Logging (Формуляр) содержит основные атрибуты файла, в который про-

изводится оцифровка. В группе Setup (Установка) посредством раскрываю-
щегося списка Capture (Оцифровка) дублируется опция оцифровки видео 
и/или звука, которую мы устанавливали при помощи меню окна. Поле Log 

Clips To (Записывать клипы для) указывает, в какой проект будут помещены 
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создаваемые при оцифровке клипы. Если проект включает вложенные папки, 

то можно выбрать одну из них для размещения в ней текущих оцифрованных 
клипов. 

В группе Clip Data (Данные о клипе) можно задать атрибуты клипа: 

� Clip Name (Название клипа); 

� Tape Name (Имя видеокассеты); 

� Description (Описание); 

� Scene (Сцена); 

� Shot / Take (Съемка); 

� Log Note (Комментарий к формуляру). 

 

Перечисленные атрибуты впоследствии будут доступны в списке клипов окна 
Project (Проект). 

Некоторые из перечисленных атрибутов могут быть считаны с внешнего уст-
ройства воспроизведения (если соответствующие записи были добавлены при 
съемке видео). Любое из полей можно отредактировать, щелкая на нем указа-
телем мыши и вводя желаемый текст. Впоследствии все перечисленные атри-
буты клипа будут доступны в соответствующих столбцах окна Project (Про-
ект). 

В группе Timecode (Тайм-код) задается рабочий фрагмент оцифрованного 
клипа (позицию входа, выхода и длительность), а элементы управления груп-
пы Capture (Оцифровка) используются при проведении оцифровки с приме-
нением аппаратного контроля. 

Вторая закладка — Settings (Установки) (см. рис. 2.20) — позволяет про-
смотреть и отредактировать основные установки Premiere, касающиеся про-
цедуры оцифровки. Большинство элементов управления, собранных на этой 
закладке, доступно и в других окнах программы Premiere. 

В группе Capture Settings (Установки оцифровки) (см. рис. 2.20), в зависи-
мости от того, какая конкретно аппаратура используется, отображается соот-
ветствующая информация об оцифровке (такая как размер кадра, частота 
кадров оцифровки и т. п.). Если требуется изменить эти установки, то нажми-
те в данной группе кнопку Edit (Изменить) — появится диалоговое окно 
Project Settings (Установки проекта), открытое на странице с установками 
оцифровки, где их можно будет отредактировать. 

Группа Capture Locations (Размещение оцифровки) (см. рис. 2.20) позволяет 
управлять размещением создаваемых видео- и аудиофайлов на жестком дис-
ке. Как правило, файлы, образующиеся при оцифровке, имеют большой раз-
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мер, поэтому пользователю стоит внимательно отнестись к выбору места их 
размещения (особенно если компьютер имеет не один, а несколько жестких 
дисков). В группе Device Control (Аппаратный контроль) (см. рис. 2.20) за-
даются опции управления внешним устройством с компьютера (если оно по-
зволяет это сделать). 

2.4. Óïðàâëåíèå ôàéëàìè ïðîåêòîâ 

Управление проектами в Premiere организовано так же, как и в обычном при-
ложении для ОС Windows. Проекты создаются, сохраняются в файлах, могут 

быть открыты и закрыты подобно документам Microsoft Word. Основное от-
личие касается невозможности одновременной работы над несколькими про-

ектами (в то время как в Microsoft Word можно редактировать несколько до-
кументов в многооконном режиме). Многозадачность в Premiere поддержива-
ется благодаря возможности одновременного редактирования нескольких 

различных фильмов в рамках одного проекта. 

2.4.1. Ñîçäàíèå íîâîãî ïðîåêòà 

Для того чтобы создать новый проект, выберите в верхнем меню команду 
File>New>Project (Файл>Создать>Проект). После этого вам потребуется оп-

ределить установки нового проекта, его название и расположение на диске 
(см. разд. 2.1), после чего можно будет приступать к его редактированию. 

2.4.2. Ñîõðàíåíèå ïðîåêòà 

Несколько команд меню File (Файл) позволяют осуществить опции сохране-

ния проекта (рис. 2.24): 

� File>Save (Файл>Сохранить) — сохраняет проект под текущим именем; 

� File>Save As (Файл>Сохранить как) — сохраняет проект под новым име-

нем; 

� File>Save A Copy (Файл>Сохранить копию) — сохраняет копию проекта 

под другим именем, но открытым оставляет проект под старым именем. 

Разработчики Premiere предусмотрели очень удобную возможность автома-
тического сохранения файлов через определенные промежутки времени ра-
боты. Проекты сохраняются во временные файлы, которые помещаются в 

папку My Documents во вложенной папке Adobe/Premiere Pro/2.0/AutoSave 
(путь к файлам может отличаться — если вы установили Premiere в другую 

папку). Если компьютер случайно "завис", выключилось напряжение и т. п., 
то в ней удастся найти автоматически сохраненную версию вашего проекта. 
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Рис. 2.24. Сохранение проекта 

2.4.3. Îòêðûòèå ïðîåêòà 

Сохраненный ранее проект можно открыть несколькими способами: 

� File>Open Project (Файл>Открыть проект) — открывает проект через 

стандартное диалоговое окно ОС Windows Open File (Открытие файла),  
в котором следует найти и выделить файл на диске компьютера (рис. 2.25). 

Обратите внимание, что можно открывать как файлы предыдущих версий 
Premiere с расширением ppj, так и с расширением prproj; 

� File>Open Recent Project (Файл>Открыть недавний проект) — открывает 
один из тех проектов, которые редактировались в последнее время. Имя 
нужного проекта следует выбрать из вложенного меню. 

При открытии проектов Premiere следует иметь в виду, что клипы, которые 

содержатся в проекте, — это фактически ссылки на медиафайлы вашего ком-
пьютера. Если в открываемом проекте ссылка на медиафайл указывает на не-
правильное место на диске (например, если файл был перемещен или уда-

лен), то вместо нормального открытия проекта появляется диалоговое окно 
Where is the File? (Где находится файл?) (рис. 2.26). 
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Рис. 2.25. Открытие файла с проектом 

 

Помните о том, что проекты Premiere — это не самодостаточные файлы, как, 
например, текстовые документы или графические файлы. Если вы переносите 
файл с проектом в другое место на вашем диске, по локальной сети или на дру-
гой компьютер, позаботьтесь о том, чтобы все файлы, импортированные в про-
ект в виде клипов, были также перенесены на новое место. При этом по воз-
можности сохраняйте иерархию хранения файлов (например, храните все ме-
диафайлы проекта в одной папке). 

Если вы столкнулись с подобной ситуацией, отчаиваться не стоит. Проанали-
зируйте, почему Premiere не может найти нужный файл, и выберите одно из 

трех решений: либо считать его безвозвратно утерянным и полностью уда-
лить изо всех мест в фильме, где вы его использовали, либо попытаться найти 

его в другом месте на диске, либо отложить процесс поиска "на потом", 
сконцентрировавшись на других задачах и оставляя упоминания о клипе 

в фильме в качестве "белых пятен". 

В диалоговом окне Where is the File? (Где находится файл?) вам предлагает-

ся выбрать одно из решений и нажать соответствующую кнопку: 
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� OK — заменяет отсутствующий файл выбранным вами; 

� Offline (Отключить) — помечает отсутствующий файл как отключенный 
(offline file), при этом все упоминания о клипах в фильме в окне Timeline 
(Монтаж) заменяются пустыми фрагментами до того момента, пока вы не 
определите нахождение отключенного файла; 

� Offline All (Отключить все) — помечает, без дополнительных запросов, 
все отсутствующие файлы признаками отключенных файлов; 

� Skip (Пропустить) — удаляет в проекте все ссылки на этот файл; 

� Skip All (Пропустить все) — удаляет без дополнительных запросов все 
ссылки на все отсутствующие файлы; 

� Skip Previews (Пропустить файлы предварительного просмотра) — позво-
ляет пропустить поиск файлов предварительного просмотра, которые яв-
ляются результатом компиляции проекта, а не исходными файлами. 

 

Если нажать кнопку Skip (Пропустить) или кнопку Skip All (Пропустить все), то 
работа с отсутствующими клипами будет невозможна. 

 

Рис. 2.26. Диалоговое окно Where is the File? появляется в том случае,  

если при открытии проекта не удается отыскать исходные медиафайлы 
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Отключенные клипы в окне Timeline (Монтаж) символически показываются 

клипами соответствующего цвета, а их изображение в окне Program (Про-

грамма) заменяется заставкой (рис. 2.27). Впоследствии можно заменить от-

ключенный файл прежним и, таким образом, вернуть всю программу дейст-

вий, назначенную ему в окне Timeline (Монтаж). 

 

Рис. 2.27. Отключенный файл в окнах Project, Program и Timeline 

2.4.4. Çàêðûòèå ïðîåêòà 

Для того чтобы завершить работу над текущим проектом, достаточно  

выбрать команду File>Close (Файл>Закрыть), которая переводит программу в 

состояние заставки-приглашения. С его помощью можно создать новый про-

ект или открыть из файла уже существующий. Для завершения работы  

в Premiere следует закрыть его основное окно или выбрать в верхнем меню 

команду File>Exit (Файл>Выход). 
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Ðåçþìå 

Суммируя полученные сведения о первых шагах работы в Premiere, отметим, 
что основными понятиями при работе с проектами являются: 

� исходные клипы (clip), или источники (source) — ссылки на анимацион-

ные (видео), звуковые (аудио) либо графические (статические изображе-
ния) файлы, для использования которых в проекте их необходимо прежде 
импортировать из файлов с диска вашего компьютера (см. разд. 2.3.1) 

или оцифровать с внешнего устройства (см. разд. 2.3.2); 

� фильм (sequence) или, по-другому, программа (program) — собственно 
продукт ваших действий по монтажу исходных клипов. Вы можете про-
сматривать фильм в окне Program (Программа), или экспортировать его 

во внешний медиафайл, что, чаще всего, является конечной целью вашей 
работы. Формат фильма, который влияет на процесс редактирования, за-

дается при помощи установок проекта (см. разд. 2.1), а формат экспорти-
руемого файла — при помощи установок экспорта. 

После того как клипы окажутся в специально предназначенном для них окне 
Project (Проект), их можно перенести в окно Timeline (Монтаж), вставляя 

тем самым в фильм. Действия пользователя по монтажу фильма могут вклю-
чать такие операции, как разрезание клипов, изменение их длительности 
(см. урок 3), назначение различных эффектов (см.  урок 5), добавление титров 

и т. д. (см.  урок 6). Все действия по импорту клипов и редактированию 
фильмов сохраняются в файлах проектов (см. разд. 2.4). Готовые фильмы 

просматриваются и экспортируются на жесткий диск в виде файла 
(см. урок 7). При наличии соответствующей аппаратуры фильм можно также 
вывести на внешнее цифровое видеоустройство. 
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Урок содержит самые важные сведения о применении Premiere для линейно-
го монтажа фильма из исходных клипов в окне Timeline (Монтаж). 

� Чего мы хотим: 

• изучить приемы работы с окном Project (Проект) и Timeline (Монтаж); 

• научиться способам компоновки фильма из клипов; 

• освоить базовые методы редактирования клипов в фильме в окне 
Timeline (Монтаж). 

� Нам потребуется: 

• несколько видеоклипов (со звуком). 

� Что полезно вспомнить: 

• как осуществляется импорт клипов в проекты (см. разд. 2.3); 

• основы интерфейса Premiere (см. урок 2). 

3.1. Êëèïû 

Вообще говоря, работу по монтажу фильма в Premiere можно условно раз-
бить на следующие этапы: 

1. Создание нового проекта, включая определение его основных установок 
(см. разд. 2.1). 

2. Подготовка исходных файлов и импорт их в проект (см. разд. 2.3). 

3. Монтаж фильма из клипов, импортированных в проект (см. этот урок). 

4. Возможно, добавление различных спецэффектов (см. урок 5). 

5. Добавление  титров при необходимости (см. урок 6). 
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6. Возможно, разметка фильма на разделы DVD-диска  (см. урок 7). 

7. Экспорт смонтированного фильма (см. урок 7). 

Перед тем, как перейти к вопросам компоновки фильма, приведем основные 
сведения о клипах. 

3.1.1. Êëàññèôèêàöèÿ êëèïîâ 

Как вы уже знаете, монтаж фильмов (sequence) в Premiere производится из 

отдельных аудио-, видео- и статических фрагментов, называемых клипами 
(clip). Если исходный видео- и аудиоматериал фильма уже хранится на диске 
компьютера в виде файлов, то их следует импортировать в проект. Помимо 

обычных медиаклипов, в Premiere предусмотрена возможность непосредст-
венного создания некоторых специальных клипов, таких как, например, цве-

товой фон или настроечная таблица. 

Первоначально клипы помещаются в окно Project (Проект) и затем их можно 

вставлять в фильм, перенося в окно Timeline (Монтаж) (рис. 3.1). 

Òèïû êëèïîâ 

Клипы делятся на несколько типов: 

� Video (Анимация); 

� Audio (Звук); 

� Movie (Анимация+звук); 

� Image (Статическое изображение); 

� Title (Титры); 

� Sequence (Фильм) — с некоторой натяжкой фильмы тоже можно считать 

клипами, с точки зрения возможности их вставки друг в друга; 

� специальные клипы (например, черный экран, настроечная таблица и т. п.). 

В окне Project (Проект) тип каждого клипа в зависимости от типа медиа ото-

бражается символически, пиктограммой в первом столбце (рис. 3.2). Каждо-

му мастер-клипу в зависимости от типа медиа ставится в соответствие опре-

деленный цвет, показываемый в столбце Label (Метка) окна Project (Про-

ект). Тот же самый цвет сохраняется и для всех экземпляров клипа в окне 

Timeline (Монтаж). 

В зависимости от типа клипа его можно располагать на видео- (видеоклипы и 

статические изображения) или аудиотреках (звуковые клипы). Клипы бывают 

связанными (linked), т. е. могут содержать как видеоизображение, так и звук. 

Такие клипы размещаются только одновременно на видео- и аудиотреках в  
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Рис. 3.1. Клип в окнах Project и Timeline 

окне Timeline (Монтаж). Причем связанные клипы всегда располагаются 

синхронно и редактируются как единое целое. 

Ìàñòåð-êëèïû è ýêçåìïëÿðû êëèïîâ 

Чтобы использовать клипы при монтаже, необходимо поместить (импор-
тировать) их в окно Project (Проект) (см. разд. 2.3). После завершения мон-

тажа фильма его следует экспортировать во внешний медиафайл, т. е. запи-
сать файл на диск компьютера. Фильм создается с установками, которые вы  
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Рис. 3.2. Клипы различных типов в окне Project 

определяете предварительно (например, частота кадров, качество сжатия 
и т. д.). При этом клипы могут иметь существенно другие установки (напри-
мер, размер кадра или качество звука). Поэтому в процессе экспорта Premiere 

совершает сложные математические операции по пересчету программы мон-
тажа над исходными клипами, составленной вами в процессе работы над про-

ектом и записанной в символическом виде в окне Timeline (Монтаж). Время 
экспорта может быть весьма продолжительным, поскольку приходится пере-
считывать каждый пиксел для каждого кадра фильма. Для вас эта работа ос-

тается как бы "за кадром". 

Появление клипа в окне Project (Проект) означает лишь, что между проектом 
и содержимым соответствующего медиафайла установлена связь, позволяю-
щая "скачивать" информацию из файла. Следует подчеркнуть, что по мере 

работы с клипами в Premiere с самими файлами на дисках компьютера ничего 
не происходит. Premiere лишь считывает из них информацию в проект, а за-

тем (в соответствии с действиями пользователя по монтажу фильма) обраба-
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тывает ее с тем, чтобы представить скомпилированное изображение кадра 

фильма в окне Program (Программа). 

 

Рис. 3.3. Для вставки клипа в фильм перетащите его  
из окна Project в окно Timeline 

Импорт клипа в проект вовсе не означает его немедленную вставку в фильм. 

Проекты, содержимое которых мы видим в окне Project (Проект), являются 

лишь библиотекой клипов и фильмов. Для того чтобы включить клип в 

фильм, следует выполнить дополнительное действие: перенести его из окна 

Project (Проект) в окно Timeline (Монтаж). Делается это при помощи про-

стого перетаскивания клипа указателем мыши (рис. 3.3). Результат вставки 

клипа в фильм показан на рис. 3.4. 
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Рис. 3.4. Результат вставки клипа в фильм 

С точки зрения вставки в фильм, клипы в Premiere обладают различным ста-

тусом: 

� мастер-клип; 

� экземпляр клипа. 

Клипы, находящиеся в окне Project (Проект), называются исходными или 

мастер-клипами (master clip). Клипы, уже вставленные в фильм и находя-

щиеся в окне Timeline (Монтаж), называются экземплярами клипа (clip 

instance). Помните, что каждый прямоугольник в окне Timeline (Монтаж) — 

это экземпляр соответствующего мастер-клипа. По сути, он является само-

стоятельным клипом, как бы одним из "кирпичиков", из которых вы собирае-

те фильм. Подобно тому, как мастер-клип является ссылкой на файл, экземп-

ляр клипа — это, в свою очередь, ссылка на мастер-клип. 
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Как исходные клипы, так и экземпляры клипов могут быть переименованы 

при помощи команды Clip>Rename (Клип>Переименовать). Удаление эк-
земпляра клипа, равно как и любые действия с ним, в фильме в окне Timeline 

(Монтаж) не оказывают никакого влияния на мастер-клип. А вот удаление 
мастер-клипа влечет за собой автоматическое удаление всех его экземпляров 
из окна Timeline (Монтаж). Помните о таких отношениях клипов, когда бу-

дете редактировать фильм. 

 

В информационных строках области предварительного просмотра окна Project 
(Проект) приводятся сведения о том, что используется в окне Timeline (Мон-
таж) — видео и/или звук этого клипа (рис. 3.5). 

 

Рис. 3.5. Информация об использовании клипа в фильмах  
приводится в области предварительного просмотра окна Project 

3.1.2. Êëèïû â îêíå Project 

Окно Project (Проект) — одно из основных окон Premiere, и оно всегда ак-
тивно при создании нового или открытии ранее сохраненного проекта. Окно 
Project (Проект) является одновременно и хранилищем исходных клипов, 

которые вы помещаете туда с жесткого диска вашего компьютера или внеш-
него устройства, подключенного к компьютеру, и поставщиком клипов для 

компоновки их в фильмы. Фактически окно Project (Проект) представляет 
собой библиотеку клипов и фильмов, и одной из его главных задач является 
обеспечение быстрого поиска нужного клипа или фильма. 

Под заголовком и закладкой окна Project (Проект) находится область пред-

варительного просмотра (preview area) (см. рис. 3.5). Она служит для про-
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смотра в миниатюре и прослушивания клипов, помещенных в окно Project 

(Проект), а также для отображения их основных свойств. С помощью этой 
области можно быстро ознакомиться с содержимым клипа и выбрать из окна 

Project (Проект) нужный клип для последующего его монтажа в фильм.  
В области предварительного просмотра всегда отображается кадр и свойства 
клипа, выделенного в окне Project (Проект). 

Слева в области предварительного просмотра находится миниатюра с кадром 

клипа. С помощью кнопки запуска/останова воспроизведения, расположен-
ной слева от нее, можно просматривать клип. Элементы управления воспро-
изведением области предварительного просмотра окна Project (Проект) по-

хожи на кнопки окна Monitor (Монитор) и имеют тот же смысл. 

Перечислим их: 

� Play/Stop (Проиграть/Остановить) — кнопка запуска и останова воспроиз-

ведения клипа в миниатюре; 

� полоса прокрутки — служит для покадрового просмотра клипа; 

� Set Poster Frame (Cделать фоновым кадром) — кнопка, которая устанав-

ливает текущий кадр в области предварительного просмотра в качестве 
так называемого фонового кадра (poster frame). 

 

Фоновый кадр является "визитной карточкой" клипа. В частности, пиктограмма с 
ним сопровождает клип в списке клипов в окне Project (Проект), если включить 
соответствующий режим командой меню окна Thumbnails>Off (Миниатю-
ры>Выкл.) (рис. 3.6). Размер миниатюр выбирается в том же подменю Thumb-
nails (Миниатюры). 

Правая часть области предварительного просмотра содержит информацию о 

свойствах выделенного клипа или фильма. Поменять свойства клипа при ра-
боте над ним в Premiere, в отличие от установок проекта или экспорта, вы 
уже не сможете. Эта информация полезна для сравнения установок клипов, 

которые вы собираетесь монтировать в окне Timeline (Монтаж). Рекоменду-
ется, чтобы установки исходных клипов, по возможности, совпадали друг 

с другом, а также с установками фильма. 

Основную часть окна Project (Проект) под областью предварительного про-

смотра занимает список клипов, импортированных в проект, и фильмов, ко-
торые в нем редактируются. Организация списка клипов и фильмов очень 

похожа на организацию папок с файлами в ОС Windows и может иметь один 
из двух видов, выбираемых пользователем. 

� List View (Список) — клипы представлены в виде таблицы (рис. 3.6). Пер-
вый столбец содержит пиктограммы (либо миниатюры), говорящие о типе 
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медиа (видео, аудио, статическое изображение или фильм). Второй стол-

бец состоит из имен клипов, третий — цветовые метки, присвоенные дан-
ному элементу согласно его типу медиа, далее идут столбцы с длитель- 

ностью, свойствами видео- и аудиосоставляющих клипов, комментариями 
и т. п. Количество и порядок следования столбцов могут быть настроены 
пользователем. 

� Icon View (Значок) — клипы представлены в виде миниатюр — фоновых 

кадров с именем и длительностью (рис. 3.7). 

 

Рис. 3.6. Включение показа миниатюр фоновых кадров клипов 

 

Рис. 3.7. Область клипов в виде значков 
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Переключить режимы представления списка можно при помощи меню окна 
(рис. 3.7) или пары кнопок, находящихся слева на панели инструментов окна 
Project (Проект) (рис. 3.8). 

Панель инструментов окна Project (Проект) примыкает к его нижней границе 
(рис. 3.8) и служит для быстрого ввода той или иной команды. 

 

Рис. 3.8. Панель инструментов окна Project 

Перечислим слева направо названия кнопок панели инструментов, а подроб-
но расскажем об их действии в следующих разделах: 

� List (Список) — переводит область клипов в вид списка; 

� Icon (Значок) — переводит область клипов в вид значков; 

� Automate to Sequence (Автоматически вставить в фильм) — вставляет 
последовательность выделенных клипов в фильм, т. е. переносит их в окно 
Timeline (Монтаж) один за другим; 

� Find (Поиск) — осуществляет поиск клипов или корзин в окне Project 
(Проект) по их названию или его части; 

� Bin (Корзина) — создает новую папку (корзину) для более удобной орга-
низации клипов и фильмов. Не путайте с привычной "корзиной для мусо-
ра" из ОС Windows; 

� New Item (Создать элемент) — создает новые фильмы и специальные 
клипы как в окне Project (Проект), так и в отдельном окне, например — 
титры или цветовой фон. Эта кнопка эквивалентна действию пункта меню 
File>New (Файл>Создать); 

� Clear (Удалить) — удаляет выделенные в окне Project (Проект) элемен-
ты — клипы, фильмы или корзины. 

 

Удаление клипа из окна Project (Проект) автоматически влечет за собой удале-
ние всех его экземпляров изо всех фильмов, в которые он был вставлен. Если 
клип используется в каком-либо фильме, то при попытке его удаления выво-
дится дополнительное диалоговое окно, в котором пользователю необходимо 
подтвердить намерение избавиться от данного клипа. 

3.1.3. Ïðîñìîòð êëèïîâ â îêíå Source 

Окно Project (Проект) мало приспособлено для просмотра исходных клипов. 
В списке можно видеть только их фоновые кадры, а миниатюра предвари-
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тельного просмотра слишком мала. Для того чтобы открыть исходные клипы 

и редактируемые фильмы, следует использовать окно Source (Источник). 

� двойной щелчок на имени исходного клипа открывает его в окне Source 
(Источник) (рис. 3.9); 

� двойной щелчок на имени фильма открывает его в окне Program (Про-
грамма), т. е. правом окне Monitor (Монитор) и, одновременно, в окне 
Timeline (Монтаж). 

Переключаться между различными клипами в левом окне Source (Источник) 
можно так же, как и между разными фильмами в правом окне Program (Про-
грамма) — при помощи соответствующей закладки. В любом случае двойной 
щелчок на клипе из окна Project (Проект) откроет его в окне Source (Источ-
ник). 

 

Рис. 3.9. Просмотр клипа в окне Source 

3.1.4. Ïðîñìîòð ñâîéñòâ êëèïà 

Чтобы посмотреть основные свойства клипа, вызовите контекстное меню 
щелчком правой кнопки мыши на этом клипе в любом из окон Project (Про-
ект), Timeline (Монтаж) или Source (Источник) и выберите в нем команду 
Properties (Свойства). После этого появится одноименное диалоговое окно,  
в котором приведены все основные установки данного клипа (рис. 3.10). 

Помимо основных установок, для видеоклипов приводится график скорости 
передачи данных, т. е. график числа килобайт информации в секунду, коди-
рующих видеоизображение. На графике скорость передачи данных отобра-
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жается в виде вертикальных столбцов потока данных в килобайтах в секунду, 
в зависимости от текущего времени клипа. Горизонтальная ось графика явля-
ется осью времени. Кроме того, красной горизонтальной линией показана 
средняя за весь клип скорость передачи данных. Если клип был оцифрован 
программой-кодеком с применением ключевых кадров рендеринга, то поток 
данных этих ключевых кадров прорисовывается красными столбцами, в от-
личие от синих столбцов потока промежуточных кадров. 

 

Рис. 3.10. Просмотр свойств клипа в окне Properties 

3.1.5. Ñïåöèàëüíûå êëèïû 

С помощью кнопки New Item (Создать элемент), находящейся на панели ин-
струментов окна Project (Проект), легко можно создавать специальные кли-
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пы — особые клипы Premiere, предназначенные для различных служебных 

целей. Они бывают полезны для повышения удобства монтажа или воплоще-
ния художественных замыслов пользователя. 

Для создания специального клипа выполните следующие действия. 

1. Нажмите кнопку New Item (Создать элемент). 

2. В появившемся меню выберите тип создаваемого специального клипа 

(рис. 3.11). Таким же образом можно создать новый фильм, выбирая во 
всплывающем меню пункт Sequence (Фильм). 

 

Рис. 3.11. Для создания специального клипа нажмите кнопку New Item  
на панели инструментов окна Project 

После этого некоторые специальные клипы сразу появятся в окне Project 
(Проект), некоторые потребуют определения своих параметров, а некоторые 
откроются в отдельном окне, например Titler (Дизайнер титров). 

Приведем краткий обзор специальных клипов. 

Îòêëþ÷åííûå ôàéëû * 

Некоторые медиафайлы, с которыми вы работали в проекте, могут отсутство-

вать на диске. Это может произойти по нескольким причинам, например: 

� файл был случайно или намеренно удален с диска; 

� проект был перенесен из одного места в другое; 

� файл пока не оцифрован. 

Если вы все же желаете использовать такой клип в проекте, то вы можете 
сделать его отключенным (offline) (рис. 3.12). Тогда с ним можно будет рабо-

тать при монтаже как с обычным клипом, но его содержимое будет недос-
тупно, и вам придется монтировать такой клип "с завязанными глазами". Ви-

деоряд отключенного файла символически представляется картинкой с тит-
рами "отключенный файл" на разных языках (см. рис. 2.27). 

В любой момент отключенный файл можно заменить реальным файлом с 

диска, воспользовавшись командой Link Media (Присоединить медиа) верх-
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него меню Project (Проект) или контекстного меню. После замены отклю-

ченного файла мастер-клип в окне Project (Проект) и все экземпляры клипа  

в окне Timeline (Монтаж) станут отражать содержимое указанного файла. 

Кроме того, разумеется, будет сохранено и редактирование, относящееся 

к каждому экземпляру клипа в фильме. 

 

Рис. 3.12. Клип отключенного файла в окне Project 

×åðíîå âèäåî è öâåòíîé ôîí * 

Для создания клипа с черным фоном нажмите кнопку New Item (Создать 

элемент) на панели инструментов окна Project (Проект) и выберите в подме-

ню пункт Black Video (Черное видео), а для создания цветного фона — пункт 

Color Matte (Цветовой фон). Черное видео сразу создается в виде соответст-

вующего клипа в окне Project (Проект). 

Для формирования цветного фона необходимо предварительно определить 

его цвет в диалоговом окне с палитрой цветов Color Picker (Цветовая палит-

ра), а затем определить имя клипа в диалоговом окне Choose Name (Выбрать 

название). 

Еще один тип специального клипа представляет собой прозрачный видео-

клип, который может использоваться  для назначения эффектов к пустому 

треку. Для создания прозрачного видео выберите в подменю New Item (Соз-

дать элемент) пункт Transparent Video (Прозрачное видео). 
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Íàñòðîå÷íàÿ òàáëèöà * 

Настроечная таблица создается командой Bars and Tone (Настроечная таб-

лица) подменю New Item (Создать элемент) (рис. 3.13). Этот клип обычно 

располагается в начале фильма и служит для настройки аппаратуры. Помимо 

таблицы в виде разноцветных полос клип содержит килогерцевый звуковой 

сигнал, являющийся связанным клипом. 

 

Рис. 3.13. Настроечная таблица 

 

Îòñ÷åò âðåìåíè * 

Иногда перед началом фильма требуется вставить клип с отсчетом времени 

(от какой-либо секунды до нуля). Разработчики Premiere предусмотрели та-

кую возможность и встроили для этого в программу специальный клип с от-

счетом времени (рис. 3.14). После выбора в подменю New Item (Создать эле-

мент) пункта Universal Counting Leader (Универсальный отсчет) появляется 

диалоговое окно, в котором можно переопределить основные цвета данного 

клипа и некоторые опции, например — подачу звукового сигнала на каждой 

секунде и т. п. 
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Рис. 3.14. Клип Universal Counting Leader 

3.2. Êîìïîíîâêà ôèëüìà 

Принцип монтажа в Premiere чрезвычайно прост. Фильм собирается в окне 

Timeline (Монтаж) из отдельных "кирпичиков", которые являются ничем 
иным, как экземплярами клипов. Самой важной информацией для каждого 

клипа в окне Timeline (Монтаж) являются положения начала и конца клипа 
(относительно мастер-клипа), иными словами, положение рабочего фраг-

мента клипа. 

3.2.1. Îêíî Timeline 

Перечислим сначала основные составляющие окна Timeline (Монтаж) 
(рис. 3.15): 

� стандартные элементы окна — заголовок, полосы прокрутки, кнопка вы-
зова меню окна; 

� непосредственно под заголовком окна находится одна или несколько, если 
вы редактируете одновременно несколько фильмов, закладок (tabs). Вся 

остальная область окна Timeline (Монтаж), которую вы видите под за-
кладками, относится к данному фильму; 

� под закладками находится шкала времени (timeline) — горизонтальная ли-
нейка с метками времени и ползунковым маркером линии редактирования, 

а слева от нее — поле с активной надписью номера кадра (тайм-кода). Не-
посредственно под временной шкалой находится зона выбора рабочей об-

ласти (work area), выделяющая рабочий фрагмент фильма. К верхней гра-
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нице шкалы времени примыкает узкая область индикатора полной дли-

тельности фильма, позволяющего быстро перейти к нужному участку 
фильма и поменять масштаб отображения времени; 

� почти все остальное пространство окна занимают дорожки, или треки 
(tracks) — горизонтальные прямоугольные области, служащие для разме-

щения клипов. Треки начинаются заголовком, расположенным слева (под 
тайм-кодом текущего кадра) и включающим ряд элементов управления 

видом трека. Видеотреки располагаются сверху, а аудиотреки — снизу. 
Под шкалой времени находится графическая область окна Timeline (Мон-
таж), представляющая схематическое расположение места треков в филь-

ме. На рис. 3.15 она ничего не содержит, поскольку фильм пока является 
пустым; 

� в левом нижнем углу (на одном уровне с горизонтальной полосой про-
крутки) находится область задания временного масштаба, состоящая из 

двух кнопок и индикатора выбора масштаба. 

 

Рис. 3.15. Строение окна Timeline 

С окном Timeline (Монтаж) тесно связан еще один элемент интерфейса 

Premiere — палитра Tools (Инструментарий). На рис. 3.15 палитра Tools (Ин-
струментарий) показана справа от окна Timeline (Монтаж). Действия по  

монтажу фильма, производимые пользователем в окне Timeline (Монтаж), 
напрямую зависят от того, какой из инструментов палитры выбран. В частно-
сти, инструмент Selection (Выбор) применяется для выделения и перемеще-

ния клипов в фильме, инструмент Razor (Лезвие) — для разрезания клипов 
и т. д. 
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Как уже говорилось, для того чтобы вставить клип из окна Project (Проект) в 

определенное место фильма, следует перенести его в окно Timeline (Мон-
таж). Редактирование фильма в Premiere предусматривает привязку располо-

жения клипов ко времени фильма (к номеру кадра). Для этих целей в правой 
части окна Timeline (Монтаж) находится временная шкала или линейка вре-
мени (time ruler), определяющая место каждого клипа в фильме. Поэтому при 

перетаскивании можно сразу расположить клип в нужном месте окна 
Timeline (Монтаж) относительно линейки времени. После того как кнопка 

мыши будет отпущена, клип возникнет в окне Timeline (Монтаж), а обнов-
ленное изображение текущего кадра появится в окне Program (Программа) 
(рис. 3.16). 

 

Рис. 3.16. Текущий кадр выделен в окнах Timeline и Program линией редактирования 

Таким образом, один из кадров фильма всегда является выделенным, что 
отображается при помощи линии редактирования (editing line) и индикатора 
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текущего кадра (current-time indicator), выполненного в виде ползункового 
регулятора (рис. 3.16). Линия редактирования является элементом интерфей-
са, характерным практически для всех видеоредакторов, которая представля-
ет собой вертикальную линию, пересекающую шкалу времени в окне 
Timeline (Монтаж) в определенном месте. Таким образом, из всего фильма в 
каждый момент времени выделяется один из кадров, имеющий особое значе-
ние (мы его будем называть текущим кадром). Тайм-код текущего кадра 
приводится в левой верхней части окна Timeline (Монтаж) (рис. 3.16) в виде 
активной надписи (выполненной с подчеркиванием). 

Выделение текущего кадра в Premiere имеет то же назначение, что и курсор, 
отмечающий определенное место в тексте при работе в текстовых редакторах 
(например, Microsoft Word или Notepad). Изображение текущего кадра де-
монстрируется в окне Program (Программа), а большинство операций по ре-
дактированию фильма применимо как раз к текущему кадру. 

Чтобы перейти к другому кадру при помощи окна Timeline (Монтаж), доста-
точно схватиться указателем мыши за ползунковый регулятор на шкале вре-
мени, или, иначе, индикатор текущего кадра, и перетащить его на желаемое 
место (рис. 3.17), после чего его изображение откроется в окне Program 
(Программа). 

 

Рис. 3.17. Чтобы перейти к нужному кадру фильма, перетащите  
по шкале времени окна Timeline ползунковый регулятор текущего кадра 

Важная возможность шкалы времени связана с тем, что пользователь может в 
любой момент изменять ее масштаб, выбирая наиболее удобное пространство 
для монтажа фильма, "приближая" или "отдаляя" (во времени) редактируе-
мую область. Например, для редактирования продолжительного фильма — 
масштаб следует выбрать более мелким, а для прецизионного редактирования 
с точностью до кадра — наиболее крупным. Для того чтобы выбрать масштаб 
временной шкалы, можно использовать один из нескольких следующих вари-
антов: 

� перетаскивание ползункового регулятора масштаба (Zoom Slider) влево 
или вправо для плавного уменьшения или увеличения соответственно 
(рис. 3.18); 

� нажатие кнопок Zoom Out (In time) (Уменьшить временной масштаб) или 
Zoom In (In time) (Увеличить временной масштаб), которые расположены 
по бокам регулятора масштаба; 
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Рис. 3.18. Для того чтобы изменить масштаб временной шкалы в окне Timeline, 
 следует использовать регулятор и кнопки выбора масштаба 

� использование индикатора полной длительности фильма, который схема-
тически показывает соотношение видимой области шкалы времени в окне 

Timeline (Монтаж) и полной длительности фильма (рис. 3.19); 

 

Рис. 3.19. Перетаскивание краев индикатора полной длительности фильма  
позволяет изменять масштаб шкалы времени 

� нажатие клавиш <+> или <-> позволяет приблизить или отдалить область 

окна Timeline (Монтаж) около линии редактирования, изменив масштаб 

на один пункт; 

� использование инструмента Zoom (Масштаб) также изменяет масштаб 

шкалы времени (см. разд. 4.2.4). 

3.2.2. Ðàñïîëîæåíèå êëèïîâ  
íà òðåêàõ îêíà Timeline 

Процесс монтажа фильмов в Premiere заключается в расположении исходных 

клипов вдоль временной шкалы и последующем их редактировании, включая 

подгонку, вырезание и применение разнообразных спецэффектов. Фактиче-

ски то, что мы видим в соответствующей закладке окна Timeline (Монтаж), 

является исчерпывающей записью редактируемого нами фильма и однознач-

но определяет вид каждого кадра. Сам кадр отображается в окне Program 

(Программа). 

Окно Timeline (Монтаж) включает в себя видео- и аудиотреки, или дорож- 

ки, на которых можно располагать клипы (видео и аудио соответственно)  

(см. рис. 3.15). Количество треков, присутствующих изначально в окне 

Timeline (Монтаж), можно впоследствии изменить. Заголовок каждого трека 

содержит несколько элементов управления, позволяющих контролировать 

его вид и отображение на треке различных регуляторов. Режимы переключа-

ются щелчком по соответствующей кнопке. 
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Ðàñïîëîæåíèå êëèïîâ äðóã çà äðóãîì 

Самый простой и надежный способ вставки клипа в фильм — это его пере-

таскивание в окно Timeline (Монтаж), т. к. вы сразу видите, в какое именно 

место фильма вы вставляете клип. Для переноса клипа из окна Project (Про-

ект) в окно Timeline (Монтаж) выберите клип в окне Project (Проект), схва-

титесь указателем мыши за пиктограмму клипа и перетащите клип в нужное 

место в окне Timeline (Монтаж), по-прежнему удерживая левую кнопку мы-

ши (рис. 3.20). После того как вы отпустите кнопку мыши, клип будет встав-

лен в окно Timeline (Монтаж) (рис. 3.21). 

 

 

Рис. 3.20. Перетаскивание клипа в окно Timeline из окна Project 

 

Рис. 3.21. Клип, вставленный в окно Timeline 
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 1 
 

Если вы переносите клип в середину фильма, то при его переносе в окно 
Timeline (Монтаж) он "накладывается" на клипы, находящиеся на треке, заме-

няя их, на протяжении своей длительности. Если вы хотите, чтобы вставка про-
изошла без влияния на другие клипы, т. е. со сдвигом оставшейся части филь-
ма вправо и, соответственно, с увеличением длительности фильма на величину 
длительности клипа, то при перетаскивании следует нажать и удерживать на 
клавиатуре клавишу <Ctrl>. 

 2 
 

Перетаскивать клип в окно Timeline (Монтаж) можно не только из окна Project 
(Проект), но и из окна Source (Источник), хватаясь указателем мыши за кадр 

клипа. Часто последний способ бывает более предпочтительным, т. к. вы види-
те, как выглядит рабочий фрагмент клипа. При перетаскивании клипа в фильм 
из окна Source (Источник) надо следить за текущей опцией вставки Take Audio 
(Взять аудио), Take Video (Взять видео) или Take Video and Audio (Взять ви-

део и аудио). 

 3 
 

При перетаскивании клипа в окно Timeline (Монтаж) иногда удобнее включить в 
нем режим Snap (Притягивать) (рис. 3.22), при котором края клипов в процессе 

перетаскивания автоматически притягиваются к различным границам в окне 
Timeline (Монтаж). 

 

Рис. 3.22. Кнопка Snap включает режим привязки  
к границам при редактировании фильма 

 

Перетащить в окно Timeline (Монтаж) можно сразу несколько клипов из ок-

на Project (Проект). Для выделения нескольких клипов, следующих подряд, 

их надо выделять, щелкая сначала на пиктограмме первого, а затем последне-

го клипа при нажатой клавише <Shift>. А если вам надо выделить несколько 

клипов, расположенных вразброс, то следует щелкать поочередно на пикто-

грамме каждого клипа, удерживая клавишу <Ctrl>. 

Результатом описанных действий будет компоновка фильма из клипов в окне 

Timeline (Монтаж) в желаемом порядке (рис. 3.23). 
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Рис. 3.23. Линейный монтаж фильма из клипов в окне Timeline 

Íàëîæåíèå êëèïîâ * 

Каждый видеотрек является отдельным слоем изображения. На видеотреки 
можно помещать анимационные клипы, статическую графику и некоторые 
специальные клипы (титры, цветовой фон и пр.). Самый нижний слой — пус-
той и является, как бы, подложкой черного цвета. Он находится под треком 
Video 1 и в окне Timeline (Монтаж) отсутствует. Однако о нем следует всегда 
помнить, поскольку, если ни на одном треке на некотором промежутке вре-
мени в окне Timeline (Монтаж) клипов не окажется, изображением фильма 
будет черный кадр этой подложки. Кроме того, если для каких-либо клипов 
назначается режим прозрачности, черный цвет подложки может "просвечи-
вать" сквозь полупрозрачные клипы. 

Над подложкой находится трек Video 1, над ним — трек Video 2, еще вы-
ше — трек Video 3 и т. д. (если дополнительные треки были добавлены поль-
зователем). Содержимое этих треков наслаивается друг на друга. Таким обра-
зом, если, скажем, расположить на треке Video 3 какой-либо клип, то он пол-
ностью заслонит клипы, которые могут располагаться на треках Video 1 и 
Video 2 (рис. 3.24). Так будет происходить только в том случае, если клипу с 
верхнего трека не назначить определенного режима прозрачности. Собствен-
но, для настройки наложений клипов друг на друга с назначением опреде-
ленного эффекта прозрачности и предусмотрено такое большое количество 
видеотреков. 

Итак, если на каком-либо треке нет клипов, то это означает, что трек является 
совершенно прозрачным и в формировании изображения кадра фильма не 
участвует. Если же на видеотреке в некоторой его части имеется клип, то на 
всем своем протяжении он заслоняет клипы с нижних треков, если только для 
него не назначен определенный режим прозрачности. 

Принцип взаимодействия аудиотреков в корне отличается от видеотреков, 
поскольку аудиоклипы, расположенные на этих треках друг под другом, вос-
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производятся одновременно, т. е. звук со всех аудиотреков, равномерно сме-
шиваясь, дает результирующий звук фильма. Конечно, можно управлять 
громкостью отдельных клипов и треков, что позволяет создавать различные 
эффекты микширования звука. 

 

Рис. 3.24. Наложение видеоклипов 

Î êîìïîíîâêå àóäèîêëèïîâ 

Аудиоклипы, в зависимости от формата их содержимого, делятся на три  
типа: 

� моно (mono) — содержащие один звуковой канал; 

� стерео (stereo) — содержащие два звуковых канала (левый и правый); 
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� 5.1 — шестиканальный звук (пять обычных каналов, как правило, соответ-

ствующих двум фронтальным, двум тыловым и одному центральному ди-
намикам, а также низкочастотный канал — на сабвуфер). 

Перечисленным форматам клипов соответствуют такие же форматы аудио-

треков. Каждый трек в окне Timeline (Монтаж) имеет определенный тип, 
присваиваемый ему при создании, причем поменять тип трека (например, 

стерео на моно) нельзя. Тип трека обозначается в его заголовке в виде соот-
ветствующей пиктограммы. Например, на рис. 3.23 окно Timeline (Монтаж) 
содержит три стереотрека и один монотрек, а также служебный стереофони-

ческий мастер-трек. Соответственно, моноклипы допускается располагать на 
монотреках, а стереоклипы — на стереотреках. 

3.3. Ðåäàêòèðîâàíèå êëèïîâ â ôèëüìå 

Стиль, который вы выбираете для монтажа фильма в Premiere, может быть 

очень индивидуальным и зависеть от ваших собственных пристрастий. Одни 

и те же действия, как правило, можно выполнить несколькими альтернатив-

ными способами. Во-первых, можно использовать один из инструментов и 

визуально совершать над клипом нужные действия. Во-вторых, можно при-

менять команду верхнего или контекстного меню. В-третьих, можно нажать 

на клавиатуре комбинацию клавиш, соответствующую той или иной команде. 

В четвертых, можно осуществлять монтаж, пользуясь, главным образом, ок-

нами Source (Источник) и Program (Программа). 

Мы рассмотрим, в основном, первый из способов и покажем, как редактиру-

ются клипы в окне Timeline (Монтаж). При монтаже фильма в окне Timeline 

(Монтаж) используются инструменты (tools), которые выбираются с по- 

мощью панели инструментов Tools (Инструментарий) (рис. 3.25). В любой 

момент может быть выбран только один из инструментов, которым можно 

производить определенные действия с клипами. О выбранном в данный мо-

мент инструменте можно судить по включенной кнопке и по виду указателя 

мыши, который при наведении на какую-либо область окна Timeline (Мон-

таж) приобретает вид соответствующей пиктограммы. 

3.3.1. Âûäåëåíèå êëèïîâ 

Рассмотрим, каким образом выделяются один или несколько клипов. Выде-

ление необходимо для совершения над клипом определенных действий, в ча-

стности, для последующего перемещения по окну Timeline (Монтаж), удале-

ния и т. п. 
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Рис. 3.25. Вызов на экран палитры Tools и сама палитра 

Âûäåëåíèå îòäåëüíîãî êëèïà 

Клип выделяется щелчком на его внутренней части (т. е. не слишком близко 
к левому или правому краю) инструментом Selection (Выбор). Если вы хоти-
те выделить только одну из составляющих (видео или аудио) связанного кли-

па, то при щелчке инструментом Selection (Выбор) удерживайте на клавиату-
ре клавишу <Alt>. 

 

Рис. 3.26. Выделение клипа инструментом Selection 
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Âûäåëåíèå ïðîìåæóòêà ìåæäó êëèïàìè 

Инструментом Selection (Выбор) можно выделить не только клип, но и про-

межуток между клипами. Выделение пустого пространства между клипами 
может понадобиться, к примеру, для его последующего удаления из окна 

Timeline (Монтаж) со сдвигом оставшейся части фильма влево. 

Âûäåëåíèå ãðóïïû êëèïîâ 

Иногда требуется выделить не один, а несколько клипов для того, чтобы про-
вести одинаковые действия сразу со всеми клипами. Для выделения группы 

клипов используйте один из следующих приемов: 

� при удерживаемой клавише <Shift> щелчками на каждом клипе инстру-

ментом Selection (Выбор) выделите желаемую группу клипов; 

� при помощи техники протаскивания выделите инструментом Selection 

(Выбор) группу клипов, расположенных рядом друг с другом (выделение 
следует начинать вне клипов) (рис. 3.27); 

� при помощи инструмента Track Select (Выбор трека) выделите все клипы, 
расположенные правее места щелчка (для выделения только видео- или 

аудиочастей связанных клипов удерживайте при щелчке клавишу <Alt>). 

 

Рис. 3.27. Выделение группы клипов при помощи протаскивания инструмента Selection 

3.3.2. Ïåðåìåùåíèå êëèïîâ 

После того как вы вставили клип в окно Timeline (Монтаж), его можно пере-
нести с одного места на другое, на том же треке или на другой трек. Для пе-

ремещения применяется следующая техника перетаскивания — щелкните на 
кнопке инструмента Selection (Выбор), затем схватитесь, нажав левую кноп-
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ку мыши, за внутреннюю часть клипа и, удерживая кнопку мыши, перемес-

тите клип в нужное вам место. Для того чтобы переместить целую группу 
клипов на треке, следует выбрать инструмент Track Select (Выбор трека). 

 

При перемещении клипов по окну Timeline (Монтаж) можно использовать ре-
жим Snap (Притягивать), при котором края клипов в процессе перетаскивания 
автоматически притягиваются к линии редактирования, краям клипов и т. п. 

3.3.3. Ïîäãîíêà êðàåâ êëèïà 

Самое главное действие с клипами в Premiere — это их подгонка, т. е. выре-
зание из клипа того фрагмента, который будет вставлен в фильм. Изменяя 

рабочий фрагмент клипа, вы тем самым определяете и его длительность в 
фильме. В принципе, подгонку можно провести еще до вставки клипа в окно 

Timeline (Монтаж) в окне Source (Источник). Однако в окне Timeline (Мон-
таж) вам, вероятно, все равно придется проводить подгонку клипов для более 
точного определения их фрагментов для вставки в фильм. 

 

Помните, что клип в окне Timeline (Монтаж) может быть как урезан, так и уве-
личен за счет кадров клипа, находящихся за его пределами. 

Подгонка краев клипов производится входным (In) и выходным (Out) марке-

рами. In-маркер отмечает первый кадр клипа, который появится в фильме, а 
Out-маркер, соответственно, — последний кадр клипа в фильме. На шкале 

времени в окне Source (Источник) входной и выходной маркеры отмечены 
открывающейся и закрывающейся фигурными скобками, а в окне Timeline 
(Монтаж) им соответствуют левый и правый края клипа. 

Поскольку техника расстановки входных и выходных маркеров одинакова 

для разных компонентов Premiere (для этого, в частности, применяются 
кнопки с изображением фигурных скобок), кратко перечислим функции, вы-
полняемые ими в разных окнах: 

� в окне Source (Источник) маркеры выделяют начало и конец клипа. Это 

справедливо как для мастер-клипа, открытого из окна Project (Проект), 
так и для экземпляра клипа из окна Timeline (Монтаж) (более подробно об 
этом написано в разд. 4.1); 

� в окне Program (Программа) и на шкале времени, в окне Timeline (Мон-

таж) маркеры выделяют рабочую область фильма; 

� на полосе выбора рабочей области, в окне Timeline (Монтаж) маркеры 

(они имеют форму угловых скобок) определяют рабочий фрагмент фильма; 
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� на треках в окне Timeline (Монтаж) установка маркера меняет первый и 

последний кадры экземпляра клипа в фильме. 

Остановимся на последнем действии, определяющем фрагмент клипа, встав-
ляемый в фильм. 

Подогнать фрагмент можно несколькими альтернативными способами. Вы-

бирайте наиболее удобный для себя способ, который позволит подогнать 
клип максимально точно и быстро. 

Для подгонки краев клипа в окне Timeline (Монтаж) выполните следующие 

действия: 

1. Нажмите кнопку инструмента Selection (Выбор) на панели в окне Timeline 
(Монтаж). 

2. Выделите щелчком нужный клип в окне Timeline (Монтаж). 

3. Подведите указатель мыши к левому краю клипа. 

4. Как только указатель поменяет свой вид со стрелки на квадратную скобку, 

нажмите и удерживайте левую кнопку мыши (рис. 3.28). 

5. Подведите при нажатой кнопке мыши указатель к новому месту нача- 
ла клипа, ориентируясь на синхронные изменения тайм-кода в окне 

Program (Программа), и отпустите кнопку мыши. 

6. Повторите пп. 3—5 для определения выходного маркера (конца клипа) 
(рис. 3.29). 

 1 
 

Описанным выше способом можно как уменьшить, так и увеличить длитель-
ность фрагмента клипа. Чтобы увеличить длительность клипа, во-первых, ис-
ходный клип должен иметь кадры за пределами маркеров, и, во-вторых, на тре-
ке должно быть свободное место сбоку от клипа (чтобы его создать, можно, 
к примеру, использовать инструмент Track Select (Выбор треков)). 

 2 
 

Максимально растягивать длительность анимационных или звуковых клипов 
можно лишь до оригинальной длительности их мастер-клипов из окна Project 
(Проект), а длительность статических изображений допускается менять произ-
вольно, выбирая для них сколь угодно большую длительность. 

 

Если клип очень мал и указатель мыши в его пределах не принимает форму 
стрелки, то воспользуйтесь изменением масштаба шкалы времени окна 
Timeline (Монтаж). 
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Рис. 3.28. Подгонка левого края клипа 



Ìîíòàæ ôèëüìà èç êëèïîâ 95 

 

Рис. 3.29. Подгонка правого края клипа 
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Для точного перемещения входного маркера на определенный кадр экземп-
ляра клипа выполните следующие действия: 

1. Включите режим Snap (Притягивать) в окне Timeline (Монтаж). 

2. Инструментом Selection (Выбор) выделите клип в окне Timeline (Мон-
таж). 

3. Щелчком в нужном месте шкалы времени переместите линию редактиро-
вания на тот кадр клипа в окне Timeline (Монтаж), который вы желаете 
сделать первым. 

4. Подведите указатель мыши к левому краю клипа и, как только он поменя-
ет свой вид со стрелки на квадратную скобку, нажмите и удерживайте ле-
вую кнопку мыши. 

5. Подведите указатель к линии редактирования. 

6. Отпустите кнопку мыши в тот момент, когда указатель будет установлен 
на линию. 

В результате входной маркер окажется передвинутым в нужное место. Таким 
же образом вы можете переместить и выходной маркер, определив тем са-
мым желаемый фрагмент клипа, который войдет в фильм. 

3.3.4. Óäàëåíèå êëèïà 

Удалить клип из фильма можно несколькими способами, описанными далее. 

Óäàëåíèå êëèïà áåç ñäâèãà 

Для удаления клипа без сдвига следует выделить этот клип (рис. 3.30) и на-
жать клавишу <Delete> или <Backspace>. Кроме того, можно воспользоваться 
командой Clear (Удалить) из верхнего меню Edit (Правка) или контекстного 
меню. В результате простого удаления клипа на его месте остается пустой 
промежуток (рис. 3.31). 

 

Рис. 3.30. Перед удалением клипа выделите его 
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Рис. 3.31. Результат удаления клипа без сдвига 

Также можно удалить несколько клипов. Для этого следует предварительно 
выделить группу клипов, например, щелчками на каждом из них инструмен-
том Selection (Выбор) при нажатой клавише <Ctrl>, а затем нажать клавишу 
<Delete>. 

Óäàëåíèå êëèïà ñî ñäâèãîì 

Часто требуется удалить клип из фильма, чтобы на его месте не осталось пус-
того пространства. Для этого применяется удаление клипа со сдвигом всей 
оставшейся справа от него части фильма влево. Таким образом, пустое место, 
остающееся от удаленного клипа, сразу заполняется. Для удаления клипа со 
сдвигом: 

1. Выделите клип в окне Timeline (Монтаж). 

2. Выберите в верхнем меню Timeline (Монтаж) или в контекстном меню 
команду Ripple Delete (Удалить со сдвигом) (рис. 3.32). 

 

Рис. 3.32. Удаление клипа со сдвигом 
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Рис. 3.33. Результат удаления клипа со сдвигом 

Результат удаления клипа со сдвигом показан на рис. 3.33. 

Óäàëåíèå ïðîìåæóòêà ìåæäó êëèïàìè 

Точно так же удалить со сдвигом можно и пустой промежуток на треке меж-
ду клипами. Для этого достаточно выделить пустой промежуток щелчком на 

нем инструментом Selection (Выбор), вызвать контекстное меню и выбрать в 
нем команду  Ripple Delete (Удалить со сдвигом) (рис. 3.34). 

 

Рис. 3.34. Удаление пустого промежутка между клипами 

Óäàëåíèå âñåõ ýêçåìïëÿðîâ ìàñòåð-êëèïà 

Иногда требуется удалить все экземпляры некоторого клипа, присутствую-
щие в окне монтажа. Для этого достаточно просто удалить соответствующий 

мастер-клип из окна Project (Проект). При этом все его экземпляры в окне 
Timeline (Монтаж) будут удалены автоматически. Удаление будет произве-
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дено без сдвига, т. е. на месте удаленных клипов в окне Timeline (Монтаж) 

появятся пустоты. 

3.3.5. Ðàçðåçàíèå êëèïà 

Разрезание клипов часто используется для удаления некоторой внутренней 

части клипа (например, содержащей дефект изображения или звука). 

Чтобы разрезать клип на каком-либо треке: 

1. Выберите инструмент Razor (Лезвие). 

2. Щелкните этим инструментом в том месте клипа, в котором вы желаете 

произвести разрез (рис. 3.35). 

 

Рис. 3.35. Разрезание клипа 

В результате в месте применения инструмента Razor (Лезвие) появится раз-
рез, т. е. клип будет разделен на два клипа (рис. 3.36). Началом второго — 

нового — клипа будет тот кадр, на котором был произведен разрез, а концом 
первого из клипов станет, соответственно, предыдущий кадр. После того как 

вы разрезали клип на две части, можно изменить длительность каждого из 
этих клипов, например, устранив фрагмент, который вы хотели бы исключить 
из фильма. 

 

Помните о том, что каждый разрез клипа делит его на два независимых клипа. 
Впоследствии вы не сможете их "склеить", если только не отмените свое дейст-
вие при помощи соответствующей команды верхнего меню Edit>Undo Razor 

(Правка>Отменить разрезание) или сочетанием клавиш <Ctrl>+<Z>. Каждый из 
клипов после разрезания представляет собой независимый экземпляр одного и 



Óðîê 3 100 

того же мастер-клипа из окна Project (Проект). Однако допускается изменять 

рабочие фрагменты, входящие в фильм. В частности, оба клипа можно растя-
нуть до оригинальной длительности мастер-клипа. 

 

Рис. 3.36. Результат разрезания клипа 

Ïðåöèçèîííîå ðàçðåçàíèå êëèïà * 

Иногда очень важно точно произвести разрезание клипа (с точностью до кад-

ра). Для этого можно применить следующую последовательность действий: 

1. Выберите инструмент Razor (Лезвие). 

2. Включите режим Snap (Притягивать) окна Timeline (Монтаж). 

3. Установите линию редактирования на кадр клипа, на котором вы желаете 
произвести разрезание. Ориентируйтесь на вид кадра фильма в окне 

Program (Программа) и, при необходимости, нажимайте либо клавиши 

<←> и <→> для покадрового перемещения линии редактирования в окне 
Timeline (Монтаж) назад и вперед, либо кнопки Step Back (Кадр назад) и 

Step Forward (Кадр вперед) на панели управления воспроизведением окна 
Program (Программа). 

4. Щелкните инструментом Razor (Лезвие) вблизи линии редактирования. 

В результате разрезание будет произведено в точности на текущем кадре, 
благодаря включенному режиму Snap (Притягивать). 

 

Можно действовать иначе, используя вместо инструмента Razor (Лезвие) соот-
ветствующую команду Razor at Current Time Indicator (Разрезать на индикато-
ре текущего кадра) верхнего меню Sequence (Фильм). 
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Ðàçðåçàíèå êëèïîâ íà âñåõ òðåêàõ 

Разрезать можно не только отдельный клип на каком-либо треке, но и все 

клипы, находящиеся в точке разреза на всех треках (один над другим). Для 
этого следует использовать инструмент Razor (Лезвие) при удерживаемой 

клавише <Shift>. 

Óäàëåíèå âíóòðåííåãî ôðàãìåíòà êëèïà 

С помощью инструмента Razor (Лезвие) легко организовать удаление внут-
реннего фрагмента клипа, например, с дефектом изображения. Для этого: 

1. Произведите два разрезания клипа: одно в начале фрагмента, который хо-
тите удалить, а второе — в его конце. Таким образом, клип будет разрезан 

на три клипа, средний из которых и будет удаляемым фрагментом 
(рис. 3.37). 

 

Рис. 3.37. Разрезание клипа на три части и удаление среднего клипа 

2. Удалите средний клип командой контекстного меню Ripple Delete (Уда-
лить со сдвигом). 

 

Конечно, можно пойти и по другому пути, произведя только одно разрезание, а 
затем переопределив выходной маркер первого и/или входной маркер второго 
из клипов. Пустой промежуток между клипами можно убрать той же командой 
Ripple Delete (Удалить со сдвигом). 
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3.3.6. Êîïèðîâàíèå, âûðåçàíèå è âñòàâêà êëèïà 

Для редактирования клипов в окне Timeline (Монтаж) можно эффективно 

использовать возможности буфера обмена. Перечислим три основные коман-
ды из верхнего меню Edit (Правка), использующие буфер обмена. 

� Cut (Вырезать) — удаляет выделенный клип, помещая его при этом в бу-
фер обмена (соответствующая комбинация горячих клавиш <Ctrl>+<X>); 

� Copy (Копировать) — копирует выделенный клип в буфер обмена (ком-

бинация клавиш <Ctrl>+<C>); 

� Paste (Вставить) — вставляет скопированный или вырезанный ранее клип 

из буфера обмена в пустое место в окне Timeline (Монтаж) (комбинация 
клавиш <Ctrl>+<V>); 

3.3.7. Îñîáåííîñòè ìîíòàæà ñâÿçàííûõ êëèïîâ 

Клипы, включающие как видео-, так и звуковой ряд, называются связанными 

(linked). В окне Timeline (Монтаж) клип будет располагаться на двух треках: 
его изображение — на видеотреке, а звук — на аудиотреке. Связанные клипы 

всегда синхронизированы во времени и редактируются как единое целое. 
Действия пользователя над одной из частей связанного клипа влекут за собой 
точно такое же изменение второй его части (например, разрезание в некото-

ром месте, удаление и т. п.). Если вам нужно редактировать видео и звук свя-
занного клипа отдельно друг от друга, выделите его, а затем "развяжите" коман-

дой контекстного меню Unlink (Развязать) (рис. 3.38). Также допускается 
связывать любой видеоклип с любым аудиоклипом в общий связанный клип. 

 

Допускается связывание только видеоклипа с аудиоклипом, но никак не видео- 
или аудиоклипов между собой. 

Связанный клип не обязательно содержит видеоклип точно над аудиоклипом. 
Части связанного клипа могут быть смещены относительно друг друга во 

времени. Например, допускается связывать смещенные клипы, создавая, та-
ким образом, связанный клип, разнесенный во времени. Несмотря на смеще-

ние, связанные клипы всегда редактируются как единое целое. 

Смещенные клипы сопровождаются в окне Timeline (Монтаж) пиктограммой 

с указанием значения времени (в формате тайм-кода), на которое сдвинуты 
видео- и аудиочасти клипа относительно друг друга (рис. 3.39). Если из об-

ласти такой пиктограммы вызвать контекстное меню и выбрать в нем пункт 
Move Into Sync (Передвинуть для синхронизации), то смещение будет авто-
матически устранено, и связанные клипы выстроятся друг над другом. 
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Рис. 3.38. Развязывание связанного клипа 

 

Рис. 3.39. Смещенные связанные клипы 
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Äîïîëíèòåëüíûå ïðèåìû  
ìîíòàæà 

Рассмотрим на этом уроке некоторые дополнительные приемы монтажа 
фильмов в Premiere. Большинство из них просто дублируют возможности, 
рассмотренные на предыдущем уроке. Однако их использование зачастую 
позволяет сделать работу в Premiere более комфортной и быстрой. 

Если средств, описанных в других главах книги, для вас достаточно, то мож-
но пропустить изучение этого урока (на восприятие материала следующих 
уроков это не повлияет). Исключение составляют, пожалуй, довольно про-
стые сведения из разд. 4.2.5 и 4.2.6, с которыми мы советуем читателю по-
знакомиться. 

� Чего мы хотим: 

• получить представление о некоторых дополнительных методах монта-
жа в Premiere. 

� Нам потребуется: 

• несколько видеоклипов. 

� Что полезно вспомнить: 

• как осуществляется монтаж видео в окне Timeline (Монтаж) (см. 
урок 3). 

4.1. Ïîäãîíêà êëèïîâ â îêíå Source 

В прошлой главе мы изучили, как осуществляется подгонка (т. е. выделение 
рабочего фрагмента) клипов в фильме, в окне Timeline (Монтаж). Тем не ме-
нее, возможно, более удобной для вас будет подгонка не в окне Timeline 
(Монтаж), а в окне Source (Источник), тем более что ее допускается приме-
нять (одним и тем же способом) как к мастер-клипам из окна Project (Про-
ект), так и экземплярам клипов из окна Timeline (Монтаж). 
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Повторим, что подгонка краев клипов производится входным (In-marker) и 

выходным (Out-marker) маркерами. Входной маркер отмечает первый кадр 
клипа, который появится в фильме, а выходной маркер, соответственно, по-

следний кадр клипа в фильме. Чтобы выделить рабочий фрагмент клипа 
в окне Source (Источник): 

1. Откройте клип в окне Source (Источник), например двойным щелчком 
мыши на его пиктограмме в окне Project (Проект) (в случае мастер-

клипа), или в окне Timeline (Монтаж) (в случае уже вставленного в фильм 
экземпляра клипа). 

2. Просмотрите кадры клипа с помощью ползункового регулятора, полосы 
протяжки или кнопок управления воспроизведением и отыщите кадр, ко-

торый вы хотите сделать начальным кадром фрагмента. Сделайте этот 
кадр текущим, т. е. добейтесь, чтобы именно он отображался в окне 
Source (Источник). 

3. Нажмите кнопку Set In Point (Установить входной маркер) на панели ин-

струментов окна Source (Источник) (рис. 4.1). 

4. Таким же образом отыщите конечный кадр фрагмента и пометьте его вы-

ходным маркером, нажав кнопку Set Out Point (Установить выходной 
маркер) (рис. 4.2). 

На рис. 4.2 показан видеоклип с выделенным рабочим фрагментом. Выделе-
ние рабочего фрагмента показано более насыщенным цветом на шкале вре-

мени, а также входным и выходным маркерами, которые имеют вид, соответ-
ственно, открывающей и закрывающей фигурных скобок. 

  

Рис. 4.1. Выделение начала фрагмента клипа Рис. 4.2. Выделение конца фрагмента клипа 
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Изменять местоположение входного и выходного маркеров можно не только 

с помощью кнопок на панели инструментов внизу окна, но и перетаскивани-
ем этих маркеров по шкале времени вправо или влево. Для снятия выделения 

со всего рабочего фрагмента или только с его начала или конца вызовите из 
области шкалы времени окна Source (Источник), наведите указатель мыши 
на его пункт Clear Clip Marker (Удалить маркер клипа) и выберите в по- 

явившемся подменю тип маркера, который вы хотите удалить. 

Обратите внимание (см. рис. 4.1 и 4.2), что по мере установки входного и вы-

ходного маркеров длительность фрагмента клипа, отображаемая на правом 

табло, изменяется. Клип именно такой длительности и будет вставлен в 

фильм. 

 

При подгонке мастер-клипа из окна Project (Проект) помните о том, что именно 

рабочий фрагмент клипа вставляется в фильм при его перетаскивании в окно 
Timeline (Монтаж). 

4.2. Ìîíòàæ êëèïîâ â îêíå Timeline 

На предыдущем уроке были представлены наиболее простые приемы монта-

жа клипов в окне Timeline (Монтаж) при помощи ряда инструментов, выби-

раемых на панели Tools (Инструментарий). Рассмотрим теперь, как исполь-

зуются остальные инструменты, которые не были рассмотрены ранее. 

4.2.1. Ìîíòàæ ñòûêîâ êëèïîâ:  
Ripple Edit è Rolling Edit 

Для монтажа стыков клипов на панели Tools (Инструментарий) предусмот-

рены следующие инструменты: Ripple Edit (Сдвиг) и Rolling Edit (Совмеще-

ние). В принципе можно не использовать эти инструменты, а ограничиться 

управлением взаимным расположением и длительностью клипов при помощи 

комбинации инструмента Selection (Выбор) и команд удаления. Однако когда 

вы освоитесь с монтажом фильмов в Premiere, применение инструментов ре-

дактирования станет для вас более понятным и эффективным. 

При монтаже стыков клипов применяются две техники — монтаж с совме-

щением (рис. 4.3, а) и монтаж со сдвигом (рис. 4.3, б). 

Ìîíòàæ ñ ñîâìåùåíèåì 

Чтобы лучше разобраться в монтаже внутренних клипов, рассмотрим приме-

нение этих методик на примере специального клипа универсального отсчета  
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                              а                                                                                         б 

Рис. 4.3. Принципы монтажа 

 

Рис. 4.4. Клип с универсальным отсчетом времени в фильме 
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времени, который, как вы помните (см. разд. 3.1.5), представляет собой ви-

деоизображение, отсчитывающее цифры от 8 до 0 в обратном порядке. Пере-

несем этот клип в окно Timeline (Монтаж) и расположим справа от него ка-

кой-нибудь видеоклип (рис. 4.4). 

Монтаж с совмещением используется в том случае, когда вы хотите увели-

чить длительность одного из клипов за счет другого, состыкованного с ним 
клипа. В этом случае один клип накладывается на другой, полностью засло- 
 

 

 

Рис. 4.5. Монтаж стыка клипов с совмещением 
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няя его. Технически же смещение входного или выходного маркера одного из 
клипов происходит за счет соответствующего смещения выходного или 
входного маркера другого клипа. Для осуществления монтажа с совмещением: 

1. Выберите инструмент Rolling Edit (Совмещение). 

2. Наведите указатель мыши на стык клипов. В результате он примет вид 
выбранного инструмента Rolling Edit (Совмещение). 

3. Нажмите и удерживайте левую кнопку мыши. 

4. Перемещайте указатель влево или вправо, перетаскивая, таким образом, 
стык клипов, и ориентируйтесь на величину его смещения, которая ото-
бражается в окне Program (Программа) (рис. 4.5). 

5. При достижении желаемого состояния стыка клипов отпустите левую 
кнопку мыши, зафиксировав, таким образом, новые рабочие фрагменты 
клипов. 

 

Поскольку правки длительности клипов на стыке компенсируют друг друга, из-
менения общей длительности фильма не происходит (сравните рис. 4.6, 4.3). 

 

Рис. 4.6. Результат монтажа с совмещением 

Ìîíòàæ ñî ñäâèãîì 

Альтернатива монтажу с совмещением — это монтаж со сдвигом (см. 
рис. 4.3, б). Используйте его в том случае, когда хотите увеличить или 
уменьшить длительность одного из клипов на стыке за счет общей длитель-
ности фильма. В этом случае один клип накладывается на другой, полностью 
заслоняя его. Технически же смещение входного или выходного маркера од-
ного из клипов происходит за счет соответствующего смещения выходного 
или входного маркера другого клипа.  
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Для осуществления монтажа со сдвигом: 

1. Выберите инструмент Ripple Edit (Сдвиг). 

2. Наведите указатель мыши на стык клипов со стороны того клипа, дли-
тельность которого вы собираетесь изменять. В результате он примет вид 

выбранного инструмента Ripple Edit (Сдвиг). 

3. Нажмите левую кнопку мыши и, удерживая ее, перетаскивайте стык кли-

пов влево или вправо (рис. 4.7). 

 

Рис. 4.7. Монтаж стыка клипов со сдвигом 
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4. При достижении желаемого состояния стыка клипов отпустите кнопку 
мыши. 

 

При монтаже со сдвигом модифицируется рабочий фрагмент только одного из 
клипов. Другой клип при этом никак не изменяется, а длительность фильма 
увеличивается или уменьшается за счет соответствующего увеличения или 
уменьшения редактируемого клипа и сдвига оставшейся части фильма влево 
или вправо (рис. 4.8). 

 

Рис. 4.8. Результат монтажа со сдвигом 
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4.2.2. Ìîíòàæ ñ ïðîêðóòêîé: Slip è Slide 

Рассмотренные ранее два вида монтажа — с совмещением и сдвигом — из-

меняли положение стыка клипов. Другие два инструмента окна Timeline 

(Монтаж) позволяют редактировать внутренние клипы без изменения поло-

жения стыка, относительно шкалы времени в окне Timeline (Монтаж). Их 

применение заключается в прокрутке одного или обоих клипов, т. е. соответ-

ствующим изменением одновременно входного и выходного маркеров кли-

пов таким образом, чтобы общая длительность фильма оставалась посто- 

янной. 

Монтаж с прокруткой производится не для стыка клипов, а для внутренних 

клипов, окруженных с обеих сторон другими клипами. Поэтому применять 

инструменты монтажа с прокруткой следует не на стыке, а на самом внут-

реннем клипе. Имеются два инструмента монтажа с прокруткой: 

� Slip (Прокрутка) — инструмент для редактирования с прокруткой внут-

реннего клипа, при котором длительность редактируемого и соседних 

клипов или общая длительность фильма не меняются, а монтаж заключа-

ется в прокрутке кадров внутри клипа (рис. 4.9); 

 

Рис. 4.9. Монтаж с прокруткой инструментом Slip 

� Slide (Прокрутка с совмещением) — инструмент для редактирования без 

изменения рабочего фрагмента внутреннего клипа за счет взаимного на-

ложения на соседние клипы справа или слева и соответствующей про-

крутки этих соседних клипов (рис. 4.10). 
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Рис. 4.10. Прокрутка с совмещением при помощи инструмента Slide 

 

При монтаже со сдвигом, совмещением и прокруткой в окне Program (Про-
грамма) отображаются численные значения, на которые смещаются начальный 
и конечный кадры клипов. 

4.2.3. Ðåãóëèðîâêà ñêîðîñòè êëèïà: Rate Stratch 

При переносе клипов в окно Timeline (Монтаж) скорость их воспроизведения 
устанавливается равной скорости исходного мастер-клипа из окна Project 
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(Проект). Однако может понадобиться вставить клип в фильм в ускоренном 

или в замедленном действии. В любом случае новая скорость клипа отсчиты-
вается от скорости исходного мастер-клипа. Скорость в 100% означает ори-

гинальную скорость, 50% — замедление скорости в 2 раза, 200% — увеличе-
ние скорости в 2 раза и т. д. Для редактирования скорости предусмотрено две 
возможности. 

При визуальном изменении скорости клипа вы имеете возможность растя-

нуть или сжать клип непосредственно в окне Timeline (Монтаж). При этом 
вам потребуется соответствующий инструмент Rate Stratch (Растяже-
ние/Сжатие), служащий для масштабирования клипа. Изменение длительно-

сти клипа производится не за счет передвижения маркеров, а за счет измене-
ния скорости клипа. 

1. Выберите инструмент Rate Stratch (Растяжение/Сжатие) на панели Tools 

(Инструментарий). 

2. Наведите указатель мыши на один из краев клипа, нажмите и удерживайте 

левую кнопку мыши. 

3. Растяните или сожмите клип с помощью перетаскивания края клипа влево 

или вправо (рис. 4.11). 

4. Отпустите кнопку мыши. 

 

Рис. 4.11. Редактирование скорости клипа 

Результат масштабирования клипа показан на рис. 4.12. Если присмотреться 
к миниатюрам кадров с цифрами отсчета времени на рис. 4.11 и 4.12 в окне 

Timeline (Монтаж), то можно понять, что после масштабирования клип будет 
входить в фильм в замедленном варианте. 
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Рис. 4.12. Результат изменения скорости клипа 

 

Если вы уменьшаете скорость клипа, то улучшить качество замедленного вос-
произведения может опция плавного сопряжения кадров (frame blending), кото-
рая доступна путем выбора в меню Clip (Клип) или контекстном меню команды 
Video Options>Frame Blend (Опции видео>Плавное сопряжение кадров). 

Заметим, что существует возможность непосредственного задания новой от-
носительной скорости выделенного клипа. Для этого следует воспользоваться 

командой  Clip>Speed/Duration (Клип>Скорость/Длительность) и ввести в 
появившемся диалоговом окне Clip Speed/Duration (Скорость/Длительность) 
либо относительное значение новой скорости клипа, либо новую длитель-

ность клипа (рис. 4.13). В последнем случае, чтобы скорость клипа была ав-
томатически масштабирована, следует установить признак синхронизации 

скорости и длительности (пиктограмма в правой части рис. 4.13). 

 

Рис. 4.13. Ввод значения новой скорости клипа в диалоговом окне Clip Speed/Duration 
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4.2.4. Íàñòðîéêà îêíà Timeline: Zoom è Hand 

Инструменты Zoom (Масштаб) и Hand (Рука)  служат для быстрого перехода 

к нужной области фильма в желаемом масштабе. Инструмент Hand (Рука) 
служит для визуального перемещения по рабочей области окна Timeline 

(Монтаж). При выбранном инструменте Hand (Рука) указатель мыши имеет 
форму руки, и им можно перетаскивать содержимое окна Timeline (Монтаж), 

отображаемое в видимой области, влево или вправо. 

Быстро приблизить или отдалить участок фильма в окне Timeline (Монтаж), 

но не обязательно в районе линии редактирования, можно при помощи инст-
румента Zoom (Масштаб). Для этого: 

1. Выберите инструмент Zoom (Масштаб) на панели инструментов окна 
Timeline (Монтаж) (рис. 4.14). 

2. Перенесите указатель мыши в область окна Timeline (Монтаж), которую 
вы желаете приблизить или отдалить. При этом указатель мыши будет 

иметь вид лупы с символом "плюс" (+) внутри. 

3. Если вы хотите отдалить область (т. е. уменьшить масштаб), нажмите и 
удерживайте клавишу <Alt> — указатель мыши приобретет вид лупы с 
символом  "минус" (–) внутри. 

4. Щелкните на нужной области или выделите область, пользуясь техникой 
протаскивания указателя мыши (см. рис. 4.14). 

 

Рис. 4.14. Изменения масштаба при помощи инструмента Zoom 
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4.2.5. Ñòîï-êàäðû 

Иногда требуется остановить действие фильма на некотором кадре. Этот кадр 
называется стоп-кадром. Чтобы создать стоп-кадр, необходимо сделать сле-
дующее: 

1. Выберите клип, действие которого вы хотите полностью остановить. 

2. Выберите в верхнем меню или контекстном меню команду Clip>Video 
Options>Frame Hold (Клип>Опции видео>Остановка кадра). 

3. В открывшемся диалоговом окне Frame Hold Options (Опции стоп-кадра) 
установите флажок проверки Hold On (Остановить на) (рис. 4.15). 

4. Выберите в соседнем раскрывающемся списке желаемый кадр клипа, ко-
торый вы хотите сделать стоп-кадром: 

• In Point (Начало клипа); 

• Out Point (Конец клипа); 

• Marker 0 (Маркер 0); 

5. Нажмите кнопку OK. 

Результатом остановки клипа является замена его в фильме демонстрацией 
одного из его кадров на всей длительности клипа (рис. 4.15). 

 

Рис. 4.15. Настройка стоп-кадра 

4.2.6. Ìàðêèðîâêà ôèëüìà 

В целях повышения удобства редактирования в Premiere предусмотрены спе-
циальные средства, называемые маркерами (markers). Маркеры могут отме-
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чать определенные кадры клипов или фильмов и бывают нумерованными и 

ненумерованными. Ненумерованный маркер ставится на текущий кадр филь-
ма нажатием кнопки Set Unnumbered marker (Num *) (Установить ненуме-

рованный маркер) в окне Timeline (Монтаж) (рис. 4.16). 

 

Рис. 4.16. Нажмите кнопку Set Unnumbered marker (Num *)  
для маркировки текущего кадра фильма 

Результат установки маркера показан на рис. 4.17. Вы видите, что маркер от-
мечает определенный кадр на шкале времени в окне Timeline (Монтаж). Тот 

же рисунок демонстрирует использование альтернативного способа марки-
ровки, через контекстное меню.  Его же следует применять, чтобы осуществ-
лять переходы по маркерам, а также для удаления маркеров (рис. 4.17). 

 

Рис. 4.17. Установка маркера при помощи контекстного меню 

 

Устанавливать маркеры (как нумерованные, так и ненумерованные) можно не 
только на кадры фильма, но и на кадры отдельных клипов. Разметка клипов 
маркерами осуществляется в окне Source (Источник), а фильмов — в окнах 
Program (Программа) и Timeline (Монтаж). Во всех случаях управление марке-

рами удобно осуществлять при помощи контекстного меню, вызываемого из 
области шкалы времени того или иного окна. 
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4.3. Ìîíèòîð â ðåæèìå òðèììèíãà 

Режим тримминга окна Monitor (Монитор) служит для редактирования гра-
ницы соседних клипов на рабочем треке. Тримминг позволяет осуществлять 
визуальный контроль над действиями по монтажу сразу двух клипов, состы-
кованных друг с другом. 

В режиме тримминга можно изменять длительность обоих клипов за счет 
смещения их входных и выходных маркеров. При этом пустоты, которые мо-
гут возникать между клипами, Premiere убирает автоматически, в зависимо-
сти от выбранного вами стиля редактирования. 

 

 Рис. 4.18. Монитор в режиме тримминга 
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Напомним (см. разд. 4.2.1), что существуют два условных стиля монтажа: 

� Ripple Edit (Монтаж со сдвигом) — изменение длительности клипов осу-
ществляется за счет соответствующего изменения длительности всего 
фильма (если вы растягиваете один клип, то весь фильм справа от него 
сдвигается на такое же число кадров вправо, а если сжимаете клип, то 
фильм сдвигается влево); 

� Rolling Edit (Монтаж с совмещением) — монтаж с сохранением общей 
длительности фильма, когда изменение длительности клипов происходит 
за счет такого же изменения длительности соседнего клипа. 

Для управления процессом тримминга используется режим Тrim (Режим 
тримминга), переход в который осуществляется путем выбора команды Тrim 
(Тримминг) в меню окна Program (Программа). В этом случае открывается 
новое окно Тrim (Тримминг), обе области которого представляют клипы в 
процессе редактирования. В левой области вы видите клип, находящийся 
слева от линии редактирования в окне Timeline (Монтаж), а в правой — клип 
справа от линии редактирования (рис. 4.18). 

4.3.1. Ìîíòàæ ñ ñîâìåùåíèåì 

Монтаж с совмещением (rolling edit) затрагивает края обоих клипов на стыке, 
но не влияет на остальную часть фильма. Таким образом, перемещается толь-
ко сам стык клипов влево или вправо, изменяя длительность двух клипов в  
 

 

 Рис. 4.19. Монтаж с совмещением в режиме тримминга 
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соответствующей пропорции. Для редактирования стыка клипов в режиме 
монтажа с совмещением: 

1. Перейдите с помощью кнопок Go To Previous Edit Point (Перейти к пре-
дыдущему стыку) или Go To Next Edit Point (Перейти к следующему 
стыку) к нужной границе клипов. 

2. Поместите указатель между кадрами клипов в окне Тrim (Тримминг). Он 
приобретет форму инструмента монтажа с совмещением. 

3. Для смещения стыка клипов влево или вправо перемещайте в нужную 
сторону указатель при удерживаемой левой кнопке мыши (рис. 4.19). При 
этом ориентируйтесь на текущие крайние кадры клипов, которые отобра-
жаются в окне Тrim (Тримминг). 

 

 Рис. 4.20. В результате монтажа клипов с совмещением граница клипов смещается  
вдоль шкалы времени с сохранением общей длительности фильма 
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В результате стык переместится влево или вправо за счет изменения длитель-

ности двух клипов, но без влияния на остальную часть фильма (рис. 4.20). 

4.3.2. Ìîíòàæ ñî ñäâèãîì â ðåæèìå òðèììèíãà 

Для того чтобы отредактировать стык клипов, используя монтаж со сдвигом: 

1. Откройте в окне Тrim (Тримминг) желаемую границу клипов, пользуясь 
кнопками Go To Previous Edit Point (Перейти к предыдущему стыку) или 

Go To Next Edit Point (Перейти к следующему стыку). 

2. Поместите указатель на один из кадров клипов в окне Тrim (Тримминг). 

Он приобретет форму инструмента подгонки (в виде квадратной скобки). 

3. Нажмите кнопку мыши и, не отпуская ее, переместите указатель влево или 

вправо для смещения соответствующего (входного или выходного) марке-
ра клипа влево или вправо (рис. 4.21). 

4. Отпустите кнопку мыши. 

 

Рис. 4.21. Монтаж со сдвигом в режиме тримминга 

В результате стык переместится влево или вправо за счет изменения длитель-
ности клипа, на кадре которого вы проводили изменения в режиме триммин-

га. Соответствующим образом изменится и длительность всего фильма за 
счет сдвига его части, расположенной справа от стыка (рис. 4.22). 
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 Рис. 4.22. В результате монтажа со сдвигом изменяется длительность только одного из клипов 
(с соответствующим изменением общей длительности фильма) 

Сдвинуть стык клипов за счет изменения длительности одного из клипов 
можно и на точное число кадров. Для этого: 

1. Сделайте активным один из двух клипов, образующих стык, щелкнув на 
нужной части окна Тrim (Тримминг). 

2. Нажмите кнопку –1 или +1, чтобы, соответственно, уменьшить или увели-

чить длительность выделенного клипа на один кадр. Изменение длитель-
ности будет обеспечено передвижением края клипа влево или вправо 
(в зависимости от того, левый или правый клип выделен). Например, для  
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Рис. 4.23. Сдвиг стыка на определенное число кадров 

 

Рис. 4.24. В окне Тrim можно осуществлять подгонку как левого,  
так и правого клипа привычным способом 
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удаления одного кадра из левого клипа, если активна левая часть окна 

Тrim (Тримминг), нажмите кнопку –1. 

Если вам требуется сместить край на большее число кадров, то нажмите одну 
из соответствующих кнопок рядом с кнопками –1 и +1. Если вы не меняли 
установок режима тримминга, то это кнопки –5 и +5 (рис. 4.23). 

Отметим также, что в окне Тrim (Тримминг), как и в обычных режимах окна 

Monitor (Монитор), т. е. Source (Источник) и Program (Программа), допус-
кается применять стандартные приемы редактирования фильма, такие как 
подгонка левого или правого клипа при помощи маркеров начала и конца ра-

бочего фрагмента, ввода тайм-кодов в соответствующие активные надписи 
и пр. (рис. 4.24). 

4.3.3. Âîñïðîèçâåäåíèå êëèïîâ  
â ðåæèìå òðèììèíãà 

Чтобы просмотреть, как будут выглядеть в фильме два клипа, стык между 

которыми вы редактируете в режиме тримминга, нажмите кнопку Play Edit 

(Проиграть) на панели инструментов окна Тrim (Тримминг) (рис. 4.25).  

В результате окно Тrim (Тримминг) переходит из режима отображения двух 
кадров клипов в режим показа фрагмента фильма, подразумевающий показ  
 

 

Рис. 4.25. Воспроизведение клипов в окне Тrim 
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одного кадра. Чтобы остановить воспроизведение, не дожидаясь конца второ-

го клипа, нажмите эту же кнопку, которая после нажатия приобретает вид 

Stop (Остановить). 

Для выхода из режима тримминга достаточно закрыть соответствующее окно 

Тrim (Тримминг) кнопкой управления окна. 

4.4. Ìîíèòîð â ðåæèìå ìóëüòèêàìåðû 

В новой версии Premiere Pro 2 предусмотрен новый режим работы окна 

Monitor (Монитор), который называется мультикамерой (multi-camera). Он 

позволяет организовать перенос видеосигнала в фильм с нескольких (до че-

тырех) источников и допускает их синхронный просмотр и быстрое переклю-

чение. Мультикамера — довольно сложный режим, однако мы все-таки 

включили его описание в книгу, чтобы познакомить читателя с новым сред-

ством редактирования Premiere Pro 2. 

Применение мультикамеры неоценимо, если вы имеете исходный материал, 

синхронно отснятый несколькими видеокамерами, например, спортивное со-

стязание с нескольких точек и т. п. В этом случае окно Monitor (Монитор) в 

режиме мультикамеры позволяет как бы реконструировать процесс съемки, 

отображая в составном окне Multi-Сamera (Мультикамера) одновременно и 

сам исходный видеоматериал со всех камер, и кадр фильма, который форми-

руется путем выбора одной из камер. 

4.4.1. Ïîäãîòîâêà êëèïîâ 

Перед тем, как начать монтаж фильма в режиме мультикамеры, необходимо 

выполнить ряд подготовительных действий, заключающихся, главным обра-

зом, в правильном расположении клипов в окне Timeline (Монтаж) и их син-

хронизации. Выполните сначала добавление клипов следующим образом. 

1. Создайте новый фильм, например, Sequence 02. 

2. Расположите клипы, которые будут ассоциированы с каждой из камер, на 

треки с 1 по 4. 

 

Следует использовать именно треки 1—4. Клипы, вставленные, к примеру, на  
5-й трек, будут недоступны для монтажа в окне Multi-Сamera (Мультикамера). 

3. При необходимости осуществите подгонку клипов таким образом, чтобы 

их начало или конец относились к одному и тому же моменту съемки. 
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После добавления клипов в фильм следует осуществить их синхронизацию. 

А именно, выполните следующее. 

1. Выделите все клипы, которые будут участвовать в режиме мультикамеры 

(рис. 4.26). 

 

Рис. 4.26. Разместите клипы на треках 1–4 и выделите их 

 

 Рис. 4.27. Выберите опцию синхронизации клипов 

2. Выберите рабочий трек, который будет главным при синхронизации кли-
пов (щелкнув для этого на заголовке нужного трека). 

3. Выберите в верхнем меню Clip>Synchronize (Клип>Синхронизовать). 

4. В диалоговом окне Synchronize Clips (Синхронизовать клипы) (рис. 4.27) 
выберите опцию синхронизации клипов: Clip Start (Начало клипа), Clip 
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End (Конец клипа), Timecode (Тайм-код) или Numbered Clip Marker 
(Нумерованный маркер клипа). 

5. Нажмите кнопку ОК. 

После этого клипы будут синхронизованы в соответствии с выбранной оп- 
цией На рис. 4.28 показан вариант синхронизации по входным маркерам  
клипов. 

 

Рис. 4.28. Результат синхронизации клипов 

4.4.2. Ìîíòàæ â ðåæèìå ìóëüòèêàìåðû 

После того как вы правильно расположили и синхронизовали клипы в филь-
ме в окне Timeline (Монтаж), следует перейти к режиму мультикамеры. Для 
этого: 

1. Создайте еще один новый фильм, например, Sequence 03. 

2. Вставьте фильм, содержащий клипы для мультикамерного монтажа (в на-
шем примере это фильм Sequence 02), во вновь созданный фильм 
Sequence 03 (рис. 4.29). Как вы помните, такой стиль монтажа, при кото-
ром одни фильмы вставляются в другие, называют вложенным редакти-
рованием (nested edit). 

3. Включите режим мультикамеры командой Clip>Multi-Camera>Enable 
(Клип> Мультикамера>Включить) (рис. 4.30). 

Обратите внимание, что при включенном режиме мультикамеры в фильм 

(начиная с линии редактирования) включается содержимое одной из "камер" 
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(т. е. клипов, которые ранее были размещены на треках 1—4 во вложенном 

фильме). Соответственно, кадр именно этого клипа (являющийся текущим 
кадром фильма) демонстрируется в окне Program (Программа). 

 

Рис. 4.29. Фильм 2 вставлен в Фильм 3 

Переключая камеры путем выбора соответствующего пункта подменю 
Clip>Multi-Camera (Клип> Мультикамера) (рис. 4.30), можно быстро пере-
ключать источник видео, т. е. клип с одного из треков 1—4 вложенного 
фильма Sequence 02. 

Еще проще переключение камер производит в окне Multi-Сamera (Мульти-
камера), которое вызывается путем выбора одноименного пункта в меню ок-
на Program (Программа). Окно Multi-Camera (Мультикамера) состоит из 
двух половин (рис. 4.31): в правой приводится кадр фильма, а в левой — кол-
лаж четырех клипов ("камер"), находящихся на треках 1—4 вложенного 
фильма. 

В том, что кадр в правой половине окна Multi-Сamera (Мультикамера) сов-
падает с текущим кадром фильма из окна Program (Программа), можно убе-
диться сопоставляя изображения на рис. 4.31, который показывает оба этих 
окна. 

Та из камер, которая является рабочей, т. е. изображение клипа которой фор-
мирует кадр фильма, показывается в левой половине окна Multi-Сamera 
(Мультикамера) в обрамлении желтой рамки. Для того чтобы сменить рабо-
чую камеру, достаточно просто щелкнуть на нужном изображении в левой 
половине окна Multi-Сamera (Мультикамера) (рис. 4.32). 
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Рис. 4.30. При включенном режиме мультикамеры  
в окне Program отображается кадр одного из четырех клипов 

Чтобы редактировать фильм в режиме реального времени, выбирая ту или 
иную камеру, следует сначала запустить его воспроизведение нажатием 

кнопки Play around (Воспроизведение) или Play around (Воспроизведение 
фрагмента), по мере демонстрации фильма в окне Multi-Сamera (Мультика-

мера) выбирать описанным способом рабочую камеру, изображение с кото-
рой и будет вставлено в фильм. В результате монтажа в режиме мультикаме-
ры, в окне Timeline (Монтаж) автоматически, из фрагментов соответствую-

щих клипов, будет скомпонован итоговый фильм (рис. 4.33). "Подправить" 
фильм впоследствии можно обычными способами, осуществляя подгонку 

клипов в окне Timeline (Монтаж). 
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Рис. 4.31. Окна Program и Multi-Сamera 

 

 

Рис. 4.32. Для смены рабочей камеры щелкните на нужном изображении кадра  
в окне Multi-Сamera 
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Если в меню окна Multi-Сamera (Мультикамера) включена опция Audio follows 
video (Аудио привязано к видео), то переключение в нем изображения той или 
иной камеры автоматически влечет за собой и соответствующее переключение 
звукового ряда. В противном случае в фильм будет включено содержимое ра-
бочего аудиотрека. 

 

Рис. 4.33. Окно Timeline включает фильм, сформированный в режиме Multi-Сamera 

 

Если в меню окна Multi-Сamera (Мультикамера) снять флажок Show Preview 
Monitor (Отображать кадр фильма), то в окне Multi-Сamera (Мультикамера) бу-
дет воспроизводиться только коллаж исходных клипов, а кадр фильма (правая 
половина окна) будет скрыт. В этом случае для того, чтобы иметь возможность 
записи переключения камер в режиме реального времени, следует нажать 
кнопку Record On / Off Toggle (Включение / Выключение записи). 
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Ñïåöýôôåêòû 

 

Рассмотрим на этом уроке одно из главных достоинств программы Pre-

miere — широкую гамму спецэффектов, позволяющих создать зрелищный и 

динамичный фильм. 

� Чего мы хотим: 

• научиться назначать эффекты клипам. 

� Нам потребуется: 

• любой видео- и аудиофайл. 

� Что полезно вспомнить: 

• как осуществляется монтаж фильма из клипов в окне Timeline (Мон-

таж) (см. урок 3). 

5.1. Ýôôåêòû 

Эффектами называются самые разнообразные спецэффекты, которые со-

вершают определенные действия, в соответствии с заложенным в них алго-

ритмом, с изображением или звуком. Подавляющее большинство этих алго-

ритмов основано на нелинейном преобразовании видео или звука. Поэтому 

редактирование с применением спецэффектов часто называют нелинейным 

монтажом. Эффекты, как и большинство действий в Premiere, применяются 

по отношению к клипу, причем каждому клипу в фильме может быть назна-

чено сразу несколько эффектов. 

Эффекты характерны тем, что для большинства из них позволено регулиро-

вать не один, а несколько параметров, которые управляют разными свойст-

вами эффекта. Это создает, вместе с многообразием эффектов, практически 
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неограниченные возможности для манипулирования изображением фильма в 

соответствии с замыслами пользователя. 

5.1.1. Òèïû ýôôåêòîâ 

По различным признакам эффекты в Premiere можно условно разделить на 
несколько классов. 

Во-первых, по характеру действия можно выделить следующие типы эф- 

фектов: 

� переходы между клипами; 

� эффекты прозрачности и наложения изображения видеоклипов друг на 

друга; 

� анимация и масштабирование изображения видеоклипов; 

� управление громкостью звучания аудиоклипов; 

� реализации самых разнообразных алгоритмов обработки видеоизображе-
ний и звука, объединенных понятием "эффект". 

Во-вторых, по способу назначения эффектов клипам они делятся на следую-
щие типы: 

� встроенные — по умолчанию назначенные любому клипу (к ним относят-
ся эффекты наложения и анимации, а также звуковой эффект громкости); 

� стандартные — добавляемые клипам вручную, которые, в свою очередь, 
включают два класса: 

• Video Effects (Видеоэффекты); 

• Audio Effects (Аудиоэффекты). 

В-третьих, в зависимости от поведения с течением времени, эффекты бы- 

вают: 

� статическими — одинаково действующими на все кадры клипа; 

� динамическими — меняющимися от кадра к кадру. 

Для настройки статических эффектов в Premiere предусмотрены два окна — 
Effects (Эффекты) (рис. 5.1) и Effect Controls (Управление эффектом) 

(см. рис. 5.2). Для добавления эффектам временной динамики используется 
технология ключевых кадров. Для вызова упомянутых окон на экран вос-

пользуйтесь одноименными командами меню Window (Окно). Кроме того, 
перестроить рабочую область Premiere, сделав ее оптимальной для работы со 
спецэффектами, можно при помощи команды Window>Workspace>Effect 

(Окно>Рабочая область>Эффекты). 
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Рис. 5.1. Для назначения эффектов клипам  
используется окно Effects 

Эффекты назначаются клипам при помощи окна Effects (Эффекты), а окно 

Effect Controls (Управление эффектом) служит для настройки эффектов 

(рис. 5.2). Пока не выделен ни один клип в окне Timeline (Монтаж), окно 

Effect Controls (Управление эффектом) пуста, а в противном случае она со-

держит исчерпывающую информацию о настройках всех эффектов, приме-

ненных к выделенному клипу. 

Эффекты в окне Effects (Эффекты) (рис. 5.1) разложены по папкам, для рас-

крытия содержимого которых следует щелкнуть на треугольной кнопке слева 

от имени папки. Сворачивание развернутой папки также производится щелч-

ком на треугольной кнопке. Отметим, что найти эффект по названию можно, 

начав ввод ключевого слова в поле Contains (Найти), в верхней части окна. 

По мере ввода слова в режиме реального времени будет осуществляться вы-

вод найденных эффектов, названия которых содержат введенный фрагмент. 
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Рис. 5.2. Для настройки спецэффектов применяется окно Effect Controls 

Необходимо отметить, что видеоэффекты применяются исключительно к 
клипам, а аудиоэффекты могут применяться как к клипам, так и к трекам 

(т. е. ко всем клипам на треке одновременно). Если требуется применить ка-
кой-либо эффект к определенной группе клипов, которые расположены на 

одном или нескольких треках, то следует применить технику вложенного ре-
дактирования (nested editing) — сначала определить группу клипов в качестве 
отдельного фильма, а затем вставить его в основной фильм и назначить для 

него эффект, как для обычного клипа. 

5.1.2. Âñòàâêà ýôôåêòà 

Начнем рассказ о применении эффектов в Premiere с простого примера. По-
пробуем при помощи соответствующего эффекта исправить яркость какого-

либо (изначально излишне темного) клипа, сделав его более светлым. Это 
одна из типичных задач редактирования видео, решаемая при помощи при-

менения соответствующего эффекта. 

Чтобы назначить определенный эффект клипу: 

1. Выделите клип в окне Timeline (Монтаж). 

2. Отыщите нужный эффект в списке эффектов в окне Effects (Эффекты).  
В нашем случае следует развернуть папку с эффектами Adjust (Ре-

гулировка) и отыскать в ней элемент Brightness & Contrast (Яркость и 
контраст), предназначенный для изменения яркости или контраста клипа. 



Ñïåöýôôåêòû 139 

 

Рис. 5.3. Перетащите на клип желаемый эффект из окна Effects 

3. Перетащите эффект из окна на клип в окно Timeline (Монтаж) (рис. 5.3).  
В результате он будет назначен клипу, о чем будет свидетельствовать па-

нель эффекта в появившемся окне Effect Controls (Управление эффектом) 
(рис. 5.4). 

 

Если вы назначаете аудиоэффект, то надо позаботиться о совпадении форма-
та клипа (моно, стерео или 5.1) и формата эффекта. Аудиоэффекты разложены 
в папки в окне Effects (Эффекты), согласно форматам звука, т. е. — Mono (Мо-
но), Stereo (Стерео) или 5.1. При назначении клипу звукового эффекта необхо-
димо выбирать эффект из папки, отвечающей формату трека. 

4. Щелкая мышью по треугольной кнопке на панели эффекта Brightness & 

Contrast (Яркость и контраст), в окне Effect Controls (Управление эффек-

том) разверните вложенные списки его параметров. 

5. При помощи ползунковых регуляторов отрегулируйте параметры эффекта 

(рис. 5.5) в окне Effect Controls (Управление эффектом), ориентируясь 
при этом на просмотр кадра фильма в окне Program (Программа). 
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Рис. 5.4. После назначения клипу эффекта соответствующая панель  
появляется в окне Effect Controls 

6. Если вы намерены назначить клипу какой-либо дополнительный эффект, 
повторите для этого эффекта действия пп. 1—4. 

 

Рис. 5.5. Настройка параметра эффектов при помощи ползункового регулятора 

 1 
 

Настраивать значения параметров эффекта можно несколькими способами: 
вводом числового значения в соответствующее поле, непосредственно в окне 
Timeline (Монтаж), а также (для некоторых эффектов) в окне Program (Про-
грамма), т. е. непосредственно на кадре фильма при помощи соответствующих 
маркеров. 

 2 
 

Если клипу назначено несколько эффектов, то их применение к изображению 
производится в том порядке, в котором эффекты располагаются в окне Effect 
Controls (Управление эффектом). В некоторых случаях порядок применения 
эффектов играет существенную роль в формировании изображения фильма. 
Изменить порядок следования эффектов в окне можно простым перетаскива-
нием. 
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После назначения клипу эффекта можно в любой момент изменить его на-
стройки (т. е. отредактировать) при помощи окна Effect Controls (Управле-
ние эффектом), а также удалить эффект или назначить клипу дополнительные 
эффекты. 

5.1.3. Âñòðîåííûå ýôôåêòû 

В любой момент окно Effect Controls (Управление эффектом) отображает 
информацию обо всех эффектах, назначенных выделенному в фильме клипу. 
Название клипа указывается в верхней части окна под его заголовком, а так-
же в графической области, в правой части окна. Для переключения между 
клипами в окне Effect Controls (Управление эффектом) достаточно выделить 
данный клип в окне Timeline (Монтаж). 

Пока клипу не назначено ни одного стандартного эффекта, он будет содер-
жать только встроенные эффекты, добавляемые по умолчанию при создании.  
 

 

Рис. 5.6. Любому видеоклипу или графическому изображению (статическому клипу) 
по умолчанию назначены встроенные эффекты (движения и прозрачности) 

 

Рис. 5.7. Встроенный эффект громкости для аудиоклипа 
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Для рисунков и видеоклипов встроенными являются эффекты движения, или 

анимации, и наложения, или прозрачности (рис. 5.6), а для аудиоклипов — 

эффект громкости (см. рис. 5.7). 

5.1.4. Ðåäàêòèðîâàíèå ýôôåêòîâ 

Как мы уже выяснили, основную часть окна занимает область со списком 

спецэффектов, назначенных клипу. Эффекты расположены в порядке их 

применения к клипу, что имеет значение при осуществлении расчетов для 

компиляции фильма или создания предварительного просмотра в окне 

Program (Программа). В ситуации, изображенной на рис. 5.8, текущему кли-

пу movie.avi назначены три различных эффекта (помимо двух встроенных), 

причем два последних эффекта развернуты. Вложенные списки среднего эф-

фекта свернуты, а последнего — максимально развернуты, с тем, чтобы мож-

но было менять параметр эффекта посредством регулятора. Как вы видите,  

в зависимости от текущей задачи редактирования примененные эффекты, по-

добно стандартным вложенным спискам, удобно сворачивать и развора- 

чивать. 

 

Рис. 5.8. Назначение клипу нескольких эффектов 

Треугольная кнопка, расположенная слева от имени эффекта, разворачивает 

или сворачивает эффект. Развернутый эффект позволяет регулировать его 

параметры непосредственно в окне Effect Controls (Управление эффектом). 

Свернутый эффект занимает в окне меньше места и дает возможность оки-
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нуть взглядом установки большего числа эффектов одновременно. На рис. 5.8 

вы видите несколько эффектов в разном состоянии. 

В пределах панели каждого эффекта в окне Effect Controls (Управление эф-

фектом) помещаются один или несколько вложенных списков, которые груп-

пируют текущие параметры данного эффекта. Их также можно сворачивать и 

разворачивать, руководствуясь соображениями удобства, в зависимости от 

того, какую работу вы проводите в данный момент. 

В ряде случаев последовательность применения спецэффектов имеет ключе-

вое значение. Чтобы изменить порядок следования эффектов в окне Effect 

Controls (Управление эффектом), следует просто перетащить нужный эффект 

на новое место, зацепив указателем мыши панель эффекта в окне. 

5.1.5. Âîçâðàò ïàðàìåòðîâ ïî óìîë÷àíèþ 

Все типы эффектов имеют на своей панели, справа от названия эффекта, 

кнопку Reset (Сброс), позволяющую восстановить значения параметров эф-

фекта по умолчанию (рис. 5.9). 

 

Рис. 5.9. Кнопка сброса параметров эффекта в значения по умолчанию 

5.1.6. Âðåìåííîå âûêëþ÷åíèå ýôôåêòà 

Слева от названия каждого эффекта находится кнопка Enable Effect (Вклю-

чить эффект). Если она нажата (что символизируется буквой f внутри кноп-

ки), то это значит, что эффект включен и применен к клипу. Если кнопка не 

нажата, то эффект временно выключен, однако в любой момент его можно 

применить к клипу. 

Чтобы временно выключить эффект, не удаляя его, достаточно нажать кноп-

ку Enable Effect (Включить эффект) слева от его названия. При наведении 

указателя на эту кнопку всплывает подсказка Toggle the effect on or off 

(Включить или выключить эффект) (рис. 5.10). После нажатия кнопки Enable 

Effect (Включить эффект) пиктограмма в виде буквы f внутри нее пропадет, и 
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эффект не будет приниматься во внимание при расчете кадра фильма. При 

этом все настройки эффекта сохраняются, и повторное нажатие кнопки 

Enable Effect (Включить эффект) включает эффект. На рис. 5.10 включены 

лишь встроенные эффекты, а также всего один из трех назначенных эффек-

тов — Gaussian Blur (Гауссово размытие). 

 

Рис. 5.10. Из видеоэффектов включен только эффект Gaussian Blur 

5.1.7. Óäàëåíèå ýôôåêòà 

Чтобы безвозвратно удалить эффект для выделенного в окне Timeline (Мон-

таж) клипа: 

� Выделите эффект в окне Effect Controls (Управление эффектом) или в ок-

не Timeline (Монтаж). 

� Либо нажмите клавишу <Del> или <Backspace> на клавиатуре, либо выбе-

рите в верхнем меню Edit>Clear (Правка>Удалить), либо выберите пункт 
Clear (Удалить) в контекстном меню (рис. 5.11). 

 

Для того чтобы безвозвратно удалить сразу все эффекты, назначенные клипу, 
вызовите меню окна Effect Controls (Управление эффектом) и выберите в нем 
команду Delete All Effects from Clip (Удалить все эффекты клипа). 
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Рис. 5.11. Удаление эффекта 

 

Рис. 5.12. Для назначения аудиоэффекта треку вызовите  
раскрывающийся список эффектов в окне Audio Mixer 
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5.1.8. Íàçíà÷åíèå àóäèîýôôåêòà  
çâóêîâîìó òðåêó * 

Аудиоэффекты допускается назначать не только отдельным клипам, но и це-
лым трекам. Для настройки аудиоэффекта на треке сделайте следующее: 

1. Откройте окно Audio Mixer (Аудиомикшер). 

2. Если зоны эффектов на панелях треков скрыты, то вызовите их нажатием 
кнопки Show/Hide Effects and Sends (Показать/Скрыть эффекты и назна-
чения). 

3. Щелкните на кнопке вызова раскрывающегося списка одного из эффектов 
(рис. 5.12). 

4. Выберите в появившемся всплывающем меню желаемый эффект. 

5. Настройте эффект, при помощи появившихся в окне Audio Mixer (Аудио-
микшер) элементов управления параметров эффекта. 

5.2. Äèíàìè÷åñêèå ýôôåêòû 

До сих пор мы говорили о способах создания эффектов, действие которых на 
клип постоянно, т. е. не зависит от времени. Между тем многие эффекты 
можно сделать динамическими, т. е. изменяющими свои параметры во вре-
мени. Например, можно создать эффект, который в начале клипа практически 
не действует, а к концу действия клипа достигает максимальной интенсивно-
сти. Разумеется, можно задавать и более сложные зависимости параметров 
эффектов от времени. На рис. 5.13 приведен пример динамического примене-
ния эффекта к клипу. Интенсивность эффекта вначале нулевая, потом возрас-
тает до максимального значения, а затем вновь уменьшается. 

 

Рис. 5.13. Пример динамического эффекта (коллаж) 

5.2.1. Íàñòðîéêà äèíàìèêè ýôôåêòà  
â îêíå Effect Controls 

Настройка динамических эффектов осуществляется при помощи техники 

ключевых кадров. Для отдельных выбираемых пользователем кадров фильма 
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определяются индивидуальные настройки эффекта, а все остальное Premiere 

делает сам, создавая на участках фильма между ключевыми кадрами плавное 
изменение изображения (или звука — в случае аудиоэффектов). В качестве 

инструмента добавления динамики эффектам служит специальный элемент 
интерфейса лента (или, просто, график) ключевых кадров (keyframe line), 
доступный в окне Effect Controls (Управление эффектом). Графическая об-

ласть окна Effect Controls (Управление эффектом) обычно скрыта, что быва-
ет более предпочтительным при настройке статических эффектов. Для ее раз-

ворачивания следует нажать кнопку Show/Hide Timeline View (Пока-
зать/Скрыть линейку времени) (рис. 5.14). 

 

Рис. 5.14. Разворачивание графической области окна Effect Controls 

Графическая область окна Effect Controls (Управление эффектом) имеет то 
же назначение, что и графическая область окна Timeline (Монтаж). В ее 

верхней части под шкалой времени вы видите символическое представление 
клипа, а под ним, в строках, соответствующих эффектам, производится на-
стройка их динамики при помощи маркеров ключевых кадров (рис. 5.15). 

 

Рис. 5.15. Окно Effect Controls в развернутом виде 
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Положение текущего кадра фильма в окне Effect Controls (Управление эф-

фектом) выделено линией редактирования, а также строкой с тайм-кодом те-

кущего кадра, которые синхронизованы с окнами Program (Программа) и 

Timeline (Монтаж). Управление временной шкалой производится по тому же 

принципу, что и в окне Timeline (Монтаж), т. е. при помощи элементов ин-

терфейса, реализующих операции со шкалой времени и элементами измене-

ния масштаба, находящихся в левом нижнем углу окна. 

Настроим динамический эффект Brightness & Contrast (Яркость и контраст), 

который будет изменять яркость некоторого клипа, делая его первые кадры 

более темными, а последующие более светлыми. 

1. Примените к клипу эффект способом, описанным выше. Выберите эффект 

в окне Effects (Эффекты) и перетащите эффект на клип (рис. 5.15). 

2. Установите линию редактирования на тот кадр, который вы собираетесь 

сделать ключевым. 

3. Щелкните на кнопке Toggle Animation (Включить анимацию) с изображе-

нием секундомера слева от названия параметра Brightness (Яркость) 

(рис. 5.16). После щелчка слева от названия эффекта появится навигатор 

ключевых кадров с выделенной кнопкой (в центре навигатора), говорящей 

о том, что текущий кадр стал ключевым. Кроме того, положение кадра бу-

дет отмечено маркером ключевого кадра в виде ромба на пересечении ли-

нии редактирования и строки эффекта. 

 

Рис. 5.16. Включите анимацию эффекта в окне Effect Controls 
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4. Отрегулируйте значение параметра эффекта при помощи средств окна 

Effect Controls (Управление эффектом), например — ползункового регу-
лятора. 

5. Переместите линию редактирования на следующий кадр клипа, который 
вы собираетесь сделать ключевым, и отрегулируйте параметры эффекта на 

этом кадре в окне Effect Controls (Управление эффектом) (рис. 5.17). Как 
только вы измените значения параметра, текущий кадр автоматически бу-

дет помечен как ключевой. 

 

Рис. 5.17. Создайте ключевые кадры для параметра эффекта  
и отрегулируйте его значения на каждом ключевом кадре 

6. Поочередно установите линию редактирования на те кадры клипа, кото-
рые вы желаете сделать ключевыми, и отрегулируйте настройки эффекта в 
окне Effect Controls (Управление эффектом) для каждого из кадров. 

7. При желании настройте динамические эффекты для других параметров. 

8. По завершении расстановки ключевых кадров просмотрите их и, в случае 
надобности, измените (рис. 5.18). 

Таким образом, при создании динамического эффекта в окне Effect Controls 
(Управление эффектом) на клипах начинают отображаться маркеры ключе-

вых кадров эффекта (keyframe icon) в виде ромбов на этой линии (рис. 5.17, 
5.18). Значения параметров эффекта, которые вы регулируете в режиме ани-

мации, т. е. при включенной кнопке Toggle Animation (Включить анимацию), 
будут относиться только к текущему ключевому кадру. Настройки эффекта 
для других ключевых кадров сохранятся. 

Изменить настройки динамического эффекта можно путем добавления новых 

ключевых кадров, изменением настроек эффекта на существующих или уда-
лением имеющихся ключевых кадров. Для того чтобы отредактировать или 
удалить имеющийся ключевой кадр эффекта клипа, следует поместить точно 

на него линию редактирования. Чтобы не делать этого вручную, в Premiere 
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предусмотрен инструмент, называемый навигатором ключевых кадров 

(keyframe navigator). Он располагается на панели параметра эффекта в окне 
Effect Controls (Управление эффектом). С помощью кнопок навигатора, рас-

положенных по бокам, слева и справа, можно переходить, соответственно, к 
предыдущему или следующему ключевому кадру клипа, а в кнопке посере-
дине отображается информация о том, является ли текущий кадр фильма 

ключевым кадром выделенного клипа (см. рис. 5.17, 5.18). 

 

Рис. 5.18. Настройте динамический эффект, определив  
желаемое значение параметров на каждом из ключевых кадров 

Для удаления текущего ключевого кадра достаточно щелкнуть на средней 
кнопке навигатора. После этого анимация эффекта перестроится с учетом 

оставшихся ключевых кадров. Временное отключение динамического эф-
фекта в фильме осуществляется так же, как и в случае статического эффек-

та — нажатием кнопки Enable Effect (Включить эффект), нажатое состояние 
которой символизируется буквой f внутри кнопки. Для удаления динамики 

эффекта просто выключите кнопку с секундомером слева от его названия — 
все ключевые кадры будут удалены, а эффект останется статическим. 

5.2.2. Íàñòðîéêà äèíàìèêè ýôôåêòà  
â îêíå Timeline * 

Динамику эффекта можно осуществлять не только в окне Effect Controls 

(Управление эффектом), но и непосредственно в окне Timeline (Монтаж).  
В этом случае маркеры ключевых кадров параметров отображаются на самом 
клипе. Для настройки эффекта в окне Timeline (Монтаж): 

1. Примените к клипу желаемый эффект, пользуясь окном Effects (Эф-

фекты). (Если вы собираетесь настраивать динамику одного из встроен-
ных эффектов, этот шаг делать не нужно.) 
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2. Разверните трек, на котором находится клип (видео- или аудио-, в зависи-

мости от типа клипа). 

3. Нажмите в заголовке трека кнопку Show Keyframes (Показать ключевые 
кадры) и в появившемся подменю выберите пункт Show Keyframes (Пока-
зать ключевые кадры). В результате на клипе в окне Timeline (Монтаж) 

появится ленточный регулятор ключевых кадров, имеющий то же строе-
ние, что и ленточный регулятор в окне Effect Controls (Управление эф-

фектом). 

4. В верхнем левом углу клипа раскройте появившийся список назначенных 

эффектов и в подменю выберите тот эффект, который вы собираетесь ре-
дактировать (рис. 5.19). 

 

Рис. 5.19. Выберите в окне Timeline эффект для настройки динамики 

5. Выберите инструмент Pen (Перо) в палитре Tools (Инструментарий). 

6. Установите линию редактирования на тот кадр, который вы собираетесь 

сделать ключевым. 

7. Нажмите центральную кнопку навигатора ключевых кадров (рис. 5.20), 
тем самым сделав текущий кадр ключевым (о чем будет говорить пикто-
грамма в виде ромба, которая появится на ленточном регуляторе в пози-

ции линии редактирования). 
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Рис. 5.20. Настройка динамического эффекта при помощи окна Timeline 

8. Отрегулируйте значения параметров эффекта на линии редактирования 
путем перетаскивания ленты ключевых кадров инструментом Pen (Перо) 

(рис. 5.21). 

 

Рис. 5.21. Настройка динамики эффекта инструментом Pen 
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9. Переместите линию редактирования на следующий кадр клипа, который 

вы собираетесь сделать ключевым, нажмите кнопку навигатора ключевых 
кадров и отрегулируйте параметры эффекта на этом кадре инструментом 

Pen (Перо). 

10. Поочередно настройте остальные ключевые кадры клипа. 

11. При желании настройте динамические эффекты для других парамет- 

ров, пользуясь раскрывающимся списком назначенных эффектов. 

12. При желании отредактируйте созданные ключевые кадры инструментом 

Pen (Перо). 

Для того чтобы изменить значение параметра эффекта на уже созданном мар-
кере ленточного регулятора, просто подведите к нему указатель мыши и пе-

ретащите его вверх или вниз. При наведении инструмента Pen (Перо) или 
Selection (Выбор) на маркер возникает всплывающая подсказка с информа-

цией о текущем значении параметра на ключевом кадре (рис. 5.22). Допуска-
ется также перетаскивать маркеры громкости влево или вправо, изменяя их 

положение относительно клипа. 

 

Рис. 5.22. Регулировка ключевого кадра в окне Timeline 

Для удаления маркера следует выделить его щелчком инструментом Pen (Пе-

ро) и выбрать в верхнем меню Edit>Clear (Правка>Удалить), либо нажать 
среднюю кнопку навигатора ключевых кадров, либо просто нажать клавишу 

<Del> на клавиатуре. 

Вероятно, проводя описанные манипуляции в окне Timeline (Монтаж), вы 

обратили внимание, что соответствующие изменения синхронно происходят 
и в окне Effect Controls (Управление эффектом). Таким образом, для на-

стройки динамики эффектов можно использовать оба элемента интерфейса. 

5.3. Âñòðîåííûå ýôôåêòû 

Рассмотрим кратко особенности применения трех встроенных эффектов: 
движения, прозрачности (для видеоклипов) и громкости (для аудиоклипов). 
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5.3.1. Ìàñøòàáèðîâàíèå è äâèæåíèå êëèïîâ 

Спецэффектом движения (motion) или анимации клипов называется эффект 
перемещения в пределах кадра фильма одних клипов на фоне других. Это 
перемещение может сопровождаться изменением размеров (масштабиро-
ванием клипа), вращением вокруг своей оси, искажением и т. п. Пример дви-
жения клипа с воздушными шарами по клипу с изображением неба приведен 
в виде коллажа трех кадров на рис. 5.23. 

 

Рис. 5.23. Пример анимации клипа (коллаж) 
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Масштабирование и анимация клипов настраиваются в Premiere при помощи 
встроенного эффекта Motion (Движение). Статический вариант этого эффек-
та позволяет осуществить простое масштабирование клипа и его смещение 
относительно кадра фильма, а динамический вариант — настроить полно-
ценную анимацию посредством техники ключевых кадров. Для применения 
эффекта движения к тому или иному клипу его следует предварительно вы-
делить в окне Timeline (Монтаж). Назначить анимацию можно для клипа, 
расположенного на любом треке (в том числе и на треке Video 1 — в этом 
случае движение будет проходить на черном фоне, поскольку под слоем тре-
ка Video 1 ничего нет). Мы будем рассматривать эффект движения на приме-
ре двух клипов, расположенных на треках друг над другом, причем (для уп-
рощения восприятия) в качестве нижнего клипа выберем специальный клип 
универсального отсчета времени (рис. 5.24). 

 

Рис. 5.24. Клип с верхнего трека пока полностью заслоняет клип с нижнего трека 
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Для настройки эффекта Motion (Движение): 

1. Выделите клип в окне Timeline (Монтаж). 

2. Вызовите окно Effect Controls (Управление эффектом). 

3. В окне Effect Controls (Управление эффектом) нажмите кнопку с пикто-
граммой в виде буквы f включения эффекта Motion (Движение). 

4. Щелкните на пиктограмме слева от названия эффекта Motion (Движение) 
(рис. 5.25), что позволит проводить его визуальную настройку в окне 

Program (Программа). 

 

Рис. 5.25. Включение визуальной настройки (в кадре) эффекта Motion 

5. Пользуясь инструментом Selection (Выбор), масштабируйте изображение 
выделенного клипа в окне Program (Программа), хватаясь и перетаскивая 
маркеры обрамления, выделяющие кадр (см. рис. 5.25). Перетаскиванием 

клипа за центр изображения можно добиться его перемещения в любую 
часть фильма. 

6. При желании отредактируйте параметры Position (Расположение) и Scale 
(Масштаб) в окне Effect Controls (Управление эффектом). Кроме того, вы 
имеете возможность повернуть кадр путем определения угла поворота в 

поле Rotation (Вращение) (рис. 5.26). 

Для настройки анимации следует сделать эффект Motion (Движение) дина-
мическим. Проделайте следующее: 

1. Установите линию редактирования на кадр, который вы собираетесь сде-
лать ключевым. 

2. В окне Effect Controls (Управление эффектом) раскройте вложенный спи-
сок эффекта Motion (Движение) и, если этот эффект еще не включен, 

включите его нажатием кнопки. 
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Рис. 5.26. Настройка вращения клипа 

3. Выберите параметр эффекта Motion (Движение) и щелкните на кнопке 
Toggle Animation (Включить анимацию), изображающей секундомер, 

расположенной слева от названия этого параметра. В результате пересече-
ние линии редактирования и строки параметра будет отмечено характер-

ным ромбом, говорящим о том, что данный кадр стал ключевым. 

4. Определите величину параметра для данного ключевого кадра при помо-

щи соответствующего поля с числовым значением или визуальным спосо-
бом в окне Program (Программа) (рис. 5.27). 

5. Подобным образом (пп. 1—4) определите остальные ключевые кадры, за-
дав для них желаемые значения параметра. 

6. Просмотрите кадры композиции, оценив качество анимации, и, при необ-

ходимости, отредактируйте ключевые кадры и/или настройте анимацию 
для других параметров. 

 

Рис. 5.27. Настройка анимации клипа 
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Вы видите, что, комбинируя динамику всего нескольких параметров встро-
енного эффекта Motion (Движение), можно создавать весьма зрелищные эф-
фекты анимации. Перечислим эти параметры, которые доступны для редак-
тирования в окне Effect Controls (Управление эффектом). 

� Anchor Point (Точка привязки) — задает выделенную невидимую точку 
на клипе, которая имеет ключевое значение при некоторых операциях (на-
пример, при повороте клипа точка привязки является центром вращения). 
Таким образом, передвижение точки привязки не влияет на внешний вид 
самого клипа, но играет определяющую роль при некоторых действиях. 
Как и многие другие параметры, точка привязки характеризуется двумя 
числами — координатами по горизонтали и вертикали. По умолчанию 
точка привязки помещается в центр изображения клипа (см. рис. 5.25); 

� Position (Расположение) — параметр, определяющий положение клипа 
относительно кадра фильма и содержащий две координаты (горизон-
тальную и вертикальную). С помощью задания ключевых кадров для этого 
параметра можно осуществить перемещение кадров слоя по кадру фильма. 
Линия, по которой клип будет перемещаться в кадре фильма, называется 
траекторией, или путем его движения (motion path), и показывается 
пунктиром в окне Program (Программа); 

� Scale (Масштаб) — определяет изменение размера кадра клипа со време-
нем; 

� Rotation (Вращение) — определяет вращение клипа вокруг точки привяз-
ки клипа (см. рис. 5.26). Параметр задается комбинацией двух чисел — 
числа переворотов на траектории и текущего угла поворота; 

� Anti-flicker Filter (Фильтр мерцания) — задает дополнительную обработ-
ку изображения, которая регулирует эффект мерцания видео. 

Как вы видите, масштабирование и анимация клипов в Premiere осуществля-
ются путем стандартной настройки встроенного эффекта Motion (Движение) 
и могут проводиться визуальным способом непосредственно на кадре фильма 
в окне Program (Программа). 

5.3.2. Íàñòðîéêà ïðîçðà÷íîñòè âèäåîêëèïà 

Как мы уже раньше отмечали, каждый видеотрек фильма фактически пред-
ставляет собой отдельный слой изображения. Самым нижним слоем является 
трек Video 1, следующий — Video 2 и т. д. Под треком Video 1 нет других 
треков, под ним расположен черный фон. 

Если на треке нет клипов, то это означает, что трек является совершенно про-
зрачным, и в формировании изображения кадра фильма не участвует. Если 
клипов нет ни на одном из треков, то кадром фильма будет черный экран. 



Ñïåöýôôåêòû 159 

Если же на треке располагается клип, то прохождение сквозь него изображе-
ния с нижних треков зависит от степени прозрачности этого клипа. До сих 
пор мы имели дело с непрозрачными (сплошными) клипами, которые, будучи 
расположенными на треке, полностью заслоняют клипы с треков, находя-
щихся ниже. Однако клипам на треках можно назначать различные режимы 
прозрачности. 

Настройка наложения видео напоминает наслаивание друг на друга разно-
цветных стеклянных пластин. Под пластинами находится черный фон, а сами 

пластины могут быть частично прозрачными, а также иметь определенные 
непрозрачные участки. Наложение пластин определяет окончательную кар-

тину. Точно так же накладываются друг на друга и клипы. Понятно, что при 
этом основную роль должны играть способы назначения режима прозрачно-
сти видеоклипам. 

Самый простой вариант настройки наложений клипов — это определение 

прозрачности его изображения как единого целого (без разметки, в кадре, об-
ластей с разной прозрачностью). Для назначения такого типа наложения слу-
жит встроенный эффект Premiere, называемый Opacity (Непрозрачность). Его 

регулировка осуществляется точно так же, как и настройка любого другого 
эффекта в окне Timeline (Монтаж) или окне Effect Controls (Управление эф-

фектом). 

Чтобы задать прозрачность клипа в окне Effect Controls (Управление эффек-

том), достаточно выделить этот клип и установить желаемое значение пара-
метра Opacity (Непрозрачность) одноименного эффекта Opacity (Непрозрач-

ность) (рис. 5.28). 

Для задания постоянной прозрачности клипа в окне Timeline (Монтаж): 

1. Разверните трек, на котором находится клип, нажмите кнопку Show 
Keyframes (Показать ключевые кадры) и в появившемся подменю выбе-

рите пункт Show Opacity Handles (Показать маркеры непрозрачности).  
В результате на клипе в окне Timeline (Монтаж) появится ленточный ре-

гулятор прозрачности. 

2. Выберите инструмент Pen (Перо) в палитре Tools (Инструментарий). 

3. Отрегулируйте значение непрозрачности либо путем перетаскивания лен-

точного регулятора прозрачности инструментом Pen (Перо) в окне 
Timeline (Монтаж), либо при помощи стандартных регуляторов параметра 
Opacity (Непрозрачность) одноименного встроенного эффекта в окне 

Effect Controls (Управление эффектом). 

4. При желании сделайте спецэффект прозрачности динамическим при по-

мощи ключевых кадров прозрачности. Для этого нажмите кнопку Toggle 
Animation (Включить анимацию) для эффекта Opacity (Непрозрачность)  
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в окне Effect Controls (Управление эффектом). Затем настройте интенсив-

ность эффекта прозрачности для каждого из ключевых кадров клипа 
(рис. 5.29). 

 

Рис. 5.28. Настройка постоянной прозрачности выделенного клипа в окне Effect Controls 

 

Не забывайте о том, что параметр Opacity (Непрозрачность) измеряется в про-
центах непрозрачности клипа, т. е. описывает, насколько сплошным должен 
быть этот клип. 

Завершая разговор о настройке прозрачности клипов, отметим, что, вообще 
говоря, в зависимости от потребностей пользователя разрешается настраи-
вать несколько режимов прозрачности: 

� регулировка степени прозрачности клипа как единого целого, независимо 
от содержимого нижних треков (этот случай мы и рассмотрели); 

� настройка одного из эффектов прозрачного наложения, осуществляющего 
смешивание изображения клипа на треке с нижними треками по опреде-
ленному алгоритму; 

� разметка областей прозрачности изображения клипа при помощи масок. 
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Рис. 5.29. Настройка динамики прозрачности клипа в окне Timeline 

Два последних типа реализуются при помощи соответствующих эффектов, 
доступных в окне Effects (Эффекты). 

5.3.3. Ãðîìêîñòü çâóêà 

Встроенный эффект громкости позволяет изменить громкость звучания  
аудиоклипов или целых аудиотреков. Повторим основную последователь-
ность действий, необходимых для настройки эффекта: 

1. Разверните аудиотрек нажатием треугольной кнопки Collapse/Expand 

Track (Свернуть/Развернуть трек) в его заголовке. 

2. Нажмите кнопку Set Display Style (Установить стиль отображения) в заго-

ловке аудиотрека и выберите в появившемся подменю пункт Show 
Waveform (Показать график громкости). 

3. Нажмите кнопку Show Keyframes (Показать ключевые кадры) в заголовке 
аудиотрека и выберите в появившемся подменю один из пунктов Show 

Clip Volume (Показать громкость клипа) для настройки громкости от-
дельных клипов или Show Track Volume (Показать громкость треков) для 

настройки громкости треков. 
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4. Пользуясь инструментом Pen (Перо), определите интенсивность статиче-

ского эффекта громкости клипа (или трека) целиком. 

5. Перетаскивая инструментом Pen (Перо) график ленточного регулятора 

громкости в точке нужного кадра при нажатой клавише <Ctrl>, настройте 

динамику эффекта громкости (рис. 5.30) 

 

Рис. 5.30. Настройка эффекта громкости 

Для того чтобы изменить громкость звука на уже созданном маркере ленточ-

ного регулятора громкости, просто подведите к нему указатель мыши и пере-

тащите его вверх или вниз. При наведении инструмента Pen (Перо) или 

Selection (Выбор) на маркер возникает всплывающая подсказка с информа-

цией о текущем значении громкости на ключевом кадре (рис. 5.31). 

 

Рис. 5.31. Регулировка громкости на маркере 

 

Допускается перетаскивать маркеры громкости влево или вправо, изменяя их 
положение относительно клипа. 

Для равномерного изменения громкости звука на некотором фрагменте  

аудиоклипа, т. е. между двумя маркерами громкости, следует выбрать инст-

румент Pen (Перо) или Selection (Выбор), подвести указатель к точке ленточ-

ного регулятора между маркерами и перетащить этот фрагмент регулятора 

вверх или вниз. 
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5.4. Ïåðåõîäû 

Переходами (transitions) называют спецэффекты, заключающиеся в смене 
специальным образом либо изображения одного видеоклипа другим (рис. 5.32), 

либо звука одного аудиоклипа звуком другого. Создать переход можно не-
сколькими различными способами. 

 

Рис. 5.32. Переход между клипами (коллаж кадров фильма):  
средний кадр содержит изображения обоих клипов, наложенные друг на друга 

5.4.1. Ñîçäàíèå ïåðåõîäà ïåðåòàñêèâàíèåì 

Чтобы создать переход между двумя клипами: 

1. Расположите два клипа, между которыми вы собираетесь добавить пере-

ход, на одном треке. Позаботьтесь о том, чтобы за пределами выходной 
точки первого клипа и/или входной точки второго находились кадры, ко-

торые могут быть использованы для перекрытия клипов при создании пе-
рехода. 

2. Выберите переход в окне Effects (Эффекты) и перетащите его на трек, на 
котором расположены клипы, не отпуская кнопки мыши (рис. 5.33). 

3. Как только переход окажется на месте стыка клипов, Premiere просигнали-
зирует вам о возможности его вставки характерной пиктограммой, отме-

чающей место предполагаемой вставки перехода (рис. 5.33). В зависимо-
сти от текущего положения указателя относительно стыка клипов выбери-

те один из трех вариантов выравнивания перехода — на месте кадров 
левого клипа, по центру стыка или на месте кадров правого клипа. 

4. Отпустите кнопку мыши в нужном положении перехода, и он будет встав-
лен в фильм и показан синим прямоугольником в окне Timeline (Монтаж) 

(рис. 5.34). 

5. Двойным щелчком на переходе в окне Timeline (Монтаж) откройте на-

стройки перехода в окне Effect Controls (Управление эффектом). 

При желании отредактируйте длительность перехода путем перетаскива-

ния его конца или начала на новое место в окне Timeline (Монтаж) при  
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Рис. 5.33. Вставка перехода в фильм 

 

Рис. 5.34. Фрагмент фильма с переходом между клипами 
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Рис. 5.35. Редактирование длительности перехода 

помощи инструмента Selection (Выбор), либо в окне Effect Controls 
(Управление эффектом). При необходимости отрегулируйте также точ- 
ное положение перехода путем перетаскивания его центральной области 
(рис. 5.35). 

6. Выполните настройку перехода в открывшемся окне Effect Controls 

(Управление эффектом) (см. разд. 5.1). 

 

Аудиопереходы назначаются аналогично, требуется только использовать зву-
ковые клипы и переходы из папки Audio Transitions (Аудиопереходы) окна 
Effects (Эффекты). 

5.4.2. Ðåäàêòèðîâàíèå ïåðåõîäà 

Переход, вставленный в фильм, можно редактировать, т. е. изменять его на-
стройки. Переходы разных типов позволяют регулировать различные на-
стройки, причем основная часть параметров перехода настраивается в окне 
Effect Controls (Управление эффектом) (рис. 5.35), которое вызывается 
двойным щелчком на переходе. 

Окно Effect Controls (Управление эффектом) применительно к переходам 
используется точно так же, как и для эффектов (см. разд. 5.1), отличаясь 
лишь небольшими особенностями. Во-первых, в окне Effect Controls (Уп-
равление эффектом) можно установить основные характеристики перехода в 
полях Duration (Длительность) и Alignment (Выравнивание) соответственно. 
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Во-вторых, переход можно просмотреть в миниатюре прямо в окне Effect 
Controls (Управление эффектом) при нажатии кнопки Play the Transition 
(Проиграть переход). В-третьих, для переходов различного типа можно на-
страивать специфические опции, например опцию обращения перехода во 
времени, при помощи флажка Reverse (Обратить), или опции настройки гео-
метрии перехода. 

Кроме того, окно Effect Controls (Управление эффектом) имеет области вы-
бора начала и конца перехода — Start (Начало) и End (Конец), снабженные 

ползунковыми регуляторами и изображениями модельного кадра начала и 
конца перехода соответственно. С их помощью можно изменять степень за-
вершенности перехода, которая соответствует началу и концу перехода. По 

умолчанию принято, что переход начинается при 0% завершенности, а закан-
чивается при 100%. Однако можно задать, к примеру, начало и конец перехо-

да при отличной от нуля завершенности. В этом случае при старте перехода 
на экране уже будет видна часть второго клипа, как это показано на рис. 5.36. 

 

Флажок Show Actual Sources (Показывать сами клипы) задает опцию показа 

реальных кадров фильма на панелях выбора начала и конца перехода вместо 
модельных кадров, обозначенных как А и В (рис. 5.36). 

Редактирование переходов в окне Effect Controls (Управление эффектом) 

производится в реальном времени, поэтому вносимые изменения тут же дей-
ствуют на фильм в окне Timeline (Монтаж). 

 

Рис. 5.36. Панель с настройками перехода 
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Этот урок посвящен титрам — текстовым подписям и рисункам, которые 
пользователю позволяется добавлять к фильму. Вообще говоря, в Premiere 
титрами (title) называются клипы особого типа, которые могут содержать 
как текст, так и графические примитивы (например, прямоугольники, эллип-
сы, линии и т. п.). 

Для освоения основ работы с титрами достаточно будет познакомиться толь-
ко с ее первыми разделами (см. разд. 6.1, 6.2). 

� Чего мы хотим: 

• научиться создавать и редактировать титры (на простых модельных 
примерах). 

� Нам потребуется: 

• один видеофайл. 

� Что полезно вспомнить: 

• как создаются новые специальные клипы (см. разд. 3.1.5). 

6.1. Êëèïû ñ òèòðàìè 

Клипы с титрами создаются и редактируются непосредственно в Premiere при 
помощи специального встроенного графического редактора, называемого, 
начиная с версии Premiere Pro 2.0, Titler (Дизайнер титров). Окно Titler (Ди-
зайнер титров) существенно уступает в возможностях традиционным графи-
ческим пакетам (таким как Adobe Photoshop). Однако следует помнить, что 
он нацелен именно на создание характерного оформления кадров видео-
фильма. Примерами могут служить средства для создания бегущего текста 
или развитой системы управления прозрачностью фона и графики. 
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Титры могут включать разнообразные текстовые структуры, традиционные 
графические примитивы, а также сложные фигуры. Для создания и редакти-
рования титров предназначен специальный одноименный элемент интерфей-
са Premiere — окно Titler (Дизайнер титров). Вводный раздел данного урока 
посвящен технике создания клипов с титрами и основным приемам работы с 
ними как в окне титров, так и в окне Timeline (Монтаж). 

6.1.1. Ñîçäàíèå êëèïà ñ òèòðàìè 

Титры в Premiere хранятся в клипах специального вида, называемых клипами 
титров. Титры бывают трех видов: 

� Still (статические); 

� Roll (бегущие вертикально); 

� Crawl (бегущие горизонтально). 

Мы рассмотрим, в основном, принципы работы с обычными статическими 
титрами, а затем (в конце главы) покажем, как настраиваются бегущие титры. 

Для создания нового клипа с титрами выполните следующие действия. 

1. Сделайте активной ту корзину окна Project (Проект), в которой вы хотите 
разместить клип с титрами. 

2. Выберите в верхнем меню команду File>New>Title (Файл>Создать> 
Титры). 

3. В открывшемся окне Titler (Дизайнер титров) (рис. 6.1) создайте нужные 
вам титры, т. е. добавьте необходимые текст, графику и т. п., пользуясь 
панелью инструментов этого окна (пример ввода текста в титры приведен 
на рис. 6.2). 

4. Закройте окно Titler (Дизайнер титров). 

 

Создать новый клип с титрами, как вы помните, можно и при помощи кнопки 
Create Item (Создать) на панели инструментов окна Project (Проект). В от-
крывшемся диалоговом окне следует выбрать из раскрывающегося списка типа 
создаваемого объекта вариант Title (Титры). 

В результате клип с титрами появится в окне Project (Проект) (рис. 6.3), и с 
ним можно будет работать как с обычным статическим клипом. При желании 
можно переименовать клип титров, присвоив ему название, исходя из содер-
жимого или назначения титров. 

Работать с фильмом в окне Timeline (Монтаж) можно, не закрывая окна 
Titler (Дизайнер титров) (или его нескольких окон, если одновременно ре-
дактируется несколько клипов с титрами). Сделать окно активным можно, 
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щелкнув в его пределах мышью или при помощи выпадающего меню 
Window (Окно), в нижней части которого приведен список всех открытых 
окон. Последний способ особенно удобен, если на экране одновременно на-
ходится большое число окон, и многие из них полностью скрыты соседними 
окнами. 

 

Рис. 6.1. Вид окна Titler сразу после создания нового клипа титров 

6.1.2. Âñòàâêà òèòðîâ â ôèëüì 

После того как вы сохранили титры в файле, соответствующий клип появля-

ется в окне Project (Проект) (рис. 6.3). Для того чтобы вставить клип с тит-

рами в фильм, достаточно просто перетащить его из окна Project (Проект) в 

желаемое место нужного трека в окне Timeline (Монтаж), как обычный клип 

со статическим изображением (рис. 6.4). По умолчанию клипам с титрами 

присваивается тип прозрачности Alpha Channel (Альфа-канал). Невидимый 

для пользователя альфа-канал клипа с титрами формируется Дизайнером 

титров автоматически, исходя из их содержимого. 
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Рис. 6.2. Вставка текста в титры 

 

Рис. 6.3. Клип с титрами в окне Project 
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Рис. 6.4. Клип с титрами в фильме 

 

Практически во всем клипы с титрами ведут себя так же, как и статические 

клипы. Даже их тип в окне Project (Проект) помечен как Still Image (Ста-

тическое изображение). Поэтому для клипов с титрами, вставленных в окно 

Timeline (Монтаж), можно определить весь спектр спецэффектов — движе-

ния, прозрачности и т. п. 

Для последующего редактирования титров, вставленных в фильм, просто 

дважды щелкните мышью на клипе с титрами в окне Timeline (Монтаж), и 

титры загрузятся в окно Titler (Дизайнер титров). 
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Клипы с титрами отличаются от всех остальных клипов. При переносе в окно 
Timeline (Монтаж) не создается независимого экземпляра клипа с титрами. 
Этот клип всегда соответствует той информации, которая хранится в мастер-
клипе. 

6.1.3. Èíòåðôåéñ îêíà Titler 

Интерфейс Дизайнера титров довольно прост и интуитивен. Если у вас есть 
опыт работы с традиционными графическими редакторами, то вы без допол-
нительных затрат сил и времени сумеете пользоваться всем спектром воз-
можностей, которые предоставляются Дизайнером титров. С другой стороны, 
Дизайнер титров нацелен на решение задачи создания титров для фильмов, 
поэтому некоторые его опции являются специфическими. 

Основными составляющими интерфейса окна Titler (Дизайнер титров) явля-
ются следующие элементы (см. рис. 6.1): 

� Titler Tools (Инструментарий титров)  — собственный инструментарий 
(или панель инструментов) — представляет собой панель с кнопками, 
примыкающую по умолчанию к левой границе окна, и предназначен для 
выбора какого-либо инструмента, ответственного за определенные дейст-
вия; 

� Titler Actions (Действия титров)  — панель инструментов, которая служит 
для осуществления таких операций, как выравнивание объектов; 

� панель инструментов форматирования в верхней части окна (под заклад-
кой); 

� контекстное меню — меню, которое вызывается щелчком правой кнопки 
мыши на объекте или пустой части полотна; 

� меню панелей окна Titler (Дизайнер титров), вызываемые нажатием на 
характерные кнопки в правом верхнем углу панелей; 

� верхнее меню Title (Титры); 

� полотно — область, представляющая собой кадр клипа титров, на кото-
рую пользователь может наносить самые разные объекты; 

� Titler Styles (Стиль титров) — панель, предназначенная для быстрого 
форматирования титров при помощи набора предустановок, называемых 
стилями; 

� Title Properties (Свойства титров) — панель для форматирования и редак-
тирования объектов, которая устроена в виде иерархической последова-
тельности списков, объединяющих группы сходных по смыслу параметров 
объекта: 
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• Transform (Преобразование); 

• Properties (Свойства); 

• Fill (Заливка); 

• Strokes (Обрамление); 

• Shadow (Тень). 

В свою очередь, параметры на панелях Titler Styles (Стиль титров) и Title 

Properties (Свойства титров) содержат списки второго уровня, например, 
список Fill (Заливка) — внутренние списки Sheen (Блик), Texture (Текстура)  
 

 

 

Рис. 6.5. Навигация по спискам панели Titler Properties 
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и т. д. Содержимое каждого списка можно раскрыть или скрыть щелчком на 
треугольной кнопке возле заголовка списка (рис. 6.5). Когда список раскрыт, 
такая кнопка направлена вниз, а когда его содержимое скрыто — вправо. 

Панели Titler Styles (Стиль титров) и Title Properties (Свойства тит-
ров) содержат много специфических регуляторов числовых значений пара-
метров, характерных для Premiere. Среди параметров настройки цвета (на-
пример, цвета заливки, тени, линий обрамления и др.) различных списков па-
нели Titler Styles (Стиль титров) довольно часто встречаются поля выбора 
текущего цвета, сопровождаемые кнопкой выбора инструмента Eyedropper 
(Пипетка). 

6.1.4. Èíñòðóìåíòàðèé îêíà Titler 

Как уже отмечалось, панель Titler Tools (Инструментарий титров) содержит 
ряд кнопок, одна из которых является активной (рис. 6.6). Кнопки соответст-
вуют различным инструментам, использующимся для определенных целей 
при редактировании клипов титров. 

 

Рис. 6.6. Инструментарий  
титров 

 
Инструменты делятся на несколько групп согласно их назначению: 

� Selection (Выбор) — предназначен для выделения объекта или группы 
объектов, а также для их масштабирования; 

� Rotation (Вращение) — предназначен для поворота объектов; 
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� Type (Текст) — несколько инструментов, каждый из которых предназна-

чен для создания и редактирования текстовых объектов определенного 
типа: 

• горизонтальный текст; 

• вертикальный текст; 

• горизонтальный текстовый блок; 

• вертикальный текстовый блок; 

• фигурный текст; 

� Bezier (Кривые Безье) — несколько инструментов, позволяющих осуще-
ствлять рисование "от руки" как ломаных, так и сглаженных линий и  
фигур: 

• Create Bezier (Создать кривую Безье); 

• Bezier+ (Добавить маркер кривой Безье); 

• Bezier– (Удалить маркер кривой Безье); 

• Edit Bezier (Редактировать кривую Безье); 

� Graphics (Графические примитивы) — набор инструментов, создающих 

определенные графические примитивы: 

• Rectangle (Прямоугольник); 

• Clipped Corner Rectangle (Прямоугольник со срезанными углами); 

• Rounded Corner Rectangle (Прямоугольник с закругленными углами); 

• Round Rectangle (Закругленный прямоугольник); 

• Wedge (Треугольник, или Угол); 

• Arc (Дуга); 

• Ellipse (Эллипс); 

• Line (Линия). 

6.1.5. Ïðîñìîòð òèòðîâ íà ôîíå ôèëüìà 

Дизайнер титров дает пользователю возможность редактировать титры не 
только на сером фоне, но и на фоне реальных кадров фильма. Для того чтобы 
отображать титры на фоне фильма: 

1. Установите флажок Show Video (Показывать видео) (рис. 6.7). 

2. При желании установите подходящий кадр фильма при помощи поля вы-
бора тайм-кода кадра в окне Titler (Дизайнер титров). 



Óðîê 6 176 

 

Рис. 6.7. Просмотр титров на фоне кадра фильма 

6.2. Øàáëîíû è ñòèëè òèòðîâ 

Наиболее простой вариант использования Дизайнера титров связан с приме-

нением предустановленных шаблонов и стилей. Шаблоны позволяют быстро 
создавать титры определенного дизайна, а стили — редактировать объекты 

титров "в один щелчок мыши". 

6.2.1. Øàáëîíû 

Шаблонами (template) называются файлы с титрами, включенные в комплект 
Premiere, которые были специально разработаны профессиональными ху-

дожниками. Таким образом, вам предлагается использовать большое количе-
ство предварительных заготовок готовых титров (представляющих собой 
комбинацию текста и графики), заменив в них некоторый символический 

текст на свой собственный. 

Чтобы воспользоваться одним из шаблонов, необходимо проделать описан-

ные далее действия. 
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1. В верхнем меню выберите Titler>Templates (Титры>Шаблоны). 

2. В раскрывшемся диалоге Templates (Шаблоны) выберите желаемый файл 

с шаблоном, оценивая предлагаемые шаблоны титров в области предвари-

тельного просмотра (рис. 6.8). 

 

Рис. 6.8. Применение шаблона к титрам при помощи окна Templates 

3. После выбора подходящего вам шаблона титров нажмите в диалоге кноп-

ку Apply (Применить), и соответствующие титры будут открыты в Дизай-
нере титров. 

4. Замените символический текст, который имеется в шаблоне титров, на 
свой собственный. Для этого выделите символический текст инструмен-
том Type (Текст) и введите вместо него с клавиатуры другой текст 

(рис. 6.9). 

5. Просмотрите клип с титрами на фоне кадра фильма (рис. 6.10). 

6.2.2. Ñòèëè 

Стилями (styles) называются сохраненные особым образом настройки фор-

матирования (они универсальны как для текстовых, так и для графических 

объектов), которые можно использовать для быстрого форматирования объ-

ектов в титрах. Рассмотрим основные аспекты применения стилей. 
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Рис. 6.9. Замените символический текст титров 

 

Рис. 6.10. Результат создания текста титров на основе шаблона 
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Ïðèìåíåíèå ñòèëåé 

Объекты, которые имеются в титрах (возможно, вставленные в них из шаб-

лонов), легко отформатировать в один щелчок мыши, применив один из пре-

дустановленных стилей. Для этого выделите объект на полотне инструмен-

том Selection (Выбор) и щелкните на пиктограмме желаемого стиля на пане-

ли Titler Styles (Стиль титров) в нижней части окна Titler (Дизайнер титров). 

В результате объект приобретет форматирование, представленное пикто-

граммой стиля (рис. 6.11). 

 

Рис. 6.11. Применение стиля объекта 

Óïðàâëåíèå ñòèëÿìè 

Содержимым палитры Titler Styles (Стиль титров) можно управлять, созда-

вая новые стили и удаляя существующие. Подобно тому, как вы применяете 



Óðîê 6 180 

имеющиеся стили для форматирования объектов титров, можно определить 

новый стиль на основе форматирования какого-нибудь объекта. 

Для того чтобы создать новый стиль: 

1. Отформатируйте какой-либо объект на полотне титров желаемым образом 

и выделите этот объект инструментом Selection (Выбор). 

2. Вызовите меню панели Titler Styles (Стиль титров). 

3. Выберите из меню команду New Style (Создать стиль). 

4. В открывшемся диалоговом окне определите название нового стиля в поле 

ввода Name (Название) и нажмите в нем кнопку ОК. 

В результате стиль будет добавлен к списку стилей в виде кнопки с соответ-

ствующим оформлением букв "Аa", как пример. 

Чтобы удалить один из существующих стилей, достаточно вызвать контекст-

ное меню, щелкая правой кнопкой мыши на кнопке этого стиля и выбирая из 

меню пункт Delete Style (Удалить стиль), либо нажать кнопку Delete Style 

(Удалить стиль) на панели инструментов в правой части панели Styles (Сти-

ли). После этого в открывшемся диалоге предупреждения вам следует под-

твердить свое намерение удалить стиль нажатием кнопки ОК. 

Отредактировать существующий стиль можно следующим образом: 

1. Выделите какой-либо из объектов на полотне (в этих целях, к примеру, 

можно временно создать тестовый объект). 

2. Примените к нему тот стиль, который вы хотите отредактировать. 

3. Отформатируйте объект в соответствии с создаваемым стилем. 

4. Создайте на основе форматирования объекта новый стиль описанным вы-
ше способом. 

5. По желанию удалите прежний стиль из панели Styles (Стили). 

6.3. Îáúåêòû â òèòðàõ 

Объекты различных типов создаются при помощи соответствующих инстру-

ментов инструментария, а для удаления объекта достаточно выделить его ин-
струментом Selection (Выбор) и нажать затем клавишу <Del> на клавиатуре. 

6.3.1. Òåêñò 

Для того чтобы добавить в клип с титрами текстовый объект, следует вос-

пользоваться одним из четырех инструментов, относящихся к классу тексто-
вых. Этим инструментам соответствуют кнопки с литерой Т на панели Tools 
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(Инструментарий). Нужно выбрать тот тип инструмента Type (Текст), кото-

рый отвечает вашей задаче. 

Перечислим (слева направо и сверху вниз, рис. 6.12) назначение инструмен-
тов группы Type (Текст): Type (Горизонтальный текст), Vertical Type (Вер-
тикальный текст), Area Type (Горизонтальный текстовый блок), Vertical 

Area Type (Вертикальный текстовый блок), а также фигурного текста Path 

Type (Горизонтальный фигурный текст), Vertical Path Type (Вертикальный 

фигурный текст). 

 

Рис. 6.12. Создание текстового объекта 

Ïðîñòîé òåêñò 

Чтобы создать текстовый блок без ограничения его размеров (геометрия  

текста будет подобрана автоматически), следует выполнить следующие дей-
ствия: 

1. Выберите один из двух инструментов Type (Текст), предназначенных для 
создания горизонтального или вертикального текста, в зависимости от то-

го, в каком направлении вы собираетесь расположить текст в титрах 
(рис. 6.12, 6.13 соответственно). 

2. Щелкните в том месте полотна, куда вы собираетесь вставить первый сим-
вол текста. 

3. Введите текст с клавиатуры. 

4. При желании отформатируйте введенный текст (см. разд. 6.4.4). 

По мере ввода текста создаваемый текстовый объект будет автоматически 
увеличиваться в размерах, причем его размер будет в точности соответство-
вать содержанию и формату текста. Если вы впоследствии будете масштаби-

ровать такой текстовый объект при помощи инструмента Selection (Выбор), 
то размер символов текста будет изменяться, подстраиваясь под новый раз-

мер текстового объекта. 
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Рис. 6.13. Создание вертикального текста 

Òåêñòîâûé áëîê 

Для того чтобы вручную определить размеры текста при его создании, следу-
ет пользоваться инструментами Area Type (Горизонтальный текстовый блок) 
и Vertical Area Type (Вертикальный текстовый блок), предназначенными для 

создания текстовых областей с фиксированными границами. Для этого 
(рис. 6.14): 

1. Выберите нужный инструмент (горизонтальный или вертикальный, в за-
висимости от желаемого направления текста в титрах). 

2. При помощи протаскивания указателя при нажатой кнопке мыши опреде-
лите на полотне прямоугольный контур будущего текстового блока. 

3. Отпустите кнопку мыши — в результате будет создан текстовый блок, 

границы которого будут показаны обрамлением. 

4. Введите текст с клавиатуры. 

5. При желании отформатируйте введенный текст. 

Текстовый блок, введенный таким способом, всегда будет иметь те границы, 
которые вы определили. Текст, который не поместится в пределы блока,  

в титрах показан не будет. Размер текстового блока можно впоследствии из-
менять, не опасаясь за изменение атрибутов его текста. 
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Рис. 6.14. Создание текстового блока 

Ôèãóðíûé òåêñò 

Еще один вид текстовых объектов — это фигурный текст. Данный объект пред-
ставляет собой комбинацию текстового блока с фигурой Безье (см. разд. 6.3.2). 

Чтобы добавить фигурный текст к клипу с титрами (рис. 6.15), выполните 
описанные далее действия. 

1. Выберите один из инструментов Path Type (Фигурный текст), служащий 
для создания фигурного текста в желаемом направлении. 

 

Рис. 6.15. Фигурный текст в титрах 
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2. Щелчками мыши определите (возможно, в черновом варианте) контуры 

будущего фигурного текста. 

3. Введите текст с клавиатуры. 

4. Отредактируйте форму введенного текста, пользуясь инструментами, 

предназначенными для работы с фигурами Безье (см. разд. 6.3.2). 

6.3.2. Êðèâûå Áåçüå 

В окне Titler (Дизайнер титров) опция рисования линий "от руки" реализова-

на при помощи создания кривых, называемых кривыми Безье. Кривые  
Безье — это кривые, состоящие из отдельных участков, отделенных друг от 
друга маркерами, которые можно, в свою очередь, редактировать при помо-

щи управляющих линий. Кривые Безье, подобно другим объектам, могут 
иметь не только линию обрамления, но и заливку. 

Кривые Безье рассчитываются, исходя из перемещения пользователем марке-
ров и управляющих линий по полотну, по весьма сложным математическим 

алгоритмам, предложенным в свое время, Безье — сотрудником одного из 
французских автомобильных концернов. При работе с кривыми Безье гораздо 

важнее представлять хотя бы на интуитивном уровне, как действия пользова-
теля будут влиять на форму этих кривых, нежели разбираться в сложных ас-
пектах их расчетов. Поэтому мы настоятельно советуем читателю поэкспе-

риментировать с созданием нескольких кривых Безье в качестве тестов, что-
бы обучиться их свойствам. 

Для редактирования кривых Безье в окне Titler (Дизайнер титров) преду-
смотрены четыре различных инструмента: 

� Create Bezier (Создать кривую Безье) — предназначен для создания новой 

кривой Безье; 

� Bezier+ (Добавить маркер кривой Безье) — добавляет новый управляю-

щий маркер на существующую кривую Безье; 

� Bezier– (Удалить маркер кривой Безье) — удаляет один из управляющих 

маркеров с кривой Безье; 

� Edit Bezier (Редактировать кривую Безье) — предназначен для редактиро-
вания формы и размера существующей кривой Безье. 

В Дизайнере титров предусмотрено три типа кривых Безье: 

� Open Bezier (Незамкнутая кривая Безье); 

� Closed Bezier (Замкнутая кривая Безье); 

� Filled Bezier (Кривая Безье с заливкой). 
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Для того чтобы создать кривую Безье в титрах, сделайте следующее: 

1. Выберите инструмент Create Bezier (Создать кривую Безье). 

2. Щелкните в месте расположения первого маркера кривой Безье. 

3. Щелчками определите остальные маркеры кривой Безье, создав, тем са-

мым, ее контур (рис. 6.16). 

 

Рис. 6.16. Создание кривой Безье 

4. Если вы желаете создать замкнутую кривую Безье, последний из маркеров 

совместите с самым первым. 

5. Отредактируйте форму кривой Безье, перетаскивая ее линию обрамления, 
маркеры и управляющие линии маркеров инструментом Edit Bezier (Ре-

дактировать кривую Безье). 

6. При желании добавьте новые маркеры при помощи инструмента Bezier+ 

(Добавить маркер кривой Безье) или удалите существующие инструмен-
том Bezier– (Удалить маркер кривой Безье). 

7. Отформатируйте кривую Безье, отредактировав такие параметры, как за-
ливка (рис. 6.17), тень и т. п. (см. разд. 6.4). 

 

Рис. 6.17. Создание кривой Безье с заливкой 
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6.3.3. Ãðàôè÷åñêèå ïðèìèòèâû 

Окно Titler (Дизайнер титров) позволяет добавлять на полотно типовые гра-
фические примитивы, такие как прямоугольники, эллипсы, линии и т. п.  
В этом он мало чем отличается от традиционных графических редакторов, 
позволяющих создавать картинки из таких примитивов, подобно рисованию 
на листе бумаги. 

Для того чтобы добавить к титрам один из графических примитивов, следует 
сначала выбрать соответствующий инструмент, а затем нарисовать контуры 
этого примитива на полотне, используя протаскивание указателя при нажатой 
левой кнопке мыши. После того как кнопка мыши будет отпущена, объект 
будет вставлен в титры. 

В том случае если вы хотите создать объект симметричной формы (например, 
квадрат вместо прямоугольника, окружность вместо эллипса и т. п.), то в мо-
мент протаскивания указателя мыши через полотно вам следует удерживать 
на клавиатуре в нажатом состоянии клавишу <Shift>. В результате, масштаб 
объекта по вертикали и горизонтали будет принудительно выдерживаться 
одинаковым, даже если в процессе рисования вы создаете контур фигуры не-
правильной формы, и объект будет симметричным. 

Впоследствии можно будет переместить созданный объект в любое другое 
место полотна, а также изменить его размеры или повернуть. Кроме того, 
можно будет поменять стиль объекта, применив один из имеющихся в нали-
чии стилей на панели Styles (Стили), либо отформатировать объект вручную 
при помощи элементов управления на панели в правой части окна Titler (Ди-
зайнер титров). 

Для создания того или иного примитива, например, простого прямоуголь- 
ника: 

1. Выберите нужный инструмент, например, Rectangle (Прямоугольник). 

2. При помощи протаскивания указателя при нажатой кнопке мыши опреде-
лите на полотне желаемый контур графического примитива и отпустите 
кнопку мыши. 

В результате на полотне появится прямоугольник (рис. 6.18). 

 

Рис. 6.18. Создание прямоугольника 
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Titler (Дизайнер титров) позволяет менять тип созданных ранее объектов, 

сохраняя стиль их форматирования. К примеру, из прямоугольника с лег- 
костью можно сделать круг, из дуги — треугольник или фигуру Безье и т. д. 

6.4. Ôîðìàòèðîâàíèå ñòèëÿ îáúåêòîâ 

Форматирование объектов можно осуществлять двумя способами: 

� редактированием всех параметров объекта (таких как цвет обрамления, 

заливки, искажение и т. п.) вручную при помощи панели  Title Properties 
(Свойства титров); 

� заданием для объекта определенного предустановленного стиля при по-
мощи панели Titler Styles (Стиль титров). 

Если вы хотите применить сложное, зрелищное оформление объекта, то в 
первом случае вам потребуется немало потрудиться, разрабатывая его ориги-

нальный стиль от начала до конца, а во втором — настройка стиля произво-
дится в один щелчок мыши. 

6.4.1. Çàëèâêà 

Объекты в титрах могут быть как контурными, так и сплошными (иметь за-

ливку). Заливка может быть как простой (одноцветной), так и сложной (по-
лупрозрачной, градиентной, текстурной и т. д.). 

Ïðîñòàÿ çàëèâêà 

Чтобы создать заливку объекта: 

1. На панели Title Properties (Свойства титров) установите флажок Fill (За-

ливка) и раскройте список параметров заливки нажатием треугольной 
кнопки слева от этого флажка. 

2. Определите тип заливки, нажимая кнопку Fill Type (Тип заливки) и выби-
рая тип из раскрывшегося меню. В частности, тип Solid (Сплошная) соот-

ветствует простой одноцветной заливке (рис. 6.19). Кроме того, можно за-
дать градиентную или текстурную заливку, а также заливку с бликом 
(подсветкой). 

3. Выберите цвет заливки. Для этого можно либо щелкнуть на поле Color 

(Цвет), расположенном в корневом списке Fill (Заливка), и выбрать же-
лаемый цвет из палитры, либо воспользоваться пипеткой и выбрать цвет 
заливки из любого места полотна. 

4. При желании задайте полупрозрачную заливку, выбирая подходящее зна-

чение параметра Opacity (Непрозрачность) меньшее 100%. 
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Рис. 6.19. Создание простой заливки объекта 

Для того чтобы выключить заливку, достаточно просто снять флажок Fill 

(Заливка). После этого заливка объекта пропадет, но установки заливки будут 
сохранены, так что если вы повторно включите упомянутый флажок, то объ-
екту будет добавлена именно та заливка, которую вы редактировали ранее. 

6.4.2. Îáðàìëåíèå 

Подобно тому как заливка определяет содержимое внутренней части объекта, 

его внешние (и, возможно, внутренние) контуры определяются линиями об-
рамления. Обрамление, как и заливка, может задаваться и для текстовых объ-
ектов, и для графических примитивов, причем объект может иметь не одну, а 

несколько линий обрамления. 

Чтобы добавить к объекту линию обрамления (рис. 6.20): 

1. Раскройте список Strokes (Обрамление) нажатием соответствующей тре-
угольной кнопки на панели  Title Properties (Свойства титров). 

 

Рис. 6.20. Редактирование линии обрамления объекта 

2. Если вы хотите добавить линию обрамления с внешней части объекта, то 
щелкните на ссылке Add (Добавить) справа от подзаголовка Outer Strokes 
(Внешнее обрамление). Если же вам нужно добавить линию обрамления  
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с внутренней части объекта — щелкните на ссылке Add (Добавить) справа 

от подзаголовка Inner Strokes (Внутреннее обрамление). 

3. При желании добавьте дополнительные линии обрамления, повторяя дей-
ствия, описанные в п. 2. 

4. Отформатируйте добавленные линии обрамления, раскрывая соответст-
вующий список Outer Strokes (Внешнее обрамление) или Inner Strokes 
(Внутреннее обрамление) нажатием треугольной кнопки и выставляя же-
лаемые значения для параметров линий обрамления. При добавлении не-
скольких линий обрамления параметры для каждой из них придется уста-
навливать независимо от других (рис. 6.21). 

 

Рис. 6.21. Объект, имеющий несколько линий обрамления 

 

Линии обрамления являются, по сути, полноценными объектами титров. По-
этому для них предусмотрены те же параметры заливки, текстуры и бликов, что 
были рассмотрены ранее (см. разд. 6.4.1). 

В любой момент редактирования титров можно добавить дополнительные 
внутренние или внешние линии обрамления. Чтобы отключить созданную 
ранее линию обрамления объекта, достаточно снять соответствующий фла-
жок, который сопровождает список параметров данной линии обрамления 
(рис. 6.21). 

6.4.3. Ýôôåêò òåíè 

Один из типичных эффектов, повышающих зрелищность как графических, 
так и текстовых объектов, — это эффект характерной тени. Тень придает 
объектам иллюзию рельефности и трехмерности. 

Чтобы добавить выделенному объекту тень и настроить ее параметры 
(рис. 6.22): 

1. Установите на панели  Title Properties (Свойства титров)  флажок Shadow 
(Тень). 

2. Раскройте список параметров тени щелчком на треугольной кнопке слева 
от упомянутого флажка. 



Óðîê 6 190 

3. Выберите цвет тени в поле Color (Цвет), вызывая палитру цветов или ис-

пользуя пипетку. 

4. Установите степень прозрачности тени, выставляя желаемое значение 
Opacity (Непрозрачность). Как вы помните, сплошной тени соответствует 
значение этого параметра, равное 100%. 

5. Задайте угловое расположение тени относительно создающего ее объекта 

при помощи параметра Angle (Угол). Можно задать числовое значение уг-
ла в градусах в поле ввода или сделать то же самое визуально, раскрывая 
предусмотренный для этого элемент управления нажатием треугольной 

кнопки слева от надписи Angle (Угол). 

6. Определите расстояние, на котором должна находиться тень (от объекта), 

устанавливая желаемое значение параметра Distance (Расстояние). 

7. Установите размер самой тени, используя параметр Size (Размер). 

8. При желании сделайте тень размытой, выбирая подходящее значение па-

раметра Spread (Рассеивание). 

Чтобы впоследствии выключить созданную тень, достаточно снять флажок 
Shadow (Тень). Параметры тени при этом не будут потеряны, и при после-
дующем включении тени она возникнет в том же виде, в котором была соз- 

дана. 

 

Рис. 6.22. Регулировка эффекта тени 

6.4.4. Ñâîéñòâà òåêñòà 

Текстовые объекты отличаются от графических тем, что для них можно уста-
навливать форматирование шрифта, принятое в большинстве типичных тек-

стовых редакторов. Форматирование текста осуществляется на панели  Title 

Properties (Свойства титров) в списке Properties (Свойства). 

Перечислим параметры шрифта текстовых объектов и приведем основные 
рекомендации по их настройке (рис. 6.23). 
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Рис. 6.23. Свойства текстовых объектов 

� Font (Шрифт) — кнопка вызова меню, которое задает шрифт (или гарни-

туру). Чтобы изменить шрифт, достаточно выбрать соответствующий 

пункт меню. Как правило, помимо выбора самого шрифта, здесь же можно 

выбрать и его начертание — Normal (Обычное), Bold (Полужирное), Italic 

(Курсив) и т. д. Для этого достаточно навести указатель на пункт меню с 

желаемым шрифтом и выбрать тип его начертания в раскрывшемся под-

меню. Помните, что доступны только те типы начертания, которые име-

ются для данного шрифта; 

� Font Size (Размер шрифта) — параметр, задающий числовое значение раз-

мера символов (или кегля). Кегль определяет (в определенной пропорции, 

принятой для данной гарнитуры) как вертикальный, так и горизонтальный 

размеры символа; 

� Aspect (Масштаб) — параметр, задающий соотношение вертикального и 

горизонтального размеров шрифта. С его помощью можно сделать (для 

одного и того же кегля) символы более узкими или, наоборот, более ши-

рокими; 

� Leading (Межстрочное расстояние) — параметр, задающий интерлиньяж 

(межстрочное расстояние). Он имеет значение для многострочных титров; 
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� Kerning (Кернинг) — параметр, задающий межбуквенные интервалы в 

тексте (в частности, между определенными парами символов); 

� Tracking (Трекинг) — параметр, который определяет плотность текста; 

� Baseline Shift (Базовая линия) — параметр, задающий вертикальный сдвиг 

базовой линии (т. е. воображаемой линии ограничения снизу подавляюще-

го большинства символов). С его помощью можно сместить текст по вер-

тикали вверх или вниз. Оперируя данным параметром, можно установить 

фрагмент текста в позицию верхнего или нижнего индекса; 

� Slant (Наклон) — параметр, задающий угол наклона символов влево или 

вправо относительно вертикали; 

� Small Caps (Малые прописные) — флажок, задающий написание текста в 

стиле малых прописных букв; 

� Small Caps Size (Размер малых прописных) — параметр, определяющий 

относительный размер прописных букв (по сравнению с принятым кег-

лем); 

� Underline (Подчеркивание) — флажок, устанавливающий подчеркивание 

текста. 

При помощи описанных параметров можно отредактировать как текстовый 

объект целиком, выделяя его инструментом Selection (Выбор), так и изменить 

настройки некоторой части текста. Для этого следует выделить соответст-

вующий фрагмент, при помощи инструмента Type (Текст), и отрегулировать 

желаемые параметры. В последнем случае изменение параметров шрифта 

будет относиться только к выделенному фрагменту. 

6.5. Ïðåîáðàçîâàíèÿ îáúåêòîâ 

Этот раздел продолжает разговор о приемах редактирования объектов в 
Titler (Дизайнер титров). В нем пойдет речь о преобразованиях объекта тит-
ров как единого целого (перемещении объекта по полотну, масштабировании, 
поворотах и установке прозрачности объекта), а также о взаимном располо-
жении нескольких объектов. 

6.5.1. Ïðîçðà÷íîñòü 

Как вы помните, установить прозрачность можно и для заливки объекта (см. 
разд. 6.4.1), и для его тени (см. разд. 6.4.3). Кроме этого, в окне  Titler (Ди-
зайнер титров) предусмотрена опция настройки прозрачности для объекта 
целиком (т. е. одновременно для линий обрамления, заливки и тени). 
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Чтобы изменить прозрачность объекта как единого целого, следует на панели 

Title Properties (Свойства титров) определить желаемое значение параметра 
Opacity (Непрозрачность) в списке Transform (Преобразование). Напомина-

ем, что совершенно непрозрачному (сплошному) объекту соответствует па-
раметр непрозрачности, равный 100%. 

6.5.2. Ýôôåêò èñêàæåíèÿ 

Как для текстовых, так и для графических объектов можно использовать спе-

циальный эффект, определяющий их искажение вдоль горизонтали и/или 
вдоль вертикали. Чтобы настроить искажение объекта (рис. 6.24): 

1. Раскройте на панели  Title Properties (Свойства титров)  сначала список 
Properties (Свойства), а затем его внутренний список Distort (Искажение). 

Используйте для этого щелчки на соответствующих треугольных стрел-
ках. 

2. В раскрывшемся списке параметров искажений установите желаемое зна-
чение для искажения вдоль горизонтальной оси (параметр X) и вертикаль-

ной оси (параметр Y). Помните, что эти параметры могут принимать как 
положительные, так и отрицательные значения (что задает искажение по 
направлению оси или против него соответственно). 

 

Рис. 6.24. Настройка искажения 

6.5.3. Ïåðåìåùåíèå îáúåêòà ïî ïîëîòíó 

Изменять месторасположение объекта в титрах можно двумя способами — 
визуально, при помощи инструментов Selection (Выбор), и численно, задавая 
соответствующие значения координат объекта. Инструментом Selection (Вы-
бор) следует схватиться за объект и переместить его на новое место. 

Изменить расположение объекта можно и при помощи панели Transform 
(Преобразование). Для этого следует задать на ней значение параметров 
X Position (Координата X) и Y Position (Координата Y). Помните, что по ме-
ре изменения координат объекта (посредством перетаскивания линии под 
числовым значением этих параметров влево или вправо) объект будет син-
хронно смещаться по полотну (рис. 6.25). 
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Рис. 6.25. Настройка места расположения и размера объекта  
при помощи списка Transform 

6.5.4. Ìàñøòàáèðîâàíèå 

Изменение размеров объекта производится подобно его перемещению двумя 
способами. Для визуального изменения размера объекта: 

1. Выберите инструмент Selection (Выбор). 

2. Выделите объект. 

3. Наведите инструмент Selection (Выбор) на один из маркеров (эти маркеры 
также называют ручками) на его контурах. При наведении указателя на 
один из маркеров указатель меняет свой вид, что говорит о возможности 
масштабирования объекта. 

4. Перетащите маркер в новое место, определив тем самым новую границу 
объекта. После того как вы отпустите кнопку мыши, размеры объекта бу-
дут изменены соответствующим образом. 

Помимо визуального масштабирования объекта можно задать его геометри-
ческие размеры численно на панели Transform (Преобразование) при помо-
щи параметров Width (Ширина) и Height (Высота) (см. рис. 6.25). 

6.5.5. Ïîâîðîòû îáúåêòà 

Дизайнер титров позволяет с легкостью осуществить вращение любого объ-
екта. Чтобы повернуть объект: 

1. Сделайте объект активным. 

2. Наведите инструмент Rotation (Вращение) на объект (указатель при этом 
примет вид круговой стрелки) и поверните его, сместив указатель, при 
нажатой кнопке мыши, в нужном направлении (рис. 6.26). 

3. Продолжайте поворачивать объект, добиваясь желаемого угла поворота. 
Когда вы достигнете желаемого угла, отпустите кнопку мыши. 

Кроме описанного визуального вращения объекта можно задать на панели 
Transform (Преобразование) соответствующий параметр Rotation (Враще-
ние) (рис. 6.27). 
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Рис. 6.26. Вращение объекта инструментом Rotation 

 

Рис. 6.27. Настройка поворота объекта при помощи параметра Rotation 
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6.5.6. Âçàèìíîå ðàñïîëîæåíèå îáúåêòîâ 

При рисовании сложных структур в титрах некоторые объекты могут частич-
но или полностью перекрываться, наслаиваясь друг на друга. В частности, в 
титрах широко используется расположение текстовых подписей на полупро-
зрачных графических примитивах (например, различные прямоугольники  
и т. п.). Пользователь имеет возможность управлять порядком взаимного рас-
положения объектов при помощи контекстного меню или верхнего меню 
Title (Титры). При этом порядок расположения наслаивающихся объектов 
изменяется путем переноса одного из них вверх или вниз относительно дру-
гих объектов. 

Таким образом, чтобы изменить место объекта в цепочке наслаивающихся 
объектов: 

1. Выделите этот объект. 

2. В верхнем меню Title (Титры) или контекстном меню наведите указатель 
на пункт Arrange (Расположить). 

3. В раскрывшемся подменю выберите, согласно вашей задаче, одну из  
команд переноса объекта (рис. 6.28): 

• Bring to Front (На передний план) — перемещает выделенный объект 
на передний план, впереди всех остальных объектов; 

• Bring Forward (Перенести вперед) — перемещает выделенный объект 
на один шаг вперед; 

• Send to Back (На задний план) — отодвигает выделенный объект на 
задний план, позади остальных объектов; 

• Send Backward (Перенести назад) — отодвигает выделенный объект на 
один шаг назад. 

Для управления относительным расположением объектов на полотне имеется 
несколько команд в пункте Position (Позиция) верхнего Title (Титры) или 
контекстного меню: 

� Horizontal Center (Центрировать по горизонтали) — располагает не-
сколько выделенных объектов равномерно вдоль горизонтали; 

� Vertical Center (Центрировать по вертикали) — располагает несколько 
выделенных объектов равномерно вдоль вертикали; 

� Lower Third (Расположить в нижней трети) — помещает объект в ниж-
нюю треть экрана, что характерно для титров, демонстрирующихся на фо-
не кадра фильма. 

Наконец, при помощи панели Titler Actions (Действия титров) (рис. 6.29) до-

пускается осуществлять следующие операции над выделенной группой объ-
ектов: 
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� Align (Выравнивание); 

� Center (Центрирование); 

� Distribute (Распределение). 

 

Рис. 6.28. Выбор порядка взаимного расположения объектов 

 

Рис. 6.29. Действия над группой объектов в титрах осуществляются 
 при помощи панели Titler Actions 
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6.6. Áåãóùèå òèòðû 

Одна из замечательных особенностей Titler (Дизайнер титров) — это воз-
можность создания бегущих титров. Бегущими титрами называют текст, ко-

торый автоматически перемещается в заданном пользователем направлении 
по мере воспроизведения клипа. Последние кадры практически всех фильмов 

с перечислением их создателей — это и есть бегущие титры. 

Бегущие титры могут двигаться вертикально и горизонтально. Для создания 

бегущих титров выполните следующие действия: 

1. Нажмите в окне Titler (Дизайнер титров) кнопку Roll/Crawl Options (На-
стройка бегущих титров) (рис. 6.30). 

 

Рис. 6.30. Создание бегущих титров 
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2. В диалоговом окне Roll/Crawl Options (Настройка бегущих титров) выбе-

рите вместо элемента Still (Статические) нужный вам тип бегущих титров 
в выпадающем списке Title Type (Тип титров): Roll (Бегущие снизу вверх) 

или Crawl (Бегущие справа налево) (рис. 6.31). 

3. Выберите желаемое направление движения титров на панели Direction 

(Направление) в диалоговом окне Roll/Crawl Options (Настройка бегущих 
титров). 

4. Нажмите кнопку ОК. 

5. Просмотрите, как будут выглядеть бегущие титры в фильме, осуществив 
его предварительный просмотр в окнах Program (Программа) и Timeline 
(Монтаж). 

 

Рис. 6.31. Настройка бегущих титров 

Опция бегущих титров сказывается на тексте, который в этом случае может 
располагаться и за пределами кадра. Если выбран один из типов бегущих 

титров, то текст в них может размещаться далеко за пределами кадра. При 
этом по мере ввода текста полотно будет сопровождаться полосой прокрутки 

(вертикальной — если выбраны титры, бегущие снизу вверх, и горизонталь-
ной — если выбраны титры, бегущие справа налево). При вводе текста бегу-
щих титров ориентируйтесь на полосы прокрутки. Для того чтобы бегущие 

титры перемещались по мере воспроизведения клипа, их текст должен нахо-
диться за пределами видимой области полотна. 

 

Настроить дополнительные параметры бегущих титров, такие как ускорение и 
замедление их движения, можно на панели Timing (Опции времени) диалогово-
го окна Roll/Crawl Options (Настройка бегущих титров). 
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Âûâîä ôèëüìà 

 

Последний урок посвящен завершающему этапу работы с проектом в 
Premiere — созданию финальной версии фильма. Фильм может экспортиро-
ваться в соответствующий медиафайл, записываться на диск DVD или, с по-
мощью специальной аппаратуры, переноситься на внешнее устройство, на-
пример, видеомагнитофон. 

� Чего мы хотим: 

• научиться экспортировать фильм в файл или на внешнее устройство, 
подключенное к компьютеру; 

• освоить приемы подготовки DVD-дисков (DVD-авторинга). 

� Нам потребуется: 

• любой смонтированный фильм. 

� Что полезно вспомнить: 

• информацию об установках проекта (см. урок 2). 

7.1. Ýêñïîðò â ôàéë 

Фильм, который вы редактируете в Premiere, не существует на компьютере в 
форме видеофайла до тех пор, пока не будет осуществлен его экспорт. В за-
висимости от типа файла различается экспорт, приводящий к различным ре-
зультатам: 

� Movie (Фильм) — экспорт в анимационный файл видео и/или звука; 

� Audio (Аудио) — экспорт звука в аудиофайл; 

� Frame (Кадр) — экспорт статического изображения (одного кадра) в гра-

фический файл; 

 



Óðîê 7 202 

� Images Sequence (Последовательность рисунков) — экспорт видео, как 

последовательности статических изображений. 

Экспортировать в файл можно: 

� фильм, т. е. содержимое определенной закладки окна Timeline (Монтаж); 

� исходный клип. 

 

Последний вариант экспорта нужен, если вы желаете, например, создать файл 

из фрагмента клипа, экспортировать клип с другими установками (в частности, 

для создания черновика), получить аудиофайл из звукового анимационного 
клипа, экспортировать в виде графического файла стоп-кадр клипа и т. п. 

7.1.1. Ôîðìàòû ôàéëîâ 

Premiere позволяет экспортировать результаты вашей работы в файлы сле-

дующих типов: 

� форматы видеофильма — AVI и DV AVI, Animated GIF, MPEG, 

RealMedia, QuickTime (MOV), Windows Media; 

� фильм в виде последовательности графических файлов — GIF, Targa, TIFF 

или Windows Bitmap (BMP); 

� звуковые форматы — AVI и DV AVI, MPEG, RealMedia, QuickTime 

(MOV), Windows Audio Waveform (WAV); 

� форматы статической графики — Filmstrip, FLC/FLI, Targa, TIFF, Windows 

Bitmap (BMP). 

7.1.2. Ýêñïîðò âèäåîôèëüìà 

Для того чтобы экспортировать весь фильм, смонтированный в окне Timeline 

(Монтаж), или его часть, выделенную полосой выбора рабочей области в ок-

не Timeline (Монтаж):  

1. Выделите желаемый фильм в окне Project (Проект) или Timeline (Мон-

таж). 

2. Выберите в верхнем меню команду File>Export>Movie (Файл>Экспорт> 

Фильм) (рис. 7.1). 

3. В открывшемся диалоговом окне Export Movie (Экспорт фильма) опреде-

лите местонахождение файла и его имя (рис. 7.2). 

4. Обратите внимание на основные установки файла, приведенные на панели 

Summary (Сводка) в нижней части диалогового окна, и, при необходимо-
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сти, откорректируйте их, нажав для этого кнопку Settings (Установки) и 

внеся соответствующие изменения в открывшемся диалоговом окне 

Export Movie Settings (Установки экспорта фильма). 

 

Рис. 7.1. Начало экспорта фильма 

 

Premiere запоминает те установки, с которыми вы экспортировали предыдущий 

фильм, и предлагает их по умолчанию в качестве установок для экспорта ново-

го файла. Если вы экспортируете файл впервые или забыли о прошлых уста-
новках экспорта, обязательно просмотрите их все, нажав кнопку Settings (Уста-
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новки) и внимательно разбирая все страницы в диалоговом окне Export Movie 

Settings (Установки экспорта фильма). В частности, обратите особое внимание 

на поля File Type (Тип файла) и Range (Диапазон) на странице General (Об-

щие) (рис. 7.3). Диапазон Entire Project (Весь проект) задает опцию экспорта 

целого фильма, In to Out (От начала до конца) — его рабочего фрагмента (от 

входного до выходного маркера), а Work Area Bar (Рабочая область) — его 

части, отмеченной полосой выбора рабочей области в окне Timeline (Монтаж). 

Флажок Export Video (Экспорт видео) задает опцию экспорта видеоряда филь-

ма, а флажок Export Audio (Экспорт аудио) — экспорт звукового ряда. Установ-

ки на остальных страницах окна Export Movie Settings (Установки экспорта 

фильма) мало отличаются от установок проекта (см. разд. 2.1.3). 

 

 Рис. 7.2. Определение имени экспортируемого файла 

5. Нажмите кнопку Сохранить. 

6. Наблюдая за индикатором выполнения, дождитесь, пока экспорт закон-

чится и экспортированный файл откроется в окне Project (Проект) 

(рис. 7.4). При желании вы можете его просмотреть в окне Source (Источ-

ник) или использовать при монтаже других фильмов. 
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Рис. 7.3. Установки экспортируемого фильма определяются  
в диалоговом окне Export Movie Settings 

 

Рис. 7.4. По завершении экспорта файл открывается в окне Project 
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7.1.3. Ýêñïîðò àóäèîôàéëà 

Для того чтобы экспортировать в аудиофайл только звук фильма из окна 
Timeline (Монтаж), выполните следующее: 

1. Выделите фильм и выберите в верхнем меню команду File>Export>Audio 
(Файл>Экспорт>Аудио). 

2. В открывшемся диалоговом окне Export Audio (Экспорт аудио) определи-
те местонахождение файла и его имя (рис. 7.5). 

3. Обратите внимание на основные установки и, при необходимости, на-
пример, для изменения формата файла, откорректируйте их после нажатия 
кнопки Settings (Установки). 

4. Нажмите кнопку Сохранить. 

После некоторого времени выполнения расчетов файл будет экспортирован. 

 

При экспорте звука доступны только аудиоустановки экспорта. 

 

Рис. 7.5. Экспорт звука 
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7.1.4. Ýêñïîðò êàäðà 

Для того чтобы экспортировать статическое изображение отдельного кадра 
фильма в графический файл: 

1. Выделите нужный кадр линией редактирования в окне Timeline (Монтаж). 

2. Выберите в верхнем меню команду File>Export>Frame (Файл>Экспорт> 
Кадр). 

3. В открывшемся диалоговом окне Export Still Frame (Экспорт кадра) оп-
ределите местонахождение файла и его имя. 

4. Обратите внимание на основные установки и, при необходимости, откор-
ректируйте их после нажатия кнопки Settings (Установки). 

5. Нажмите кнопку Сохранить. 

После некоторого времени выполнения расчетов файл будет экспортирован и 
добавлен в проект (рис. 7.6). 

 

Рис. 7.6. Статический клип с экспортированным кадром фильма 

7.1.5. Ýêñïîðò ïîñëåäîâàòåëüíîñòè êàäðîâ 

Анимацию можно экспортировать в виде последовательности статических 
кадров. В этом случае каждый кадр фильма становится независимым графи-
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ческим файлом с именем, содержащим порядковый номер кадра. Для экспор-

та последовательности кадров: 

1. Выделите нужный фильм и введите команду File>Export>Movie (Файл> 
Экспорт>Фильм). 

2. В открывшемся диалоговом окне Export Movie (Экспорт фильма) нажми-
те кнопку Settings (Установки) (см. рис. 7.2). 

3. В диалоговом окне Export Movie Settings (Установки экспорта фильма) 
выберите, в раскрывающемся списке File Type (Тип файла), формат гра-

фических файлов (рис. 7.7), например — GIF. 

 

Рис. 7.7. Окно Export Movie Settings в случае экспорта последовательности кадров 

4. При необходимости откорректируйте прочие установки экспорта. 

5. В диалоговом окне Export Movie Settings (Установки экспорта фильма) 
нажмите кнопку ОК. 

6. В диалоговом окне Export Movie (Экспорт фильма) определите имя и ме-

стонахождение экспортируемого файла. 

7. Нажмите кнопку Save (Сохранить). 

Через некоторое время, необходимое для экспорта, последовательность гра-
фических файлов будет создана в выбранном вами месте на диске компьюте-

ра (рис. 7.8). 
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Рис. 7.8. Файлы последовательности кадров в окне Проводника ОС Windows 

7.1.6. Ýêñïîðò êëèïà 

Помимо возможности экспорта фильма из окна Timeline (Монтаж), допуска-
ется экспортировать и отдельный клип, выделенный в окне Project (Проект) 
или окне Source (Источник). Возможны те же самые опции экспорта, т. е. 
экспорт видео, звука или статического кадра, причем установки экспорта вы-
бираются аналогичным образом. Последовательность действий при экспорте 
клипа примерно та же самая, что и при экспорте фильма. 

Для экспорта клипа: 

1. Выделите клип в окне Project (Проект). 

2. При необходимости выделите рабочий фрагмент клипа входным и выход-
ным маркерами. 

3. Выберите в верхнем меню команду File>Export (Файл>Экспорт). 
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4. В появившемся подменю выберите тип экспорта: 

• Movie (Фильм) — экспорт в анимационный файл или в последователь-

ность графических файлов; 

• Audio (Аудио) — экспорт звука в аудиофайл; 

• Frame (Кадр) — экспорт текущего кадра клипа в графический файл. 

5. В соответствующем диалоговом окне экспорта определите имя и местона-

хождение экспортируемого файла. 

6. При необходимости поменяйте установки экспорта с помощью кнопки 

Settings (Установки). 

7. Нажмите кнопку Save (Сохранить). 

После некоторого времени, необходимого для компиляции, файл с экспорти-

рованным клипом будет создан. 

7.2. Ýêñïîðò äëÿ Èíòåðíåòà è ìóëüòèìåäèà 

Рассмотрим особенности экспорта фильма в файлы для последующего раз-

мещения в сети Интернет или проигрывания на компьютере. Отметим, что 

если вы готовите фильмы для таких целей, то можно воспользоваться опи-

санной выше, в разд. 7.1, последовательностью действий. Следует лишь 

иметь в виду, что для этих целей желательно выбирать определенные форма-

ты файлов и следить за их физическим размером, поскольку некоторые поль-

зователи Интернета до сих пор используют медленную модемную связь. Те 

же замечания касаются и мультимедийных файлов, размещаемых на компакт-

дисках, поскольку устаревшие устройства для их чтения не всегда могут 

обеспечить совместимость форматов и необходимую скорость чтения дан-

ных. 

Если вы готовите медиафайлы для использования в Интернете или мульти-

медийных презентациях, то, чтобы оптимизировать подготовку файлов,  

в Premiere имеется специальный программный модуль, называемый Adobe 

Media Encoder (Кодировщик медиа). Коротко расскажем, как им пользо- 

ваться: 

1. Выделите фильм, который собираетесь экспортировать. 

2. Выберите в верхнем меню команду меню File>Export>Adobe Media 

Encoder (Файл>Экспорт>Кодировщик медиа) (рис. 7.9). 

3. В появившемся диалоговом окне Export Settings (Установки экспорта) 

определите параметры экспорта. Во-первых, задайте формат файла в рас-
крывающемся списке Format (Формат), например — Windows Media.  
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Во-вторых, выберите область экспорта (весь фильм или рабочая область) 

в раскрывающемся списке Range (Диапазон). В-третьих, в раскрываю-
щемся списке Preset (Предустановка) определите желаемую предустанов-

ку параметров, ориентируясь на цель вашей работы (например, экспорт 
для Интернета с определенной скоростью доступа). В-четвертых, щелкая 
на заголовках установок в списке в левой нижней части окна, просмотрите 

и, при желании, откорректируйте конкретные установки, присутствующие 
в данном диалоге. 

 

Рис. 7.9. Специальный экспорт файла для Интернета и мультимедиа 

 

Экспорт в файлы некоторых форматов (например, Windows Media Audio и Win-

dows Media Video) возможен только при помощи модуля Adobe Media Encoder 
(Кодировщик медиа). 

При желании определите фрагмент изображения фильма, экспорт которо-

го будет осуществлен в файл. Для этого перейдите к закладке Source (Ис-
точник) в левой половине окна Export Settings (Установки экспорта), на-
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жмите кнопку Crop (Вырезать) в левом верхнем углу окна и выделите 

фрагмент кадра, экспорт которого вы хотите задать (рис. 7.10). 

4. Нажмите в диалоговом окне Export Settings (Установки экспорта) кноп-

ку ОК. 

5. В открывшемся диалоговом окне Save File (Сохранить файл) определите 
имя и местонахождение файла и нажмите кнопку Save (Сохранить). 

В результате модуль Adobe Media Encoder сам подберет наиболее опти-
мальные установки экспорта и создаст файл с фильмом. Просмотреть этот 

файл можно, открывая его в Premiere в универсальном проигрывателе ОС 
Windows или любом другом проигрывателе, поддерживающем данный фор-
мат. 

 

Рис. 7.10. Для выделения фрагмента изображения фильма для экспорта  
нажмите кнопку Crop 

7.3. Ýêñïîðò  
íà âíåøíåå óñòðîéñòâî 

Помимо экспорта в файл и на DVD, довольно широко применяется еще один 
вид финального представления фильма, связанный с передачей видеосигнала 

на внешнее устройство. Им может быть видеомагнитофон, внешний телеви-
зионный монитор, видеокамера, монтажный комплекс и т. п. Почти всегда 
экспорт на внешнее устройство — это либо просмотр фильма на телевизион-

ном мониторе, либо запись его на видеопленку. Разумеется, для осуществле-
ния такого типа экспорта вам следует иметь специальное оборудование, над-

лежащим образом установленное на вашем компьютере, с соответствующим 
инсталлированным программным обеспечением. 

Внешнее устройство может быть либо цифровым, либо аналоговым. Как пра-
вило, современные профессиональные устройства, подключаемые к компью-

теру, имеют (возможно, вдобавок к другим интерфейсам) цифровой вход 
стандарта IEEE 1394. Поэтому рассмотрим в первую очередь экспорт видео-
сигнала с компьютера на внешнее цифровое устройство с использованием 

этого порта.  
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7.3.1. Ýêñïîðò íà öèôðîâîå óñòðîéñòâî 

Для подготовки к экспорту видеосигнала на внешнее цифровое устройство 

следует выполнить следующую последовательность действий: 

1. Подключите цифровое видеоустройство (магнитофон, монитор или каме-
ру) к компьютеру через порт IEEE 1394. На устройстве нужное соедине-

ние, скорее всего, помечено маркировкой DV IN/OUT или IEEE 1394. 

2. Включите цифровое видеоустройство. 

3. Запустите Premiere. 

4. Выберите в верхнем меню команду Project>Project Settings>General 
(Проект>Установки проекта>Общие). 

5. В открывшемся диалоговом окне Project Settings (Установки проекта), на 

странице с общими установками, убедитесь в том, что в раскрывающемся 
списке Editing Mode (Режим редактирования) выбран элемент DV Play-

back (Воспроизведение на цифровом видео). Если текущим является дру-
гой режим, то вам придется закрыть текущий проект, а затем создать но-

вый с установками типа DV и импортировать в него первоначальный про-
ект (рис. 7.11). 

 

Рис. 7.11. Определение установок проекта для передачи сигнала на внешнее устройство 

6. В диалоговом окне Project Settings (Установки проекта) нажмите кнопку 
Playback Settings (Установки воспроизведения). 

7. В открывшемся диалоговом окне Playback Settings (Опции внешнего вос-
произведения) (рис. 7.12) установите желаемые параметры воспроизведе-

ния видеосигнала на внешнем устройстве (см. разд. 7.3.2). 

8. Закройте, последовательно, диалоговые окна Playback Settings (Опции 
внешнего воспроизведения) и Project Settings (Установки проекта) нажа-
тием кнопок ОК. 

9. Наблюдайте, как на внешнем устройстве демонстрируется изображение 
кадра фильма, поступающее с компьютера. 
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Рис. 7.12. Диалоговое окно Playback Settings 

После того как вы убедитесь в нормальной передаче видеосигнала на внеш-

нее устройство, можно начать на нем процесс записи. 

7.3.2. Ïàðàìåòðû âçàèìîäåéñòâèÿ  
ñ âíåøíèì óñòðîéñòâîì 

Для оптимизации работы в Premiere и одновременного экспорта видеосигнала 
на внешнее устройство (как цифровое, так и аналоговое) имеется ряд пара-

метров, настраиваемых в общих установках проекта. 

Для редактирования установок взаимодействия компьютера с внешним уст-
ройством: 

1. Выберите команду Project>Project Settings>General (Проект>Установки 
проекта>Общие) и нажмите в появившемся диалоговом окне кнопку 
Playback Settings (Установки воспроизведения). 

2. В открывшемся диалоговом окне  Playback Settings (Опции внешнего 

воспроизведения) (см. рис. 7.12) установите флажок Desktop Video (Вос-
производить видео с компьютера), чтобы иметь возможность осуществ-
лять передачу видеосигнала с компьютера на внешнее устройство. Соот-

ветственно, можно будет просматривать видео на его мониторе (например, 
мониторе видеокамеры). 

 

Помните о том, что при использовании различных воспроизводящих устройств 
для видео- и аудиосигнала может произойти рассинхронизация изображения и 
звука. 
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3. Задайте опцию воспроизведения звука при помощи пары переключателей. 
Выберите переключатель Desktop Audio ( Воспроизводить звук на ком-
пьютере) в том случае, чтобы звук смонтированного в Premiere фильма 
воспроизводился только на компьютере. Если вы хотите, чтобы звук вос-
производился на внешнем устройстве, то установите переключатель 
External Device Audio (Воспроизводить звук на  внешнем устройстве). 

4. При помощи раскрывающегося списка External Device (Внешнее устрой-
ство) в группе Real-Time Playback (Воспроизведение в режиме реального 
времени) выберите формат видео, который будет применяться при вос-
произведении фильма в процессе его редактирования. 

5. Задайте формат видео, который будет применяться в экспорте, путем вы-
бора элемента раскрывающегося списка External Device (Внешнее уст-
ройство) в группе Export (Экспорт). Этот параметр имеет то же название 
и тот же смысл, что и предыдущий, но касается не воспроизведения филь-
ма, а непосредственно процесса экспорта на видеопленку. 

6. При помощи раскрывающегося списка Aspect Ratio Conversion (Преобра-
зование пропорций пиксела) определите желаемую опцию изменения про-
порций пиксела изображения, в зависимости от стандарта применяемого 
внешнего устройства. 

7.3.3. Ýêñïîðò âèäåî íà âèäåîïëåíêó 

Перед тем как начать экспорт видео на внешнее аналоговое устройство (на-
пример, запись смонтированного фильма на видеомагнитофон), необходимо 
проверить и откорректировать соответствующие установки проекта (см. 
разд. 2.1.3). Помните, что именно установки проекта влияют на качество ви-
део- и аудиосигнала, поступающих с компьютера на внешнее устройство. 

Экспорт фильма на внешнее устройство может осуществляться в двух разных 
вариантах (в зависимости от типа устройства): 

� активном, т. е. с применением аппаратного контроля; 

� пассивном, т. е. без аппаратного контроля. 

 

Для того чтобы повысить качество экспорта на внешнее устройство, в ряде слу-
чаев бывает полезным вставить в начало фильма служебный клип Bars and 
Tone (Настроечная таблица) длительностью порядка 30 секунд, который помо-
жет осуществить предварительную калибровку устройства. 

Для начала экспорта с применением аппаратного контроля выберите в верх-
нем меню команду File>Export>Export to Tape (Файл>Экспорт>Экспорт на 
пленку) и затем, в появившемся диалоговом окне, нажмите кнопку Activate 

Recording Device (Активировать записывающее устройство). Далее, осуще-
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ствляя управление внешним устройством из Premiere, произведите экспорт 
фильма. 

Если внешнее устройство не поддерживает функции аппаратного контроля, 
то просто запустите обычный предварительный просмотр фильма в Premiere 
(например, клавишей <Enter>) и наблюдайте на мониторе внешнего устрой-
ства, как кадр фильма одновременно демонстрируется и на нем. Затем следу-
ет включить режим записи на внешнем устройстве, пользуясь его элементами 
управления. Разумеется, если ваш фильм содержит спецэффекты и сложный 
монтаж, то, скорее всего, потребуется создание файла предварительного про-
смотра. 

 

Как видите, экспорт на внешнее устройство отличается от экспорта в файл тем, 
что параметры передачи сигнала регулируются в установках проекта, а не в ус-
тановках экспорта. 

Помимо экспорта финального видео на внешнее устройство, вы можете ис-
пользовать его и в процессе монтажа, ориентируясь не только на изображе-
ние кадра в окне Program (Программа), но и на изображение кадра фильма 
на внешнем устройстве, сразу оценивая, таким образом, как будет выглядеть 
ваш фильм в окончательном варианте. 

7.4. Ýêñïîðò íà DVD 

Смонтированный фильм может быть с легкостью записан на диск DVD при 
помощи встроенных средств Premiere. Для того чтобы иметь такую возмож-
ность экспорта, ваш компьютер должен быть оснащен соответствующим уст-
ройством записи DVD (приводом DVD+/-RW). 

Верстку дисков стандарта DVD принято называть DVD-авторингом. Подго-
товка DVD-дисков основана на соответствующей разметке видеофильма и 
добавлении в него интерактивных заставок, называемых меню (menu). Ме-
ню — это особый вид титров, служащий целям навигации по диску DVD и 
совершенно незаменимый, если вы собираетесь оформлять видео в этом 
формате (для последующего просмотра на соответствующих DVD-проигры-
вателях). 

Программа Premiere, начиная с версии Pro 2.0, обладает специальными сред-
ствами, позволяющими размечать маркерами смонтированный видеофильм, 
что позволяет получить полноценный DVD-диск. DVD-авторинг в Premiere 
предполагает выполнение следующих шагов: 

1. Разметка фильма маркерами главного меню и маркерам сцен; 

2. Добавление маркеров останова и возврата; 



Âûâîä ôèëüìà 217 

3. Выбор шаблона меню; 

4. Редактирование меню (в том числе графики, текста, кнопок и т. д.); 

5. Тестирование DVD-разметки; 

6. Запись размеченного фильма на диск DVD. 

7.4.1. Ðàçìåòêà ðàçäåëîâ äèñêà ìàðêåðàìè 

В Premiere существует несколько типов DVD-маркеров. 

� Маркеры главного меню (main menu markers) используются, наряду с мар-

керами останова (stop markers), для разбиения фильма на независимые 
фрагменты (в нашем примере, это Фильмы 1, 2 и 3). Кнопки на главном 

меню, соответственно, переводят фильм на эти маркеры главного меню. 
Эти маркеры имеют зеленый цвет. 

� Маркеры сцен (scene markers) используются для разбиения каждого из 

фильмов на разделы. Они имеют синий цвет. 

� Маркеры останова (stop markers) переводят фильм к главному меню и по-
этому должны размещаться в конце каждого фильма. Эти маркеры имеют 

красный цвет. 

 

Помните о том, что маркеры останова всегда возвращают зрителя именно к 
главному меню, а не к текущему субменю. 

Для изучения особенностей DVD-авторинга сначала выполним подготови-
тельные действия, а именно создадим новый проект и скомпонуем из не-
скольких сцен модельный фильм, чтобы затем на его примере показать, как 

осуществляется DVD-разметка. 

Имейте в виду, что при подготовке фильма для просмотра на DVD-про-
игрывателях желательно изначально готовить его в формате, совместимом с 
большинством таких устройств. По возможности, используйте следующие 

установки проекта: 

� Размер кадра стандарта NTSC (720×480) или PAL (720×576) с отношением 
4:3 или 16:9 (широкоэкранное видео) 

� Частота кадров 29.97 (NTSC) или 25 кадров в сек. (PAL). 

� Параметры аудио – глубина кодировки 16 бит и частота дискретизации 

48 кГц. 

Результат подготовительных действий показан на рис. 7.13. Мы имеем 

фильм, состоящий из нескольких клипов. Самым простым вариантом будет 
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разбиение фильма на главы в местах стыков отдельных клипов на треке 

Video 1 (Видео 1), которое можно произвести в автоматическом режиме, вос-
пользовавшись соответствующей опцией Premiere. Другой вариант — это 

разметка вручную, когда желаемое начало каждой новой сцены пользователь 
помечает DVD-маркером. 

 

Рис. 7.13. Неразмеченный фильм содержит несколько видеоклипов 

Добавить новый раздел DVD-диска можно следующим образом. 

1. Установите линию редактирования на кадр фильма, который вы собирае-
тесь сделать первым кадром нового раздела. 

2. Нажмите в окне Timeline (Монтаж) кнопку Set DVD Marker (Установить 
DVD-маркер) (рис. 7.13). 

3. В диалоговом окне DVD Marker (DVD-маркер) (рис. 7.14) введите в поле 

Name (Название) название маркера (по возможности, коротко, помня  
о том, что оно появится в меню диска и должно будет соседствовать с дру-
гими названиями). 

 

Не обязательно определять сразу название маркера в окне DVD Marker (DVD-

маркер). В этом случае в меню диска будут вставлены символические названия 
разделов, пронумерованные по порядку, например, Scene 1 (Сцена 1), Scene 2  

(Сцена 2) и т. д. Отредактировать названия разделов можно будет и впоследст-
вии, при работе с меню. 

4. В списке Marker Type (Тип маркера) выберите желаемый тип маркера: 

главного меню, сцены или останова. 

5. По желанию выберите кадр фильма, который будет вставлен в меню, при 

помощи активной надписи Thumbnail Offset (Сдвиг тайм-кода миниа- 
тюры). 
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Рис. 7.14. Для разметки нового раздела диска  
определите параметры DVD-маркера 

6. Если вы хотите настроить анимацию кадра, который будет добавлен в ме-

ню, то установите флажок Motion Menu Button (Кнопка анимационного 

меню). 

7. Нажмите кнопку OK. 

В результате DVD-маркер будет добавлен на шкалу времени окна Timeline 

(Монтаж). После создания первого DVD-маркера в середине фильма допол-

нительный DVD-маркер в его начале будет добавлен автоматически (рис. 7.15). 

Повторимся, что маркеры главного меню имеют синий цвет, а маркеры 

сцен — зеленый. 

Установить маркер на текущий кадр фильма можно и при помощи меню. 

1. Установите линию редактирования на кадр фильма, который станет пер-

вым кадром нового раздела. 

2. Вызовите из области шкалы времени окна Timeline (Монтаж) контекстное 

меню или раскройте верхнее меню Marker (Маркер). 

3. Наведите указатель мыши на пункт меню Set DVD Marker (Установить 

DVD-маркер) и в подменю выберите тип маркера (рис. 7.16). 



Óðîê 7 220 

 

Рис. 7.15. Результат создания DVD-маркера 

 

Рис. 7.16. Создание DVD-маркера при помощи меню 

4. Определите настройки маркера в открывшемся диалоговом окне DVD 

Marker (DVD-маркер) (см. рис. 7.14). В результате на шкале времени в 

позиции текущего кадра появится маркер нового раздела фильма. 

5. Аналогичным образом добавьте остальные DVD-маркеры. 

Для того чтобы передвинуть ссылку на раздел в фильме, достаточно просто 

перетащить соответствующий DVD-маркер вдоль линейки времени в окне 

Timeline (Монтаж) (рис. 7.17). 

В остальном редактирование DVD-маркеров осуществляется теми же спосо-

бами, что и редактирование обычных маркеров (см. урок 4). Отметим, что 

при работе с DVD-маркерами удобно использовать контекстное меню, кото-

рое следует вызывать из области шкалы времени окна Timeline (Монтаж).  
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Рис. 7.17. Изменение положения DVD-маркера осуществляется  
его перетаскиванием по шкале времени 

В частности, используйте следующие команды меню (рис. 7.18): 

� Go to DVD Marker (Перейти к DVD-маркеру)  — для навигации по мар-

керам вдоль фильма; 

� Set DVD Marker (Перейти к DVD-маркеру)  — помечает позицию теку-

щего кадра  DVD-маркером; 

� Clear DVD Marker (Удалить DVD-маркер)  — удаляет DVD-маркер, на-

ходящийся в позиции линии редактирования; 

� Clear All DVD Markers (Удалить все DVD-маркеры)  — удаляет все 

DVD-маркеры из фильма. 

 

Рис. 7.18. Для расстановки, навигации и удаления DVD-маркеров  

удобно использовать контекстное меню 

Отметим также, что двойной щелчок на DVD-маркере на шкале времени в 

окне Timeline (Монтаж) приводит к загрузке диалогового окна DVD Marker 

(DVD-маркер), в котором можно изменить атрибуты текущего DVD-маркера 

(см. рис. 7.14). 

7.4.2. Àâòîìàòè÷åñêàÿ ðàçìåòêà äèñêà  
íà ðàçäåëû 

Разметка разделов диска может осуществляться как вручную, так и автомати-

чески. Предусмотрены следующие варианты разбиения фильма на разделы: 

� At Each Scene (В начале каждой сцены) — DVD-маркеры устанавливают-

ся на каждый стык клипов, находящихся на треке Video 1 (Видео 1); 



Óðîê 7 222 

� Every _ Minutes (Каждые _ минут) — DVD-маркеры устанавливаются с 
определенной периодичностью, которая выбирается пользователем; 

� Total Markers (Всего _ маркеров) — выбранное пользователем количест-
во DVD-маркеров устанавливается равномерно вдоль фильма. 

Для того чтобы задать  положение DVD-маркеров в автоматическом режиме, 
выполните следующее: 

1. Сделайте активным окно Timeline (Монтаж). 

2. Выберите в верхнем меню Marker>Auto-Generate DVD Markers (Мар-
кер>Автоматическое создание DVD-маркеров). 

3. В открывшемся диалоговом окне Automatically Set DVD Scene Markers 
(Автоматическая установка DVD-маркеров) выберите желаемую опцию 
расстановки DVD-маркеров (рис. 7.19). Если вы выбрали равномерную ус-
тановку маркеров через определенные промежутки времени, или по об-
щему числу маркеров вдоль фильма, то введите в соответствующее поле 
числового ввода либо временной интервал, либо общее число маркеров. 

 

Рис. 7.19. Автоматическая генерация DVD-маркеров 

4. Если фильм уже содержит DVD-маркеры, и вы хотите их удалить, то ус-
тановите флажок проверки Clear Existing DVD Markers (Удалить суще-

ствующие DVD-маркеры). 

5. Нажмите кнопку OK. 

В результате необходимое число маркеров будет добавлено в фильм (рис. 7.20 

и 7.21). 

 

Рис. 7.20. Результат автоматического создания DVD-маркеров на стыках клипов 
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Рис. 7.21. Результат автоматического равномерного создания пяти DVD-маркеров 

7.4.3. Íàñòðîéêà ìåíþ äèñêà 

Меню, как уже было сказано, является элементом фильма, который содержит 
интерактивные элементы (кнопки). Назначение кнопок заключается в воз-
можности их нажатия при просмотре фильма, которое приводит к началу 
воспроизведения фильма с определенного места, ассоциированного с нажа-
той кнопкой. Диск DVD может иметь не только одно, но и несколько меню. 
Меню, которое размещается в начале фильма, называется главным. Осталь-
ные меню — второстепенные, называемые меню сцен. Как только при вос-
произведении диска действие фильма доходит до очередного маркера оста-
нова (он имеет на шкале времени в окне Timeline (Монтаж) красный цвет), 
действие приостанавливается и переходит к соответствующему меню сцены, 
которое демонстрируется до тех пор, пока пользователь не предпримет в нем 
каких-либо действий. 

В предыдущем разделе были рассмотрены основные приемы разметки филь-
ма на разделы, сводящиеся к настройке положения DVD-маркеров. После 
того как разметка произведена, можно переходить к редактированию меню, 
которое будет содержать перечень кнопок, являющихся ссылками на разделы 
диска. 

 

Если вы все еще не очень ясно представляете назначение меню и принцип ра-
боты с ним (в режиме просмотра уже сверстанного диска), обратитесь  
к разд. 7.4.4, в котором описывается имитация работы с дисками DVD в Premiere. 

Для создания самого меню следует действовать следующим образом. 

1. Выберите в верхнем меню Window>DVD Layout (Окно>Разметка DVD). 

2. Если ваш проект содержит  несколько фильмов, то убедитесь в том, что в 
закладке окна DVD Layout (Разметка DVD) демонстрируется название 
нужного фильма. 

3. Просмотрите по очереди имеющиеся меню диска при помощи списка в 
нижней части окна DVD Layout (Разметка DVD) (рис. 7.22) и, при необ-
ходимости, отредактируйте каждое из меню. 

4. При необходимости отредактируйте ссылки на разделы, имеющиеся в ме-
ню. Для этого достаточно дважды щелкнуть на ссылке и изменить атрибу-
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ты раздела DVD-диска в открывшемся диалоговом окне DVD Marker 

(DVD-маркер) (рис. 7.23). В частности, можно поменять текст ссылки (ре-
зультат этой операции приведен на рис. 7.24). 

 

Рис. 7.22. Главное меню диска в окне DVD Layout 

5. Если вы хотите удалить какую-либо ссылку на раздел, двойным щелчком 
мыши в окне DVD Layout (Разметка DVD) перейдите к окну DVD Marker 

(DVD-маркер) и нажмите в нем кнопку Delete (Удалить). 

6. Таким же образом отредактируйте прочие пункты меню (не связанные  
с DVD-маркерами): дважды щелкните на нужном слове и затем изме- 
ните его в открывшемся диалоговом окне Change Text (Изменить текст) 

(рис. 7.25). 
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Рис. 7.23. Отредактируйте ссылки на сцены в окне DVD Marker 

 

Рис. 7.24. Меню диска с отредактированными ссылками на сцены в окне DVD Layout 
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Рис. 7.25. Отредактируйте текст ссылок во всех меню 

7. При желании смените дизайн меню. Для этого нажмите в окне DVD Layout 
(Разметка DVD) кнопку Change Template (Изменить шаблон). В открыв-
шемся диалоговом окне DVD Templates (Шаблоны DVD) выберите в рас-
крывающемся списке Theme (Темы) наиболее подходящее семейство 
шаблонов, а затем определите сам шаблон из списка в нижней части окна, 
ориентируясь на миниатюры дизайна главного меню и меню сцен (рис. 7.26). 

 

Рис. 7.26. Шаблон оформления меню выбирается в окне DVD Templates 



Âûâîä ôèëüìà 227 

8. Если вы хотите, чтобы, при вставке диска DVD-проигрыватель, фильм на-

чинал демонстрироваться автоматически (без показа меню), установите в 
окне  DVD Templates (Шаблоны DVD) переключатель Auto-play DVD 

with no Menus (Автоматическое воспроизведение DVD без меню). 

В связи с последним пунктом надо отметить, что, вообще говоря, DVD-диски 

бывают двух типов: 

� запускаемые автоматически при вставке в проигрыватель (функция auto-
play); 

� управляемые при помощи меню. 

Первый тип дисков лучше всего подходит для коротких фильмов, либо 

фильмов, для которых желательно организовать циклическое воспроизведе-
ние (т. е., по достижении конца фильма, его повторный запуск с начала). Та-

кие диски обычно вовсе не содержат меню, но могут включать разметку на 
разделы, навигация между которыми организуется при помощи кнопок Next 
(Вперед) и Previous (Назад) на пульте управления DVD-проигрывателя. 

Второй тип дисков более дружественен к зрителю, предоставляя ему возмож-

ность удобного выбора желаемого раздела из списка (возможно, сопровож-
даемого графической миниатюрой кадра или даже анимацией). Поэтому 
фильм с меню, с точки зрения пользователя, представляет собой последова-

тельность более коротких фильмов, к каждому из которых можно переходить 
при помощи меню. Таким образом, выбор типа DVD-диска (с меню или без 

него) выбирается в диалоговом окне DVD Templates (Шаблоны DVD). 

7.4.4. Ïðåäâàðèòåëüíûé ïðîñìîòð DVD-äèñêà 

После того как вы отредактировали меню, имеющиеся в фильме, остается 
осуществить тестирование DVD-разметки и запись самого DVD-диска. Воз-

можность предварительного просмотра и записи подготовленного DVD-
диска предоставляется тем же диалоговым окном DVD Layout (Разметка 
DVD). 

Для тестирования DVD-диска выполните следующие действия. 

1. Откройте диалоговое окно DVD Layout (Разметка DVD) командой 
Window>DVD Layout (Окно>Разметка DVD). 

2. Нажмите кнопку Preview DVD (Предварительный просмотр DVD). 

3. В открывшемся окне Preview DVD (Предварительный просмотр DVD), 
используя стандартные кнопки DVD-проигрывателя (рис. 7.27), проведите 

тестирование разметки диска. В частности, попробуйте осуществить нави-
гацию по кнопкам меню, перейти к следующему и предыдущему (относи-
тельно текущего) разделу фильма, открыть главное меню и т. д. Старай-
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тесь не нажимать кнопки меню мышью, а использовать для этого соответ-

ствующие кнопки курсора. 

4. По завершении тестирования закройте окно Preview DVD (Предваритель-
ный просмотр DVD) кнопкой закрытия окна. 

 

Рис. 7.27. Тестирование фильма с DVD-разметкой 

7.4.5. Çàïèñü DVD-äèñêà 

Для того чтобы записать смонтированный фильм на диск стандарта DVD, 
выполните следующее. 

1. В диалоговом окне DVD Layout (Разметка DVD) нажмите кнопку Burn 

DVD (Записать DVD). 

2. В диалоговом окне Burn DVD (Записать) (рис. 7.28) определите парамет-

ры записи. В частности, можно задать требуемое число копий диска в поле 
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Copies (Копии). Если ваш компьютер содержит не один, а несколько при-

водов записи дисков DVD, то выбрать нужный привод следует посредст-
вом раскрывающегося списка Burner Location (Расположение привода). 

Если нужный привод в списке отсутствует, проверьте его наличие и пра-
вильное подключение, а затем нажмите кнопку Rescan (Новое сканирова-
ние). 

3. Нажмите кнопку Burn (Запись). 

 

Инициировать процесс записи диска можно также командой File>Export>Export 
To DVD (Файл>Экспорт>Экспорт на DVD). 

 

Рис. 7.28. Запись фильма на диск DVD 

Помимо непосредственной записи фильма, имеется возможность имитации 

этого процесса, т. е. сохранения фильма в файлах соответствующего формата 
на жестком диске. Для этого следует выбрать переключатель  Folder (Папка), 

затем нажать кнопку Browse (Пролистать) и определить желаемое располо-
жение папки с файлами, и, наконец, нажать кнопку Burn (Запись).  
В результате файлы виртуального диска DVD будут записаны в выбранную 

папку. 
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Îïèñàíèå êîìïàêò-äèñêà 
 

На компакт-диске, прилагаемом к этой книге, вы найдете:  

� презентацию с учебником для начинающих в форматах: 

• Microsoft PowerPoint (premiere.ppt); 

• Open Document (premiere.odp); 

• Adobe Acrobat (premiere.pdf); 

� учебный видеокурс по работе с Premiere Pro 2 (около 1,5 часов видео) (in-
dex.html); 

� примеры проектов Adobe Premiere Pro, представленных в видеокурсе 
(папка examples). 

Êàê ðàáîòàòü ñ êîìïàêò-äèñêîì 

После вставки CD в устройство чтения компакт-дисков домашняя 

страница учебного видеокурса должна загрузиться автоматически. Ес-

ли опция автозапуска CD у вас отключена, откройте вручную файл 

index.html. Учебный видеокурс не требует дополнительной установки 

(нужен только браузер и медиапроигрыватель). Файлы проектов, 

приводимых в видеокурсе в качестве примеров (с необходимыми ме-

диафайлами), вы найдете в папке examples.  

Скорее всего, для работы с этим диском установка дополнительных 

программ вам не потребуется. Однако может оказаться, что некото-

рые типовые компоненты на вашем компьютере отсутствуют, тогда 

потребуется их инсталлировать. Попробуйте сначала запустить любой 

из видеороликов, и если вы будете наблюдать видео на экране, то 
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никакой установки не нужно. В противном случае обратитесь к 

справочной информации компакт-диска, содержащей необходимые 

инструкции по установке компонентов. 

 

При разрешении 1024×768 рекомендуется просматривать видео в полноэкран-
ном режиме, дабы избежать дефектов изображения.  

Îãëàâëåíèå âèäåîêóðñà 

Импорт клипов из медиафайлов. 

Интерфейс Premiere Pro.  

Монтажный стол (окно Монтажа). 

Интерфейс Premiere Pro 2.  

Окно Проекта.  

Специальные клипы.  

Компоновка фильма из клипов.  

Подгонка и разрезание клипов в фильме.  

Подгонка мастер-клипов (до вставки в фильм).  

Особенности монтажа звука.  

Статические спецэффекты.  

Динамические спецэффекты.  

Титры.  

Спецэффекты перехода между клипами. 
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